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Ubicacion y funcion de los componentes

Para obtener mds informacion acerca del uso y las funciones de cada componente, consulte la pdagina a la que
se haga referencia.

Unidad principal
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1. Gancho para la correa de bandolera (9) 9. Zapata de interfaz miiltiple (parte
2. Botén ASSIGN7/DIRECT MENU (36) delantera)
3. N (MarcaN) 10. Palanca del zoom motorizado (24)
* Sujete un smartphone compatible con NFC 11. Antena de Wi-Fi

cerca de esta marca cuando desee
establecer una conexidn inaldmbrica entre
la videocdmara y el smartphone.
Para obtener mas informacion, remitase a
las instrucciones del smartphone.

¢ NFC (Near Field Communication) es un
estdndar internacional de comunicacién por
radio de corto alcance.

4. Botén ASSIGNS/FOCUS MAG
5. Zapata de interfaz miltiple (parte trasera)

® Multi
Y interface Shoe

Para obtener mds informacién acerca de los
accesorios compatibles con la zapata de interfaz
multiple, péngase en contacto con su
representante de ventas.

6. Pieza de sujecién del micréfono

1. Soporte del micréfono (32)

8. Antena GPS
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. Micrdéfono interno (31)

2. Lampara indicadora/indicador de
grabacion (parte delantera) (96)
Parpadea cuando la capacidad restante del
soporte de grabacion o de la bateria es baja.

. Boton ASSIGN6

. Botén FULL AUTO (23)

. Interruptor ND FILTER

. Interruptor de modo ND FILTER

. Interruptor FOCUS (25)

8. Botén ASSIGN3/VIDEO SIGNAL
MONITOR

9. Botén ASSIGN1/ZEBRA
10. Botén ASSIGN2/PEAKING
11. Interruptor INPUT1 (31)

12. Interruptor CH1 (INT/EXT/MI SHOE)
(€2)]

13. Dial AUDIO LEVEL (CH1) (31)

14. Dial AUDIO LEVEL (CH2) (31)

15. Interruptor CH2 (INT/EXT/MI SHOE)
16. Interruptor INPUT2 (31)

17. Botén ASSIGN5

18. Interruptor SHUTTER

19. Bot6n ASSIGN4

20. Botén FOCUS PUSH AUTO/HOLD (25)
21. Dial de control ND

22.Botén WB SET

23. Parasol del objetivo con cubierta del
objetivo (18)
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. Boton BATT RELEASE (16)

. Acoplamiento de la bateria (16)

. Conector Multi/Micro USB (62)

. Conector USB3.0 (HOST) (tipo A)
. Conector SDI OUT (61)

. Dial de ajuste diéptrico (19)

. Interruptor ON/STANDBY(17)
I: ON
(&: STANDBY

N OO O AE W N =

o

. Indicador de encendido
9. Conector USB2.0 (HOST) (tipo A)
(Compatible en una version futura.)
10. Interruptor IN/OUT (selector entrada/
salida)

11. Salida de aire

* Es posible que las zonas situadas alrededor de la
salida de aire se calienten.
* No cubra la salida de aire.

12. Palanca de zoom del asa (24)

13. Bot6n de grabacién del asa
Cuando la palanca se encuentre ajustada en la
posicion HOLD, el bot6n de grabacién del asa
no estard operativo.

14. Conector AUDIO INPUT1 (31)
15. Conector AUDIO INPUT2 (31)

16. Portacables
Suministrado para fijar el cable de un
micréfono, etc.

17. Correa de sujecion
18. Selector miltiple (Botén 4/%/«/»/SET)

91011 1213 14 15
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19. Botén de grabacion (23)
20. Entrada de aire

* No cubra la entrada de aire.

21. Conector REMOTE
El conector REMOTE se utiliza para controlar
el inicio/detencién de la reproduccién y otras
funciones del dispositivo de video y los
periféricos que se hayan conectado a él.

22. Abrazadera de cable

* No la utilice para fines distintos de fijar los
cables.

23. Conector LAN con cable (compatible en
futuras actualizaciones)

24. Conector TC IN/OUT
25. Conector HDMI OUT (61)

26. Ranura UTILITY SD/MS/indicador de
acceso
Utilizado para las opciones de almacenamiento/
carga y grabacién de proxy (funcién File).
Compatible con una actualizacién futura
(actualizacion de software).
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1. Anillo de zoom (25)
2. Anillo de enfoque (25)

3. Interruptor Full MF (25)
Enciende/apaga el modo de enfoque manual al
mover el anillo de enfoque hacia delante/atras.

4. Palanca de la tapa del objetivo (18)
Abre/cierra la cubierta del objetivo.

5. Gancho para la correa de bandolera
6. Anillo de diafragma (27)

7. Toma ¢ (auriculares)

Para auriculares con minitoma estéreo.

8. Lampara indicadora/indicador de
grabacion (parte trasera) (96)
Parpadea cuando la capacidad restante del
soporte de grabacion o de la bateria es baja.

9. Botén SLOT SELECT
10. Ranura para tarjetas de memoria A

11. Indicador de acceso a tarjeta de memoria
A (20)

12. Ranura para tarjetas de memoria B

13. Indicador de acceso a tarjeta de memoria
B (20)

14. Conector DC IN
15. Botén CANCEL/BACK (67)
16. Dial SEL/SET (67)

17. Botén MENU (67)
El botén dispone de un punto tactil para que le
resulte mas fécil encontrarlo.

18. Interruptor WHT BAL (30)
19. Interruptor GAIN (28)

20. Botén IRIS PUSH AUTO
21. Interruptor IRIS (27)

Para colocar una correa de bandolera
Coloque la correa de bandolera en los ganchos
destinados a tal fin.




7 8 91011 12

THUMBNAIL  F RV PLAY;/AUSE F ['WD [ LCD |IRIGHT

1T 0D 0|0

2 STATIIS _PREV__QTOPCAM  NEXT DISPLAY

—0 @ 0 & G-
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DURATION
CANCEL  TCU-BIT
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1. Botén THUMBNAIL (55)
2. Botén STOP/CAM (56)
3. Botén STATUS CHECK (13)
4. Botén PREV (56)
5. Botén 4/%/«/%/SET (67)
6. Botén MENU (67)
7.Botén F REV (56)
8. Boton PLAY/PAUSE (56)
9. Botén F FWD (56)

10. Botén NEXT (56)

11. Botén LCD BRIGHT (19)

12. Botén DISPLAY (11)

13. Pantalla LCD (19)

14. Visor (19)

15. Ocular grande

16. Entrada de aire

* No cubra la entrada de aire.
17. Botones VOLUME (26)
18. Botén DURATION/TC/U-BIT (33)
19. Botén CANCEL (67)

Lado inferior

1. Orificios para los tornillos del tripode
(1/4 pulgadas, 3/8 pulgadas)
Compatible con tornillos 1/4-20UNC y 3/8-
16UNC.

Acople la unidad a un tripode (vendido por
separado, longitud de tornillos: 5,5 mm o
inferior).



Visualizacion de la pantalla

Pantalla LCD/visor

Durante la grabacion, la grabacién en espera o durante la reproduccioén los estados y ajustes de la
videocdmara aparecen superpuestos en la pantalla LCD/del visor.

Puede mostrar/ocultar la informacién con el botén DISPLAY.

También puede elegir si desea mostrar u ocultar cada elemento independientemente (pdgina 85).

Informacion mostrada en la pantalla durante la filmacion

2

l
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1. Indicador de estado de red (pdgina 13)
Muestra el estado de la conexion de red
mediante un icono.

2. Indicador del modo de grabacién/estado
de funcionamiento de la ranura A/B

O®Rec Grabacién

Stby Grabacién en espera

3. Indicador de profundidad de campo

4. Indicador de la velocidad de fotogramas a
camara lenta y rapida

5. Indicador de capacidad de bateria
restante/tensién DC IN

21 22 23
6. Indicador de modo de enfoque (pdgina 34)
Modo Full MF Bull ME
Modo MF ME
Modo AF AR

Face detection AF (AB/ @// /1)

Icono de deteccién facial o

Icono de Face Only AF Only

Icono de cara registrada <%

Icono de autoenfoque de m
modo Face Only AF

pausado ¥

a) Se muestra cuando no hay ninguna cara
registrada y no se ha detectado ninguna cara, y
cuando hay una cara registrada pero no se
detecta.

7. Indicador de posicién del zoom

Muestra la posicién del zoom en el rango

comprendido entre O (posicion de gran angular)

y 99 (posicion de teleobjetivo).

8. Indicador de estado GPS



10.

11
12

14.

15.

16.

17

18.
19.

20.
21.

22.

23.

24

25.
26.

21.

28.
29.

. Indicador de modo de estabilizacion de la

imagen (SteadyShot)

Indicador de Rec Control de salida SDI/
HDMI

Se muestra cuando Display On/Off >SDI/
HDMI Rec Control en el meni LCD/VF y SDI/
HDMI Rec Control >Setting en el mend Video
se encuentran en On.

. Indicador del extensor digital (pdgina 95)

. Indicador de enfoque asistido

13.

Indicador de la capacidad restante del
soporte

Indicador de modo de balance de blancos
ATW Modo automético
ATW Hold Introduce una pausa en el
modo automadtico
W:P Modo predeterminado
W:A Modo de Memoria A
W:B Modo de Memoria B

Indicador del cédigo de tiempo
(pdgina 33)

Indicador del filtro ND (pdgina 28)

. Indicador de archivos de escena

(pdgina 41)
Indicador de posicién del diafragma

Indicador del advertencia del nivel de
video

Indicador de ganancia (pdgina 28)

Indicador del modo del obturador/
velocidad del obturador

Indicador de modo AE/nivel AE
(pdgina 29)

Medidor del nivel de audio

. Pantalla VIDEO SIGNAL MONITOR

(monitor de forma de onda/vectorscopio/
histograma)

Indicador de nombre del clip
Indicador de la pantalla asistida de
gamma (pdgina 41)

Indicador de gamma (pdgina 78)
Muestra el ajuste gamma.

Indicador de estado de proxy

Indicador de formato de grabaciéon
(codec) (pdgina 94)

Muestra el formato en el que se ha grabado en
una tarjeta de memoria.

30.

31.

Frecuencia del sistema e indicador del
método de escaneado

Indicador de formato de grabaciéon
(tamaiio de imagen) (pdgina 94)

Muestra el tamafio de la imagen en el que se ha
grabado en una tarjeta de memoria.

Informacion mostrada en la pantalla de
reproduccion

La siguiente informacion se superpone sobre la
imagen reproducida.

3 4?67
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. Indicador de estado de red
. Nimero del clip/Nimero total de clips
. Indicador de modo de reproduccion

. Indicador de formato de reproduccion

(velocidad de fotogramas)

. Indicador de formato de reproduccién

(tamaiio de imagen)

. Indicador de capacidad de bateria

restante/tension DC IN

. Indicador de formato de reproduccién

(codec)

. Indicador de soporte

Se muestra la marca () a la izquierda si la
tarjeta de memoria estd protegida contra la
escritura.

. Indicador de los datos de la hora

Se muestran los datos de la hora cuando Display
On/Off >Timecode en el meni LCD/VF se
encuentra en On y se pulsa el boton DISPLAY.

Indicador de nombre del clip

Indicador de la pantalla asistida de
gamma

Medidor del nivel de audio

Indicador de gamma



Indicadores del icono de conexion de red

Modo de red Estado de Icono

conexion
Modo de punto  Funciona como
de acceso un punto de
acceso
Error de m
funcionamiento
de punto de
acceso
Modo de Wi-Fi
estacion conectado

A 4
24

Intensidad de la
sefial del Wi-Fi
(4 niveles)

Wi-Fi
desconectado
(incl. durante la
configuracion)

Error al k

conectarse al
Wi-Fi

Pantalla de estado

Puede comprobar los ajustes y el estado de la
videocdmara en la pantalla de estado.

Operaciones de la pantalla de estado

Para mostrar la pantalla de estado:
« Pulse el botén STATUS CHECK.

Para cambiar la pantalla de estado:
« Gire el dial SEL/SET o pulse el botén 4/¥.

Para ocultar la pantalla de estado:
« Pulse el botén STATUS CHECK.

Pantalla de estado de la camara

Muestra la calidad de la foto, los ajustes de zoom

y el estado.

White Switch<B> Valor de ajuste de la memoria
de balance de blancos B

White Switch<A> Valor de ajuste de la memoria
de balance de blancos A

White Switch<P> Ajuste de Preset White

ND<Preset> Preset1 a opcién 3 para ND
Filter

Zebral Ajuste y nivel de Zebral On/
Off

Zebra2 Ajuste y nivel de Zebra2 On/
Off

Gamma Categoria y curva de Gamma

Gain Switch Ajuste de Gain<L>,
Gain<M>, Gain<H>

Handle Zoom Speed Ajuste de Handle Zoom

Scene File Archivo de la escena actual e
ID del archivo

Pantalla de estado del audio

Muestra el ajuste de entrada, el medidor del nivel
de audio y el ajuste del filtro de reduccién de
ruido para cada canal.

Medidor del nivel CHl Medidor del nivel CH1

CHI Input Source Fuente de entrada CH1

CH1 Ref./Sens. Nivel de referencia de entrada
CHI1

CHI1 Wind Filter Ajuste del filtro de reduccién
del ruido en el micréfono
CHI

Medidor del nivel CH2 Medidor del nivel CH2

CH2 Input Source Fuente de entrada CH2

CH2 Ref./Sens. Nivel de referencia de entrada
CH2

CH2 Wind Filter Ajuste del filtro de reduccién
del ruido en el micréfono
CH2

Medidor del nivel CH3 Medidor del nivel CH3

CH3 Input Source Fuente de entrada CH3

CH3 Ref./Sens. Nivel de referencia de entrada
CH3

CH3 Wind Filter Ajuste del filtro de reduccién
del ruido en el micréfono
CH3

Medidor del nivel CH4 Medidor del nivel CH4

CH4 Input Source Fuente de entrada CH4

CH4 Ref./Sens. Nivel de referencia de entrada
CH4

CH4 Wind Filter Ajuste del filtro de reduccién
del ruido en el micréfono
CH4

HDMI Output CH Ajuste de la combinacion del
canal de audio de salida
HDMI

Analog Output CH Ajuste de la combinacion del
canal de audio de salida
analdgico

Monitor CH Ajuste del canal del monitor

Headphone Out Ajuste del tipo de salida de
auriculares

Pantalla de estado del sistema
Muestra los ajustes de la sefial de video.



Frequency/Scan Frecuencia del sistema y
ajustes del método de
escaneado

Codec Ajustes de cédec

Simul Rec Estado de encendido/apagado
de 2-slot Simul Rec

Title Prefix Prefijo del titulo del nombre

del clip

Picture Size Tamaifio de la imagen del

formato de la reproduccién

Se habilita un formato de
grabacién y unos ajustes
especiales

Rec Function

Clip Continuous Rec Estado de encendido/apagado

de Clip Continuous Rec

Picture Cache Rec Estado de encendido/apagado

y ajustes de Picture Cache

Rec
Number Sufijo numérico del nombre
del clip
Shooting Mode Ajuste del modo de disparo
Proxy Rec Estado de encendido/apagado

y configuracién de la
grabacién proxy

Pantalla de estado de la salida de video
Muestra los ajustes de salida de video, SDI y
HDML.

SDI Tamaiio de la imagen de
salida
Estado de Rec Control

Output On/Off

HDMI Tamaifio de la imagen de
salida
Estado de Rec Control

Output On/Off

Gamma Ajuste de Gamma

Color Gamut Ajuste de la gama de colores

Gamma Display Assist Ajustes de la pantalla asistida

de gamma

Pantalla de estado de los botones asignables
Muestra las funciones asignadas a cada uno de los
botones asignables.

1 Funcién asignada al botén
Assign 1

2 Funcién asignada al botén
Assign 2

3 Funcién asignada al botén
Assign 3

4 Funcién asignada al botén
Assign 4

5 Funcién asignada al botén
Assign 5

6 Funcidn asignada al botén
Assign 6

7 Funcidn asignada al botén
Assign 7

8 Funcién asignada al bot6én
Assign 8

Pantalla de estado de la bateria
Muestra informacidn sobre la bateria y sobre la
fuente DC IN.

Detected Battery Tipo de bateria

Remaining Capacidad restante (%)
Charge Count Numero de recargas
Capacity Capacidad restante (Ah)
Voltage Tensioén (V)

Fecha de fabricacion de la
bateria

Manufacture Date

Video Light Remaining Nivel de carga restante de la

bateria de la luz de video

Power Source Fuente de alimentacién

Tensién de la fuente de
alimentacién

Supplied Voltage

Pantalla de estado de los soportes

Muestra el espacio restante, el tiempo de
grabacion disponible y la vida ttil estimada del
soporte de grabacion (tarjeta de memoria A/
tarjeta de memoria B) y del soporte UTILITY.

Informacién del soporte Muestra el icono del soporte

A cuando el soporte de
grabacién se ha introducido
en laranura A.

Proteccién del soporte  Muestra el icono de bloqueo

A cuando el soporte de
grabacion introducido en la
ranura A estd protegido

(bloqueado).
Medidor de la Muestra la capacidad de
capacidad restante del ~ grabacién restante del soporte
soporte A de grabacién introducido en

la ranura A, expresado en
forma de porcentaje en un
grafico de barras.

Muestra un cilculo del
tiempo de grabacién restante
del soporte de grabacién
introducido en la ranura A,
expresado en minutos segiin
las condiciones de grabacion
actuales.

Tiempo de grabacién
restante del soporte A




Informacion del soporte Muestra el icono del soporte

B

cuando el soporte de
grabacidn se ha introducido
en la ranura B.

Proteccién del soporte

B

Muestra el icono de bloqueo
cuando el soporte de
grabacién introducido en la
ranura B estd protegido
(bloqueado).

Medidor de la
capacidad restante B

Muestra la capacidad de
grabacién restante del soporte
de grabacion introducido en
la ranura B, expresado en
forma de porcentaje en un
grifico de barras.

Tiempo de grabacion
restante del soporte B

Muestra un célculo del
tiempo de grabacién restante
del soporte de grabacién
introducido en la ranura B,
expresado en minutos segin
las condiciones de grabacién
actuales.

Informacién del soporte

UTILITY

Muestra el icono de soportes
cuando se ha introducido
alguno en la ranura UTILITY
SD/MS.

Proteccién del soporte

Muestra el icono de bloqueo

UTILITY cuando el soporte introducido
en la ranura de la tarjeta
UTILITY SD/MS estd
protegido (bloqueado).

Medidor de la Muestra la capacidad restante

capacidad restante del

soporte UTILITY

del soporte introducido en la
ranura UTILITY SD/MS,
expresado en forma de
porcentaje en un grifico de
barras.

Capacidad restante del

soporte UTILITY

Muestra un célculo del
tiempo de grabacién restante
del soporte de grabacion
introducido en la ranura
UTILITY SD/MS, expresado
en minutos. O muestra la
capacidad restante, expresada
en GB.

Pantalla de estado del ajuste de Rec Button
Muestra el estado de ajuste del botén de
grabacion y del boton de grabacion del asa.

Rec Button

Muestra la ranura de la tarjeta
de grabacion del botén de
grabacién

Handle Rec Button

Muestra la ranura de la tarjeta
de grabacién del botén de
grabacién del asa

Pantalla de estado de GPS
Muestra el estado y la informacién del

posicionamiento GPS.

GPS

Estado del posicionamiento
de la sefial GPS

Dilution of Precision

Precision de la informacién
de posicién

Latitude Informacion de latitud
Longitude Informaci6n de longitud
Altitude Informacién de altitud

Positioning date and
time

Fecha y hora del
posicionamiento

Current date and time

Fecha y hora actuales

Time Zone

Ajustes de la zona horaria

Pantalla de estado de red
Muestra el estado de conexién de red.

Wireless LAN

Ajustes de lared inaldmbrica,
estado de conexién

Ajustes de Wireless LAN

Pantalla de
Setting

Pantalla de
Status

Descripcion

Off ---

El ajuste de LAN
inaldmbrica estd
desactivado.

Access Point
Mode

Non Active

No funciona como
un punto de acceso.
Se muestra cuando
el chip Wi-Fi falla.

Active

Funciona como un
punto de acceso.

Station Mode

Non Active

No funciona en
modo de estacion.
Se muestra cuando
el chip Wi-Fi falla.

Searching

Intentando
conectar a la red
conectada
previamente (punto
de acceso).

Disconnected

No conectado a
ninguna red (punto
de acceso).
También se
muestra cuando la
direccién IP no se
asign6 usando
DHCP.

<SSID>

Conectado a red
<SSID> (punto de
acceso).




Fuente de alimentacion

Puede utilizar una bateria o una fuente de
alimentacion de CA mediante un adaptador de
CA.

Cuando se conecta un adaptador de CA, este tiene
prioridad incluso cuando se conecta una bateria.
Por su seguridad, utilice sélo las baterias y los
adaptadores de CA Sony que se enumeran a
continuacion.

Baterias de iones de litio
BP-U30 (suministrado)
BP-U60

BP-U60T

BP-U90

Adaptadores/cargadores de CA
BC-U1A (suministrado)
BC-U2A

No guarde las baterfas en lugares expuestos a la
luz solar directa, cerca de fuegos ni a temperatura
elevadas.

¢ Cuando se utilice conectado a una toma de corriente,
utilice el adaptador de CA suministrado.

Uso de una hateria

Para colocar la bateria, conéctela en el
acoplamiento (pdgina 8) empujiandolo hasta el
tope y a continuacién deslicela hacia abajo para
que quede bloqueada en la posicion final.

Para extraer la baterfa, mantenga pulsado el bot6n
BATT RELEASE (pdgina 8), deslicela hacia
arriba y a continuacion, tire de ella para sacarla
del acoplamiento.

Antes de usar la baterfa, cdrguela con el cargador de
bateria BC-U1A (suministrado) o BC-U2A.

Si carga la baterfa inmediatamente después de
utilizarla y cuando todavia estd caliente, es posible que
no se recargue completamente.

La baterfa BP-U90 de alta capacidad es de grandes
dimensiones y sobresale de la videocdmara al
introducirla. La bateria BP-U90 es iitil cuando se
engancha la videocdmara a un tripode durante periodos
de grabacion prolongados.

Comprobacion de la capacidad restante

Cuando se estd grabando o reproduciendo con la
baterfa, se muestra un icono para mostrar el nivel
de carga de la baterfa actual y el tiempo de uso

restante en la pantalla LCD/del visor (pdgina 11).

Icono Capacidad restante

Entre 100% y 91%

¥///| Entre 90% y 71%

Entre 70% y 51%

Entre 50% y 31%

Entre 30% y 11%

BNYYE

Entre 10% y 0%

La videocdmara indica el tiempo de uso restante
en minutos mediante el cdlculo del tiempo
disponible con la baterfa si se continda utilizando
la cdmara con el nivel de consumo de energia
actual.

Si el nivel de carga de la bateria es bajo

Si la carga restante de la baterfa desciende por
debajo de un nivel determinado durante el
funcionamiento (Low Battery state), aparecerd un
mensaje de bateria baja, el indicador de grabacién
comenzard a parpadear y se escuchard un pitido
de advertencia.

Si la carga restante de bateria desciende por
debajo del nivel al que el funcionamiento ya no
puede continuar (Battery Empty state), aparecera
un mensaje de bateria agotada.

Sustituya la baterfa por una bateria cargada.

Cambio de los niveles de advertencia

El nivel Low Battery estd ajustado en el 10% de
la carga total de la bateria y el nivel de Battery
Empty estd ajustado en el 3% de manera
predeterminada. Puede cambiar la configuracién
del nivel de advertencia en Battery Alarm
(pdgina 96) en el mend System.



Utilizacién de la alimentacion por
CA

Si el camcorder se conecta a una toma de

corriente este se podrd utilizar sin preocuparse de

la necesidad de recargar la bateria.

Conector Enchufe del adaptador
DC IN de CA

1 Conecte el cable de alimentacién al adaptador de
alimentacién de CA.

2 Conecte el adaptador de alimentacién de CA al
conector DC IN de la videocdmara.

3 Conecte el cable de alimentacion a la toma de
corriente de pared.

Adaptadores de CA

« No conecte ni utilice un adaptador de CA en
espacios reducidos, como por ejemplo, entre
una pared y un mueble.

« Si se produce algtin problema durante el uso,
desconecte inmediatamente el cable de
alimentacion de la toma de corriente.

« No provoque cortocircuitos en la clavija del
adaptador de alimentacién de CA con objetos
metdlicos. Si lo hace, provocard un fallo de
funcionamiento.

* No se puede cargar la videocdmara
conectdndola al adaptador de alimentacion de
CA.

Conexion/desconexion de la
videocamara

Para conectar la alimentacién, ajuste el
interruptor ON/STANDBY (pdgina 8) en la
posicién ON (I). Para desconectar la
alimentacion, ajuste el interruptor ON/
STANDBY en la posicién STANDBY (()).

* Aunque el interruptor ON/STANDBY se encuentre en
la posiciéon STANDBY, la unidad continda
consumiendo alimentacion eléctrica en espera. Retire
la bateria si no va a utilizar la videocdmara durante un
periodo de tiempo prolongado.

* Retire la bateria o desconecte la fuente de alimentacién
DC IN una vez se haya apagado el indicador de
alimentacién cuando el interruptor se encuentre en la
posicién STANDBY. Si se retira la alimentacién
mientras el interruptor se encuentra en la posicién ON,
es posible que se produzca un fallo de funcionamiento
en la videocdmara o en las tarjetas de memoria.



Ajuste del reloj

Al encender la videocdmara por primera vez tras
adquirirla o una vez se descarga por completo la
bateria secundaria, se muestra la pantalla de
ajuste inicial en la pantalla del visor y en la
pantalla LCD.

Ajuste la fecha y la hora del reloj interno en esta
pantalla.

Time Zone

El valor muestra la diferencia horaria existente
respecto al UTC (Hora universal coordinada).
Cambie el ajuste segiin sea necesario.

Ajuste de la fecha y la hora

Desplace el cursor con el botén #/¥/«/»
(pdgina 8) o el dial SEL/SET (pdgina 9). A
continuacioén, pulse el botén SET o el dial SEL/
SET para configurar cada elemento.

Por tltimo, desplace el cursor a [Finish] y pulse el
botén SET o el dial SEL/SET para cerrar la
pantalla de ajustes y terminar de ajustar el reloj.

Después de cerrar la pantalla de ajustes, puede
cambiar los ajustes de fecha, hora y zona horaria
en Clock Set (pdgina 96) en el menud System.

Si el ajuste del reloj se pierde debido a que la baterfa de
reserva se descarga totalmente por el hecho de
permanecer desconectado durante un periodo
prolongado (sin baterfa ni fuente de alimentacion DC
IN), se mostrard la pantalla de ajustes iniciales la
préxima vez que encienda el camcorder.

Mientras se muestra la pantalla de ajustes iniciales, no
podra realizar ninguna otra operacién, excepto apagar
el dispositivo, hasta que se completen los ajustes en
esta pantalla.

Si no utiliza la videocdmara durante aproximadamente
3 meses, la bateria incorporada se descargard y es
posible que los ajustes de fecha y hora se borren de la
memoria. En ese caso, cargue la bateria recargable y, a
continuacion, configure la fecha y la hora de nuevo
(pdgina 101).

Acople de dispositivos

Acople del parasol del objetivo

Botdn PUSH (liberacion del parasol del objetivo)

Haga coincidir las marcas del parasol del
objetivo con las de la videocamara y gire el
parasol del objetivo en la direccién indicada
por la flecha @ hasta que se bloquee.

Retirar el parasol del objetivo

Gire el parasol del objetivo en la direccién
opuesta a la indicada mediante la flecha que
aparece en la ilustracion mientras mantiene
pulsado el botén PUSH (liberacién del parasol del
objetivo).

* Retire el parasol del objetivo cuando vaya a instalar/
retirar un filtro de polarizacién o de proteccién de
82 mm de didmetro.

Acoplamiento del ocular grande

Extienda ligeramente el ocular grande y encdjelo
en la muesca del visor.

Ocular grande (incluido)



Ajuste de las pantallas

Ajuste de la pantalla LCD

Abra la pantalla LCD 180 grados (D) y, a
continuacién, girela hasta situarla en el mejor
angulo posible para grabar o reproducir (®).

@ Abierta
180 grados

(® 90 grados g
(max.) ‘

>

® 180
grados
(max.)

Puede ajustar el dngulo de manera que el visor
esté orientado hacia el sujeto. Las imdgenes se
visualizan como en un espejo en la pantalla LCD,
pero se graban como imagenes normales.

Ajuste del contraluz

Cambie el brillo del contraluz con el boton LCD
BRIGHT (pdgina 10).

Ajuste del brillo

Puede ajustar el brillo en el visor mediante LCD
Setting >Brightness (pdgina 83) en el meni LCD/
VF. Los cambios en el brillo no afectan al brillo
de las imdgenes grabadas.

Ajuste del visor

Mire a través del visor con la pantalla LCD
cerrada cuando utilice el visor.

Si la pantalla del visor no se visualiza de manera
clara, ajustela mediante el dial de ajuste didptrico
situado debajo del visor.

\

Dial de ajuste diéptrico
Muévala hasta que la
imagen se visualice de
manera clara.

Ajuste del brillo

Puede ajustar el brillo en el visor mediante VF
Setting >Brightness (pdgina 83) en el menti LCD/
VF.

Ajuste del brillo de la pantalla
LCD/visor mediante un botdn
asignable

Puede mostrar una barra de nivel para ajustar el
brillo de la pantalla LCD/visor si asigna el ajuste
LCD/VF Adjust a un bot6n asignable (pdgina 36)
y lo pulsa.

1 Pulse el botén al que haya asignado
LCD/VF Adjust para mostrar una
barra de nivel, con la que podra ajustar
el brillo.

Cada vez que pulse el botdn, la pantalla
cambiard por orden entre la barra de nivel de
la pantalla LCD — la barra de nivel del visor
— ninguna visualizacién.

2 Ajuste el nivel con el botén 4/¥/«/% o el
dial SEL/SET. A continuacién, pulse el
boton SET o el dial SEL/SET.

La barra de nivel desaparece.

Pulse el botdn al que haya asignado LCD/VF
Adjust o no realice ninguna accion durante
3 segundos para ocultar la barra de nivel.



Uso de tarjetas de
memoria

Esta videocdmara graba audio y video en tarjetas
de memoria (se venden por separado) insertadas
en las ranuras para tarjetas de memoria.

Acerca de las tarjetas de memoria

Tarjetas de memoria admitidas

Las siguientes tarjetas de memoria son
compatibles.
Para mds detalles sobre soportes de grabacion y

formatos compatibles, consulte pdgina 104.

Tarjetas de memoria SDXC (Clase 10)

Colocacidn de tarjetas de
memotia

1 Abrala tapa del bloque de la ranura
para tarjetas.

2 Insertela tarjeta de memoria con la
etiqueta orientada hacia la derecha.
El indicador de acceso (pdgina 9) se ilumina
en rojo y, a continuacién, cambia a verde en
cuanto la tarjeta de memoria se encuentra
preparada para utilizarse.

3 Cierre la tapa.

 La tarjeta de memoria, la ranura de la tarjeta de
memoria y los datos de imagen de la tarjeta de
memoria pueden resultar dafiados si la tarjeta se
introduce a la fuerza en la ranura en la orientacién
incorrecta.

Extraccion de una tarjeta de
memoria

1 Abralacubierta del bloque de laranura
de la tarjeta y presione la tarjeta
ligeramente hacia dentro.

La tarjeta de memoria saltara.
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Durante la grabacion, esto detendra la
misma.

2 Extraiga la tarjeta de memoria.

« Siel camcorder estd apagado o si se extrae la tarjeta de
memoria mientras se estd accediendo a esta, no se
podrd garantizar la integridad de los datos de la tarjeta.
Es posible que se pierdan todos los datos grabados en
la tarjeta. Asegtirese de que el indicador de acceso esté
siempre iluminado en color verde o apagado antes de
apagar la videocdmara o extraer la tarjeta de memoria.
Es posible que, al extraer una tarjeta de memoria de la
videocdmara tras finalizar la grabacion, esta se
encuentre caliente. No se trata de un fallo de
funcionamiento.

Cambio entre tarjetas de memoria

Cuando se han cargado tarjetas de memoria tanto
en la ranura A como en la B, puede cambiar la
tarjeta utilizada para grabaciones con tan solo
pulsar el botén SLOT SELECT (pdgina 9).

Si una tarjeta se llena por completo durante la
grabacion, el camcorder cambia automaticamente
ala otra tarjeta.

El botén SLOT SELECT estd deshabilitado durante la
reproduccion. Las tarjetas de memoria no se
intercambian incluso si pulsa el botén. El botén estd
habilitado mientras se muestra la pantalla de
miniaturas (pdgina 55).

Formateo (inicializacién) de una
tarjeta de memoria

Es necesario formatear las tarjetas de memoria la
primera vez que se van a utilizar en la
videocdmara.

Las tarjetas de memoria que se vayan a utilizar en
la videocdmara se deben formatear mediante la
funcién de formateo de la videocdmara.

Si aparece un mensaje cuando la tarjeta de
memoria se introduce en la videocdmara,
formatee la tarjeta de memoria.

Si se inserta una tarjeta de memoria que se ha
formateado en un formato no compatible con esta
videocdmara, aparecerd el mensaje “Unsupported
File System” en la pantalla del visor/LCD.
Formatee el soporte tal como se indica a
continuacion.



Para ejecutar el formateo

Mediante Format Media (pdgina 90) del
ment Media, especifique Media(A) (ranura
A) 0 Media(B) (ranura B) y, a continuacién,
seleccione Execute.

Se mostrard un mensaje durante el formateo y el
indicador de acceso se iluminard en rojo.
Cuando finaliza el formateo, aparece un mensaje
de finalizacion.

¢ Al formatear una tarjeta de memoria se borran todos
los datos de esta, incluidos los videos protegidos. Los
datos no se podrdn restaurar.

Para utilizar un soporte formateado con la

videocamara en la ranura de otro dispositivo

Lleve a cabo una copia de seguridad del soporte

y, a continuacién, formatéelo mediante el otro

dispositivo.

Comprobacion del tiempo de
grabacion restante

En el modo de grabacion (o en espera para grabar)
puede comprobar el espacio restante de las
tarjetas de memoria cargadas en las ranuras para
tarjetas en la pantalla del estado del soporte/
espacio disponible de la ranura A/B de la pantalla
del visor/LCD (pdgina 11).

El tiempo de grabacion restante se calcula a partir
de la capacidad restante de los soportes en cada
ranura y del formato de video actual (velocidad de
bits de grabacion), y se mostrard en minutos.

« Sila tarjeta de memoria estd protegida contra escritura
aparece un icono @ .

Sustitucion de una tarjeta de memoria

« Si el tiempo total en las dos tarjetas llega a ser
inferior a 5 minuto, aparecerd el mensaje
“Media Near Full”, el indicador de grabacion/
ldmpara indicadora parpadeard y sonard un
aviso acustico en los auriculares para avisarle.
Introduzca algiin soporte que disponga de
espacio.

« Si sigue grabando hasta que se agote el tiempo
restante, el mensaje pasa a ser “Media Full” y la
grabacidn se interrumpe.
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En una tarjeta de memoria se pueden grabar hasta 600
clips aproximadamente.

Si el nimero de clips grabados llega al limite,
aparecerd una indicacién que dice que se ha alcanzado
el nimero maximo de clips.

Restauracion de una tarjeta de
memoria

Si, por alguna razo6n, se produjera un error en una
tarjeta de memoria, esta debe restablecerse antes
de usarla.

Si carga una tarjeta de memoria que necesite
restaurarse, aparecerd un mensaje en la pantalla
del visor/LCD en el que se le preguntard si desea
restaurarla.

Restablecer una tarjeta

Seleccione Execute con el boton 4/¥/«/% o el
dial SEL/SET y pulse el botén SET o el dial
SEL/SET.

Se mostrard un mensaje y el estado de avance (%)
durante el formateo y el indicador de acceso se
iluminard en rojo.

Cuando termine el restablecimiento, aparecerd un
mensaje de finalizacion.

Si falla el restablecimiento

* No se pueden restaurar las tarjetas de memoria

protegidas contra grabacién ni en las que se

haya producido un error de memoria. En estas

tarjetas, aparecerd un mensaje de advertencia.

Siga las instrucciones del mensaje y desproteja

la tarjeta o cambiela por otra tarjeta.

Las tarjetas de memoria en las que se haya

producido un error de memoria pueden volver a

usarse si se formatean de nuevo.

Algunos clips pueden restablecerse, pero otros

no. Los clips restablecidos pueden reproducirse

con normalidad.

Si, tras restaurar varias veces, continia

apareciendo el mensaje “Could not Restore

Some Clips”, es posible restaurar la tarjeta de

memoria mediante el siguiente procedimiento.

1 Utilice la funcién de copia (pdgina 59) de la
videocdmara para copiar los clips necesarios a otra
tarjeta de memoria.

2 Formatee la tarjeta de memoria inutilizable en la
videocdmara.

3 Copie los clips necesarios de nuevo a la tarjeta de
memoria recién formateada.



« Asegitrese de utilizar esta videocdmara para
restablecer los soportes grabados con ella.
Es posible que los soportes grabados con un
dispositivo que no sea esta videocdmara o con una
videocdmara de versién diferente (incluso del mismo
modelo) no se restablezcan mediante esta
videocdmara.

« Es posible que no se puedan restaurar clips de menos
de 1 minuto de duracién.
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Procedimiento basico de funcionamiento

Filmacién Grabacion continua en las tarjetas de
memotria (Relay Rec)

La filmacion basica se realiza mediante el

.. L. Cuando las tarjetas de memoria se introducen en
siguiente procedimiento.

las ranuras A 'y B, la grabacion cambia
automdticamente a la segunda tarjeta de memoria
justo antes de que la capacidad restante de la
primera tarjeta se reduzca a cero.

Puede continuar grabando de forma continua al
cambiar de tarjeta de memoria si sustituye la
tarjeta de memoria llena por una nueva.

1 Acople los dispositivos necesarios y
compruebe que se suministra la
alimentacion necesaria.

2 Cargue las tarjetas de memoria.

Si carga dos tarjetas de memoria en las

ranuras para tarjetas de memoria A y B, la m

grabacion contindia automaticamente * No extraiga una tarjeta de memoria mientras se esté
pasando a la segunda tarjeta cuando la grabando en ella. Retire tinicamente la tarjeta de
primera tarjeta se llena. memoria de la ranura cuyo indicador de acceso esté

apagado durante la grabacién.

. Si la tarjeta de memoria grabable se encuentra
Coloque el interruptor ON/STANDBY introducida en la otra ranura cuando el tiempo restante
en la posicion ON. de la tarjeta de memoria en la que se estd grabando es
inferior a 1 minuto, se mostrard el mensaje “Will
Switch Slots Soon”. El mensaje desaparecerd después
de cambiar las ranuras de tarjeta de memoria.

Es posible que la funcién de grabacion de relé no

w

Aparece la pantalla de grabacioén en la
pantalla LCD/pantalla del visor.

4 pulse el botén de grabacion de la funcione si inicia la grabacién cuando el tiempo
empuiadura o del asa (pdgina 8). restante de la tarjeta de memoria sea inferior a 1
minuto. Para llevar a cabo la grabacion de relé
El indicador de grabacién/ldmpara correctamente, asegtirese de que el tiempo restante de
indicadora se enciende y se inicia la la tarjeta de memoria sea superior a 1 minuto.
grabacion. * Los videos creados con la funcién de grabacion

continua del camcorder no se pueden reproducir sin

5 P det 1 bacié I 1 interrupciones en el camcorder.
ara detener la grabacion, pulse ¢ Para combinar los videos creado con la funcién de

boton de grabacion de nuevo. grabaci6n continua de la videocdmara, utilice el
software Content Browser.

La grabacién se detendrd y el camcorder
cambiard al modo STBY (en espera).

Filmacion (Modo automatico completo)

Pulse el botéon FULL AUTO y gire el
indicador del boton hasta que se encienda.

Al activar el modo Full Auto, Auto Exposure
(pdgina 73) se activa, y Auto ND Filter, Auto Iris,
AGC (Auto Gain Control), Auto Shutter y ATW
(localizacion automética del balance de blancos)
se establecen en On. A continuacion, se ajustaran
automaticamente el brillo y el balance de blancos.
Cuando acabe de ajustarlos manualmente,
desactive el modo Full Auto.
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Acerca de los clips

Clip (datos de grabacion)

Al detener la grabacion, el video, el audio y los
datos relacionados desde el principio hasta el
final de la grabacion se graban como un solo
clip en una tarjeta de memoria.

Nombres de clips

A todos los clips grabados con esta
videocdmara se les asignard un nombre
automaticamente segtin el modo establecido en
la opcién Clip Naming (pdgina 91) del ment
Media.

Duracion maxima de clip

La duracion maxima de un clip varia en funcién
del formato de grabacion.

La duracién maxima de una grabacién continua
es la misma que la duracién maxima de un clip.
Si el tiempo de grabacion supera la duracién
maéxima de un clip, se crea un clip nuevo
automdticamente y continda la grabacién. El
nuevo clip aparece como un clip separado en la
pantalla de imdgenes en miniatura.

Si desea obtener informacion detallada acerca
del tiempo de grabacién médximo de un clip de
cada formato de grabacién, consulte “Tiempo
de grabacion mdximo de un clip”

(pdgina 105).

Para eliminar un clip

Se puede eliminar el dltimo clip grabado
mediante la funcién Last Clip Delete (pdgina 95).
Para eliminar todos los clips o clips especificos,
realice la operacién desde la pantalla de imdgenes
en miniatura (pdgina 60).
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Ajuste del zoom

Uso de la palanca del zoom motorizado

Pulse la palanca del zoom motorizado [C| para
accionar el zoom.

Pulse ligeramente la palanca del zoom
motorizado |C| para obtener un zoom mds lento.
Pulsela por completo para obtener un zoom mds
rdpido.

Campo de vision amplio: amplio

%$

¥

©

g

Primer plano: teleobjetivo

* La distancia minima necesaria entre la
videocdmara y el sujeto que desea enfocar debe
ser de aproximadamente 1 cm para gran angular
y de unos 80 cm para teleobjetivo.

El enfoque puede no poder ajustarse en
determinadas posiciones de zoom si el objeto se
encuentra a una distancia inferior a 80 cm de su
videocdmara.

Mantenga el dedo en la palanca del zoom
motorizado [C]. Si retira el dedo de la palanca
del zoom motorizado [C], es posible que
también se grabe el sonido de funcionamiento
de dicha palanca.

Utilizacion del zoom del asa

1. Ajuste la velocidad del zoom del asa a
“Low”, “High” o “Variable” en Handle



Zoom (pdgina 74) >Setting, en el menu
Camera.

» Cuando se establece en “Variable”, podrd
ampliar o reducir las imagenes a distintas
velocidades, segtn la presion aplicada al
interruptor.

Cuando se establece en “Low” o “High”,
podrd ampliar o reducir las imdgenes a una
velocidad fija, sin importar la presién
aplicada al interruptor. Puede establecer la
velocidad a “Low” o “High” en Handle
Zoom, en el mend Camera.

Al asignar la funciéon Handle Zoom
>Setting a un botdn asignable (pdgina 36),
puede cambiar el funcionamiento del zoom
del asa cada vez que pulse el boton.

2. Pulse la palanca del zoom del asa [A] para
ampliar o reducir las imagenes.

* No puede usar la palanca del zoom del asa |A| si el

funcionamiento del zoom del asa estd ajustado en OFF.

Uso del el anillo del zoom

Gire el anillo del zoom para acercar el zoom [B].
Es posible utilizar el zoom a la velocidad que
desee girando el anillo del zoom [B]. También se
puede ajustar de forma precisa.

Ajuste del enfoque

Consejos para enfocar

¢ Mueva la palanca del zoom motorizado hacia la
posicion T (teleobjetivo) para ajustar el enfoque
y, a continuacién, hacia la posicion W (gran

angular) para ajustar el zoom para la grabacion.

« Si desea grabar una imagen cercana de un
sujeto, mueva la palanca del zoom motorizado
hacia la posicién W (gran angular) para ampliar
completamente la imagen y, a continuacion,
ajuste el enfoque.
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Modo
AF/MF Modo Full MF

Ajuste en el modo Full MF

Tire del anillo de enfoque [A| hacia atrds (hacia la
videocdmara) para activar el modo Full MF, para
un control del enfoque completamente manual.
Gire el anillo de enfoque para ajustar el enfoque
mientras supervisa la imagen en la pantalla LCD
o del visor.

En el modo Full MF, puede utilizar los
marcadores de distancia impresos en el anillo de
enfoque a modo de guia cuando ajuste el enfoque.
Las distancias en las que la imagen estd enfocada
se corresponden con las posiciones de los
marcadores de distancia.

* No use una fuerza excesiva en ninguno de los dos
extremos del recorrido al girar el anillo de enfoque.

¢ En el modo Full MF, el enfoque automatico y el
enfoque automatico push no funcionan.

¢ Macro estd desactivado independientemente de la
configuracién de Focus Macro en el mend Camera.

Ajustes en el modo MF

En el modo MF (enfoque manual), puede utilizar
el enfoque automadtico siempre que lo necesite.
Deslice el anillo de enfoque |A| hacia delante
(hacia el parasol del objetivo) y ajuste el
interruptor FOCUS [B] a MANUAL.

Uso del enfoque automatico de forma temporal
(Push auto focus)

En el modo MF, se activard el enfoque
automatico mientras se pulse el boton FOCUS
PUSH AUTO/HOLD |C| del objetivo o se pulse



el bot6n asignable (pdgina 36) con la funcién
Push AF/Push MF asignada.

El enfoque volverd al enfoque manual cuando
suelte el boton.

Esta funcion es til para cambiar el enfoque de un
sujeto a otro durante el modo de enfoque manual.

Ajuste en modo AF

En el modo AF (enfoque automadtico) el enfoque
se ajusta de forma automadtica.

Deslice el anillo de enfoque |A| hacia delante y
ajuste el interruptor FOCUS a AUTO.

Uso del enfoque manual de forma temporal
(Push manual focus)

En el modo AF, se activard el enfoque manual
mientras se pulse el boton FOCUS PUSH AUTO/
HOLD del objetivo o se pulse el bot6n asignable
(pdgina 36) con la funcién Push AF/Push MF
asignada.

El enfoque volverd al enfoque automatico cuando
suelte el boton.

Uso del modo Macro

En el modo MF o AF, ajuste Focus (pdgina 72)
>Focus Macro en el mend Camera a On o pulse
un botén asignable asignado a Focus Macro
(pdgina 36) para activar el modo Macro y ajustar
el enfoque en un intervalo que incluya la zona
Macro.

El modo Macro no es valido en modo Full MF.

Enfocar con una visualizacion
aumentada (Focus Magnifier)

Cuando a un botén asignable (pdgina 36) se le
asigna la funcion Focus Magnifier, aparece la
pantalla de ampliacién de enfoque y muestra la
parte de la imagen ampliada.

La ampliacion cambia entre 4 y 8§ aumentos cada
vez que se pulsa el botén, cuando el formato de
grabacion es QFHD. Puede mover la posicién
ampliada con el boton 4/¥/«/s.

El centro de la pantalla se amplia de forma fija en
2 aumentos en formatos de grabacién distintos a
QFHD.

Pulse el botén de nuevo para volver a la pantalla
normal.

Esta funcion resulta til para comprobar el
enfoque.

¢ Aunque la imagen aparezca ampliada en la pantalla, la
imagen grabada no se ampliara.

Control del audio durante la
filmacion

Al conectar unos auriculares al conector de
auriculares (minitoma estéreo) (pdgina 9) podra
controlar el audio que se estd grabando.

« El altavoz integrado estard desactivado durante la
filmacion (grabacién o grabacién en espera).

Ajuste del volumen de monitorizacion de audio

Utilice los botones VOLUME (pdgina 10).

Para cambiar el volumen de monitorizacion de
audio

Seleccione el canal mediante Audio Output
(pdgina 82) en el mend Audio.



Cambios en los ajustes
basicos
Puede cambiar la configuracién segin la

aplicacién de video o las condiciones de
grabacion.

Formato de video

Los formatos disponibles que se pueden
seleccionar varian segun los ajustes de la
frecuencia del sistema y del codec.

Cambio de la frecuencia del sistema

Cambie utilizando Rec Format (pdgina 94)
>Frequency en el ment System.

La videocdmara se reiniciard automdticamente
tras el cambio.

* No puede cambiar la frecuencia del sistema durante
una grabacién o una reproduccién.

Cambio del codec

Cambie utilizando Rec Format (pdgina 94)
>Codec en el mend System.

¢ No puede cambiar el c6dec durante una grabacién o
una reproduccion.

Cambio de formato

Cambie utilizando Rec Format (pdgina 94)
>Video Format en el mend System.

Las sefiales de los conectores SDI OUT y HDMI
OUT también se envian en el formato
seleccionado mediante este menu.

¢ No puede cambiar el formato durante una grabacién o
una reproduccién.
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Ajuste del brillo

(A}

Puede ajustar el brillo mediante el ajuste de
diafragma, ganancia y velocidad del obturador y
también mediante el ajuste del nivel de luz con
filtros ND.

Filmacion con iris automatico

Cuando el modo Full Auto (pdgina 23) esta
activado
El iris se ajusta a la fuerza en el modo Auto.

Cuando el modo Full Auto esta desactivado
Coloque el interruptor IRIS en la posicién
AUTO. Se ajustard el modo Automatico.

La opcidn de ajuste aplicada cuando el interruptor
AUTO/MANUAL del iris se establece en
MANUAL también se puede configurar usando el
menu directo (pdgina 34).

Filmacion con iris manual

Si el modo Full Auto se encuentra desactivado,
ajuste el interruptor IRIS en MANUAL. Se
ajustard el modo Manual. Gire el anillo de
enfoque |A| para ajustar el iris.

La opcidn de ajuste aplicada cuando el interruptor
AUTO/MANUAL del iris se establece en
MANUAL también se puede configurar usando el
menu directo (pdgina 34).



Cambio al iris automatico de forma temporal
En el modo de iris manual, presione el bot6n IRIS
PUSH AUTO [H] para activar la funcién de iris
automatico con una pulsacion.

El iris automdtico estard activado mientras se
pulse el bot6n. Suelte el botdn para volver al
modo de iris manual.

Filmacidn con control automatico de
ganancia (AGC)

Cuando el modo Full Auto (pdgina 23) esta
activado

Se fuerza la activacion del modo AGC (Control
automdtico de ganancia).

Cuando el modo Full Auto esta desactivado
Ajuste Auto Exposure >AGC (pdgina 73), en el
menud Camera, en On para activar el modo AGC.
También se puede ajustar el modo AGC en on/off
mediante el menu directo (pdgina 34).

Toma de imagenes con una ganancia fija

1. Desactive el modo Full Auto.

2. Cuando se ajuste la ganancia
automaticamente, ajuste Auto Exposure
>AGC (pdgina 73) del mend Camera en Off.
“AGC” desaparece.

3. Ajuste el interruptor GAIN [G] en H, Mo L.
El valor de ganancia ajustado para la
posicion del interruptor de ganancia
seleccionada aparece en la pantalla.

Es posible ajustar un valor de ganancia para
H/M/L mediante Gain (pdgina 72), en el
ment Camera.

También se puede ajustar el valor H/M/L
mediante el menu directo (pdgina 34).

Captura de imagenes en el modo de
obturador automatico

Cuando el modo Full Auto (pdgina 23) esta
activado

El obturador se ajusta a la fuerza en el modo
automdtico.

Cuando el modo Full Auto esta desactivado
Ajuste Auto Exposure >Auto Shutter
(pdgina 74), en el menti Camera en On para
activar el modo de velocidad de obturacién
automadtica.

28

También se puede activar el obturador automatico
al seleccionar Auto Shutter en el mendu directo y
ajustarlo en On.

Toma de imagenes con un obturador fijo

Cuando el modo Full Auto estd desactivado y
Auto Exposure >Auto Shutter (pdgina 74) en el
menud Camera estd en posicion Off, coloque el
interruptor SHUTTER |F] en la posicién ON para
establecer el obturador fijo con el modo de
obturacién y la velocidad configurados mediante
Shutter (pdgina 73), en el mentd Camera.

Ajuste en el menii Camera

Seleccione Shutter (pdgina 73) en el menu
Camera y ajuste el modo de obturador y la
velocidad.

Ajuste mediante el menii directo

También puede activar/desactivar el modo ECS
(pdgina 73) y la velocidad del obturador
mediante el menu directo (pdgina 34).

Ajuste del nivel de luz (filtro ND)

Puede filmar un sujeto con el brillo adecuado
mediante la utilizacién del interruptor ND
FILTER [C| cuando el entorno de grabacién
presenta demasiado brillo.

La videocdmara dispone de dos modos de filtro
ND. Puede cambiar el modo mediante el
interruptor de modo ND FILTER [D].

Modo predeterminado

Ajuste el interruptor de modo ND FILTER [D] en
PRESET y, a continuacion, ajuste el interruptor
ND FILTER |C]| en lo siguiente.

CLEAR: No se usa el filtro ND.

1: Densidad del filtro establecida mediante ND
Filter >Preset1, en el ment Camera. El ajuste
predeterminado es 1/4.

2: Densidad del filtro establecida mediante ND
Filter >Preset2, en el ment Camera. El ajuste
predeterminado es 1/16.

3: Densidad del filtro establecida mediante ND
Filter >Preset3, en el ment Camera. El ajuste
predeterminado es 1/64.

Modo Variable

Ajuste el interruptor de modo ND FILTER [D] en
PRESET y, a continuacion, ajuste el interruptor
ND FILTER |C]| en lo siguiente.

CLEAR: No se usa el filtro ND.



1, 2, 3: Puede ajustar la densidad del filtro entre
1/4 'y 1/128 de manera continua mediante el dial
de control ND [E|.

La posicion del interruptor ND FILTER

(1/2/3) no afecta al ajuste de la densidad del filtro.

Filtro ND automatico

Cuando se coloca el interruptor de modo ND
FILTER en VARIABLE y el interruptor ND
FILTER en una posicion del 1 al 3, puede ajustar
la densidad del filtro ND de forma automdtica si
ajusta Auto Exposure >Auto ND Filter

(pdgina 73) en el ment Camera, en On.
También puede activar/desactivar el Auto ND
Filter mediante el menu directo (pdgina 34).
Cuando Auto ND Filter esta desactivado, puede
seleccionar la densidad del filtro ND en el ment
directo.

Ajuste de exposicion automatica

La exposicion automatica controla el brillo
excesivo a un nivel apropiado mediante las

funciones de filtro ND, iris, ganancia y obturador.

Ajuste el modo de control mediante Auto
Exposure (pdgina 73) >Mode, en el mend
Camera, y ajuste el nivel mediante Level.
También se puede ajustar el modo de control y el
nivel de correccion mediante el meni directo
(pdgina 34).

Uso de la funcidn de reduccion de
parpadeo

Ajuste Flicker Reduce (pdgina 74) >Mode, en el
menu Camera, en Auto u On y ajuste Frequency a
la frecuencia de la fuente de alimentacion (50 Hz
0 60 Hz).

« Sila velocidad de fotograma de la filmacién es
parecida a la frecuencia de la fuente de alimentacién,
es posible que el parpadeo no se reduzca por completo
al utilizar la funcién de reduccién de parpadeo. En tal
caso, utilice el obturador electrénico.
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Ajuste de colores naturales
(balance de blancos)

GAIN SEL/SET

WHT BAL

: = Y
@)
Ot | @ %

Bl
Puede seleccionar el modo de ajuste que mejor se
adapte a las condiciones de filmacion.

Modo predeterminado

Este modo ajusta la temperatura del color a un
valor predeterminado (el valor predeterminado de
fabrica es 3200K). Seleccione este modo si no
tiene tiempo de ajustar el balance de blancos o si
desea fijar el balance de blancos al ajuste
preestablecido mediante White (pdgina 76)
>Preset White en el mend Paint.

Modo Memory A, modo Memory B

Este modo ajusta el balance de blancos en la
configuracién guardada en la memoria A o B
respectivamente.

Pulse el botén WB SET |A| para ejecutar el
balance de blancos y almacenar el valor ajustado
en Memory A o Memory B.

Modo ATW (Localizacion automatica del balance
de blancos)

En este modo, la videocdmara ajusta
automaticamente el balance de blancos en la
condicién adecuada.

El balance de blancos se ajusta automdticamente
cuando la temperatura de color de la fuente de luz
cambia.

Puede seleccionar la velocidad de ajuste (cinco
pasos) mediante White Setting >ATW Speed
(pdgina 76), en el menu Paint.

Puede congelar el ajuste del balance de blancos
actual si asigna la funcién ATW Hold a un botén



asignable (pdgina 36) y pulsa el boton asignable
para pausar temporalmente el modo ATW.

Tal vez no sea posible ajustar los colores adecuados

con ATW, segtin las condiciones de iluminacion y del

sujeto.

Ejemplos:

— Cuando un tnico color domina el sujeto, como por
ejemplo el cielo, el mar, la tierra o las flores.

— Cuando la temperatura del color es extremadamente
alta o extremadamente baja.
Si no se puede obtener el efecto adecuado porque la
velocidad de correccion automdtica de ATW es
demasiado lenta o por cualquier otro sujeto, utilice
el balance de blancos automatico.

Utilizacidn del interruptor

Seleccione el modo con el interruptor WHT BAL
[Bl.

B: Modo ATW o modo Memoria B

A: Modo Memoria A

PRESET: Modo predeterminado

La posicion B del interruptor WHT BAL estd
asignada de forma predeterminada al modo
ATW. Puede cambiar este ajuste para seleccionar
el modo Memory B mediante White Setting
>White Switch<B> (pdgina 76), en el ment
Paint.

Si se ajusta la videocdmara en el modo
automdtico completo (pdgina 23) se activa
forzosamente el modo ATW.

Si se asigna la funcién de activacién/
desactivacion de ATW a un botdn asignable
(pdgina 36), se puede activar/desactivar el ATW
de forma independiente cuando el modo
automdtico completo estd desactivado.

Uso del Menii directo

Pulse el botéon DISPLAY (pdgina 10) para
visualizar el modo seleccionado y la temperatura
del color en la pantalla (pdgina 11).

ATW: Modo ATW

W:A: Modo Memoria A

W:B: Modo Memoria B

W:P: Modo Predeterminado

En el ment directo (pdgina 34), puede cambiar el
modo de ajuste en lo siguiente.

Cuando se coloca el interruptor WHT BAL en la
posicion B, se pueden ajustar los modos ATW y
Memory B.

Cuando se coloca el interruptor WHT BAL en la
posicion A, se pueden ajustar los modos ATW y
Memory A.
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Cuando se coloca el interruptor WHT BAL en la
posicion PRESET, se pueden ajustar el modo
ATW y el modo predeterminado.

Puede ajustar la temperatura del color en el ment
directo cuando no estd configurada en el modo
ATW.

Puede cambiar la temperatura del color en el
ment directo seleccionando el indicador de la
temperatura del color. En el modo predefinido, al
pulsar el botén WB SET, también se establece la
temperatura del color.

Cambio del modo predeterminado
mediante un bhotén asignable

Asigne Preset White Select a un botén asignable
(pdgina 36). Puede cambiar los valores del modo
predeterminado del interruptor en el siguiente
orden, cada vez que pulse el boton: 3200K,
4300K, 5600K y 6300K.

Ejecucion del balance de blancos
automatico

1 Para guardar un valor de ajuste en la
memoria, seleccione el modo Memory A
o0 el modo Memory B.

2 Coloque un papel blanco (u otro objeto)
en un lugar con la misma fuente de
iluminacién y condiciones que el sujeto
y, a continuacion, utilice el zoom para
acercarse al papel y asi mostrar blanco
en la pantalla.

3 Ajuste el brillo.

Ajuste el iris tal como se describe en
“Filmacion con iris manual” (pdgina 27).

4 pulse el botén WB SET [Al.

Cuando ejecute el ajuste en un modo de
memoria, el valor ajustado se almacenard en
la memoria (A o B) seleccionada en el paso 1.
Si el balance de blancos se ejecuta en el
modo ATW, el ajuste del balance de blancos
vuelve al balance de blancos del modo ATW
cuando finaliza el ajuste.

« El ajuste de Auto White Balance no se puede llevar a
cabo en el modo Preset.

* Si el ajuste no se realiza correctamente, aparecerd un
mensaje de error en la pantalla. Si el mensaje de error



contintia después de varios intentos repetidos de ajuste
del balance de blancos, péngase en contacto con su
servicio de asistencia técnica de Sony.

Especificacion del audio que se va
a grabar

Los siguientes conectores, interruptores y
selectores le permiten ajustar el sonido que desea
grabar.

y
) )
MIC+48V MI

INPUT2
LINE MIC INT

T i
MIC+48V Wi [

[H]

Interruptores de seleccion y conectores de
entrada de audio externa

Conector AUDIO INPUT1

Conector AUDIO INPUT2

Interruptor INPUT1

Interruptor INPUT2 H]

Interruptores de fuentes de audio
Interruptor CH1 (INT/EXT/MI SHOE) D]
Interruptor CH2 (INT/EXT/MI SHOE)

Interruptores para ajustar el nivel de audio
Dial AUDIO LEVEL (CH1) [E]
Dial AUDIO LEVEL (CH2) [F|

Consulte los diagramas de bloques (pdgina 114).

Utilizacion del microfono interno

Puede grabar sonido con el micré6fono interno.
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Para grabar en CH1, CH2

Coloque los interruptores CH1 (INT/EXT/
MISHOE) IE y CH2 (INT/EXT/MI SHOE)
en INT.

Para grabar en CH3, CH4

Seleccione Internal MIC utilizando Audio
Input (pdgina 81) >CH3 Input Select y CH4
Input Select en el mentd Audio.

Utilizacion del dispositivo de audio
externo

Los mezcladores y otros dispositivos de audio
externos son compatibles.

Para grabar en CH1, CH2

1 Coloque los interruptores CH1 (INT/
EXT/MI SHOE) [D] y CH2 (INT/EXT/
MI SHOE) [G] en EXT.

Cuando Audio Input >CH2 EXT Input
Select, en el mend Audio, se encuentre
ajustado en INPUT?2, el sonido procedente
del conector AUDIO INPUT]1 se grabard en
CH1 y el sonido del conector AUDIO
INPUT?2 se grabard en CH2.

Cuando CH2 EXT Input Select se encuentre
ajustado en INPUT], el sonido del conector
AUDIO INPUT]1 se grabard en CH1 y CH2.

2 Coloque los interruptores INPUT1/
INPUT2 ((Cl/[H]) en LINE.

3 Conecteun dispositivo de audio externo
a los conectores AUDIO INPUT1/
AUDIO INPUT?2 ([Al/[B)).

Para grabar en CH3, CH4

1 Seleccione INPUTT utilizando Audio
Input (pdgina 81) >CH3 Input Select e
INPUT2 mediante CH4 Input Select en
el mend Audio.

Si se selecciona INPUT1 mediante CH4
Input Select, el sonido del conector AUDIO
INPUT]1 se grabard en CH3 y CH4.

2 Realice los pasos 2 y 3, tal como se
describe en ‘“Para grabar en CH1,
CH2”.



Uso de un microfono externo

Es posible conectar un micréfono de condensador
de electreto u otros dispositivos y utilizarlos para
grabar.

Para grabar en CH1, CH2

1 Coloque los interruptores CH1 (INT/
EXT/MI SHOE) D] y CH2 (INT/EXT/
MI SHOE) [G] en EXT.

Cuando Audio Input >CH2 EXT Input
Select, en el mend Audio, se encuentre
ajustado en INPUT?2, el sonido procedente
del conector AUDIO INPUT! se grabard en
CH1 y el sonido del conector AUDIO
INPUT?2 se grabard en CH2.

Cuando CH2 EXT Input Select se encuentre
ajustado en INPUT1, el sonido del conector
AUDIO INPUT1 se grabard en CH1 y CH2.

2 Ajuste los interruptores INPUT1/
INPUT2 ([CI/[H)).

MIC: Para un micr6fono que no necesite
alimentacién phantom.

MIC+48V: Para un micréfono que necesite
alimentacion phantom de +48 V.

Si selecciona “MIC+48V” y conecta un
micréfono que no sea compatible con fuentes de
+48 V, es posible que daifie el dispositivo
conectado. Compruebe dicho aspecto antes de
conectar el dispositivo.

Si le preocupa el ruido en conectores que no
tengan un dispositivo conectado, ajuste los
interruptores INPUT1/INPUT2 correspondientes
en LINE.

3 Abra la cubierta tirando del asa del
soporte del micr6fono.

4 Instale un micréfono y cierre el soporte
para asegurarlo.

9 Conecte el cable del micréfono a los
conectores AUDIO INPUT1/AUDIO
INPUT?2 ((A)/[B)).

Cuando utilice un micréfono estéreo

(2 clavijas XLR), conecte la clavija del canal
L (izquierdo) al conector AUDIO INPUT1 y
la del canal R (derecho) al conector AUDIO
INPUT2.
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Para grabar en CH3, CH4

1 Seleccione INPUTT1 utilizando Audio
Input (pdgina 81) >CH3 Input Select e
INPUT2 mediante CH4 Input Select en
el mend Audio.

Si se selecciona INPUT1 mediante CH4
Input Select, el sonido del conector AUDIO
INPUT]1 se grabard en CH3 y CH4.

2 Realice los pasos de 2 a 5, tal como se
describe en ‘“Para grabar en CH1,
CH2”.

Utilizacion de un micréfono compatible
con una zapata de interfaz maltiple

Para grabar en CH1, CH2

1 Coloque los interruptores CH1 (INT/
EXT/MI SHOE) D] y CH2 (INT/EXT/
MI SHOE) |G| en MI SHOE.

2 Conecte un micréfono a la zapata de
interfaz multiple.

Para grabar en CH3, CH4

1 Seleccione Shoe CH1 utilizando Audio
Input (pdgina 81) >CH3 Input Select y
Shoe CH2 mediante CH4 Input Select
en el mend Audio.

2 Conecte un micréfono ala zapata de
interfaz multiple.

* No se pueden conectar dos micréfonos a la zapata de
interfaz multiple de la parte delantera y de la parte
trasera al mismo tiempo. El primer micréfono
conectado serd el micréfono activo.

Ajuste del nivel de grabacion de audio

Para CH1, CH2

Ajuste automatico (AGC):

Ajuste los diales AUDIO LEVEL (CH1/
CH2) ([E)/[F)) a 1a posicién AUTO.

Puede establecer que los niveles de CH1 y CH2 se
ajusten automdticamente por separado (Mono) o
de forma conjunta (Stereo) mediante Audio Input
(pdgina 81) >CH1&2 AGC Mode en el ment
Audio.



Ajuste manual:

Durante la filmacion o en espera, gire los
diales AUDIO LEVEL (CH1/CH2) ([EJ/[F])
delos canales correspondientes, en un
intervalo de 0 a 10, para ajustar el nivel de
grabacion de audio del micréfono.

Para CH3, CH4

Ajuste automatico (AGC):

Ajuste Audio Input (pdgina 81) >CH3 Level
Control/CH4 Level Control en el meni
Audio a Auto.

Puede establecer que los niveles de CH3 y CH4 se
ajusten automdticamente por separado (Mono) o
de forma conjunta (Stereo) mediante Audio Input
(pdgina 81) >CH3&4 AGC Mode en el ment
Audio.

Ajuste manual:

1 Ajuste Audio Input (pdgina 81) >CH3
Level Control/CH4 Level Control en el
meni Audio a Manual.

2 Ajuste el nivel de grabacion de audio
usando CH3 Input Level/CH4 Input
Level.

Para reducir el ruido del viento, ajuste Audio
Input >CH Wind Filter del mend Audio en On
(pdgina 81).

Grabacion de audio en modos de
grabacidon especiales

El audio no se graba cuando se encuentra en el
modo Interval Rec o el modo Slow & Quick
Motion.

Estabilizacién de la imagen

Al activar la funcién de estabilizacion de la
imagen (SteadyShot), se suprimen las sacudidas
de la imagen causadas por los movimientos de la
cdmara durante una grabacion.

Ajuste SteadyShot (pdgina 74) >Setting en
el meni Camera a Active o Standard.
Standard: reduce el temblor de la imagen
debido al movimiento de la cimara.
Active: reduce el temblor de la imagen debido al
movimiento rdpido de la cdmara, como al
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caminar, usando una correccién mds fuerte
que la del ajuste Standard.
Off: desactiva el modo de estabilizacién de
imagen.
Asigne la funcién SteadyShot a un botén
asignable (pdgina 36) y alterne el modo de
estabilizacion de la imagen entre Standard,
Active y Off presionando el botén.
Este ajuste aparece en la pantalla LCD/pantalla
del visor.
El modo de estabilizacién de imagen también se
puede cambiar entre Standard, Active y Off
usando el men directo (pdgina 34).

El ajuste Active no estard disponible en los siguientes
€asos.

— Cuando Video Format es 3840x2160

— Durante la grabacién Slow & Quick Motion
Cuando filme con un tripode para tener estabilidad,
establezca SteadyShot en Off.

Datos sobre el tiempo

Ajuste del codigo de tiempo

Ajuste el codigo de tiempo que se va a grabar
mediante Timecode (pdgina 87) en el meni TC/
UB.

Ajuste de los hits del usuario

Puede afiadir un nimero hexadecimal de 8 digitos
a la imagen grabada como bits de usuario.
También puede establecer los bits del usuario a la
hora actual.

Ajuste utilizando Users Bit (pdgina 87) en el
menid TC/UB.

Visualizacion de los datos de tiempo

Pulse el boton DISPLAY para mostrar los datos
de tiempo en la pantalla (pdgina 11).

La indicacién cambia entre el cédigo de tiempo,
los bits de usuario y la duracién de la grabacion

cada vez que se pulsa el boton DURATION/TC/
U-BIT (pdgina 10).

Pantalla
TCG sk sk

CLK ks skok ok

Descripcion
Cédigo de tiempo

Cédigo de tiempo (modo
Clock)
Bits de usuario

UBG #3% #% sk s
DUR 3% :#3%. sk e

Duracién desde el inicio de la
grabacion




Funciones utiles

Funcionamiento del meni directo

Puede comprobar el estado y los ajustes de
cambio de algunos objetos mostrados
directamente en la pantalla LCD/visor.

La funcién del Direct Menu se utiliza al asignarle
dicha funcidn a un botdn asignable.

Estos son los elementos que pueden configurarse.
* Modo de enfoque automatico

« SteadyShot

* ATW

* Preset White

¢ Color Temp <A>/Color Temp <B>

* Scene File

¢ Auto ND Filter

« Valor de ND Filter

¢ Auto Iris

« Valor de Iris

*« AGC

¢ Valor de Gain (H/M/L/Turbo)

« ECS

 Auto Shutter

¢ Valor de Shutter Speed

 Valor de Shutter Angle

* Auto Exposure Mode

* Auto Exposure Level

* S&Q Frame Rate

« El funcionamiento del mend directo no estd disponible
cuando el modo Full Auto (pdgina 23) estd activado (el
indicador FULL AUTO estd encendido).

1 Pulse el botén asignable al que le haya
asignado Direct Menu.

Cuando la informacién se muestra en la
pantalla LCD/visor con el botén DISPLAY,
solo se pueden seleccionar mediante el cursor
los elementos de la pantalla que se pueden
configurar mediante el menu directo.
Cuando la informacién no aparece en la
pantalla LCD/visor, solo se muestran y solo
se pueden seleccionar mediante el cursor los
elementos que se pueden configurar
mediante el menu directo.
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2 Mueva el cursor al elemento deseado
con el boton 4/¥%/«/% o el dial SEL/SET.
A continuacion, pulse el botén SET o el
dial SEL/SET.

Aparecerd el menu directo de los elementos
seleccionados.

3 Seleccione un ajuste con el botén 4/% o
el dial SEL/SET. A continuacién, pulse
el boton SET o el dial SEL/SET.

El cursor desaparece y se muestra el nuevo
ajuste.

Pulse de nuevo el botén asignable al que se
ha asignado la funcién Direct Menu o espere
3 segundos sin realizar ninguna accién para
cerrar el menu directo y volver a la pantalla
de filmacion.

Puede abrir el ment directo estableciendo Menu
Settings >Direct Menu with <SET> (pdgina 97)
en el mend System en On y pulsando el botén
SET o el dial SEL/SET. Sin embargo, la funcién
de cara registrada de la deteccién facial AF deja
de estar disponible.

Deteccion facial AF

La videocdmara puede detectar las caras de la
gente y ajustar el enfoque en las caras.

Esta funcién solo estd disponible cuando el ajuste
del enfoque estd en el modo AF o durante el
enfoque automadtico mediante una pulsacion.
Cuando se detecta una cara, aparece un marco
gris de deteccion facial. El marco se vuelve de
color blanco cuando se establece el enfoque
automdtico. Cuando se detectan varios
individuos, se determina el individuo principal
automdticamente.

Configure el funcionamiento de la deteccién
facial AF mediante Focus (pdgina 72), en el
menid Camera.

Face Only AF: la cdmara detecta las caras de los
sujetos (personas) y solo enfoca en las caras.
Aunque no se detecte una cara, AF se detiene
temporalmente (MF), se muestra el icono de
enfoque automadtica pausado del modo Face
Only AF [1] (pdgina 11). Este modo resulta
eficaz cuando no se ha estabilizado la
deteccién de caras.

Face Priority AF: la cimara detecta las caras de
los sujetos (personas) y prioriza el enfoque



en las caras. Cuando no se detecta ninguna
cara, el enfoque estd en modo AF (ajuste
predeterminado)

Off: la funcién de deteccion facial AF estd
desactivada.

Durante el funcionamiento del enfoque automatico

mediante una pulsacion, se activa la Face Priority AF,

incluso si se ha seleccionado Face Only AF.

La deteccién facial AF no estard disponible en los

siguientes casos.

— En modo Full MF

— Cuando el interruptor FOCUS se ha establecido en
MANUAL (salvo durante el funcionamiento del
enfoque automdtico mediante una pulsacion)

— Cuando el formato de grabacién es DVCAM

Si apaga la videocdmara mientras Face Only AF estd

seleccionado, el modo cambia automdticamente a Face

Priority AF cuando vuelva a encender la cimara.

Ocultar marcos de deteccion de caras

Puede mostrar/ocultar los marcos de deteccién de
caras mediante Display On/Off >Face Detection
Frame (pdgina 85) en el meni LCD/VF.

Enfoque en una cara registrada

Durante el funcionamiento de la deteccion facial
AF, puede registrar una cara como sujeto
(persona), para realizar el enfoque en dicha cara.
Solo se puede registrar una cara. El registro de
una cara sobrescribe el registro actual.

Cuando se registra una cara, el marco de

deteccién cambia a un marco doble y se muestra

el icono de cara registrada g (pdgina 11).

En la deteccidn facial AF, las siguientes acciones

tienen lugar dependiendo de si se ha registrado

una cara y del modo de funcionamiento de la
deteccion facial AF.

Face Priority AF (con cararegistrada): sila
cdmara detecta una cara registrada, la cimara
la enfoca. Si no se detecta ninguna cara
registrada, se activa el modo normal de Face
Priority AF.

Face Only AF (con cara registrada): si la
cdmara detecta una cara registrada, la cimara
la enfoca. Si no se detecta la cara registrada,
AF se detiene temporalmente (MF) y se
muestra el icono de enfoque automatico
pausado del modo Face Only AF [1]
(pdgina 11). Este modo resulta eficaz cuando
desea enfocar automaticamente la persona
registrada.

Ajuste de la cara registrada

Mueva el cursor de seleccion de caras
(destacado en naranja) al elemento deseado
con el boton 4/¥%/«/%. A continuacion, pulse
el boton SET o el dial SEL/SET.

Marco de cara registrado
Otras caras (gris) (marco blanco doble)

Cursor de seleccion de cara (naranja)

Borrar la cara registrada

Mueva el cursor de seleccion a la cara registrada
con el boton #/¥/«/%. A continuacién, pulse el
botén SET o el dial SEL/SET.

La cara registrada se borra, el marco de la cara
pasa a ser un marco tnico y el icono de cara
registrada desaparece.

Cuando se detectan caras sin mostrar el marco de
cararegistrada y se muestra el cursor de seleccién
de caras (naranja), puede borrar la cara registrada
pulsando dos veces el botén SET o el dial SEL/
SET.

* Es posible que no se detecten las caras a causa del
entorno de grabacion, la condicién del sujeto o los
ajustes.

Es posible que no pueda obtener el efecto adecuado o
que se pueda detectar como una cara objetos que no
sean caras de personas, en algunos entornos de
grabacion. En este caso, ajuste la funcién AF de
deteccion de cara en Off.

Se recomienda el registro de la cara del individuo
previsto para realizar el enfoque antes de filmar.

El registro de caras puede resultar incorrecto en
funcidn del estilo del pelo o la decoracion facial o si no
se mira directamente a la cimara. En este caso, el
marco de la cara puede convertirse en un doble marco,
pero no se muestra el icono de cara registrada.

Si ya se ha registrado una cara, se recomienda borrar la
cara existente y, a continuacion, registrar la cara nueva.
La funcion de cara registrada no estd disponible
cuando se establece Menu Settings >Direct Menu with
<SET> (pdgina 97) en el mend System en On.



Cambio del funcionamiento de la
deteccion facial AF con un hoton
asignable

Asigne Face Detection AF a un botén asignable
(pdgina 36). Puede cambiar el funcionamiento de
la deteccidn facial AF cada vez que pulse el
botén, en el siguiente orden: Face Priority AF,
Face Only AF y Off.

Ajuste mediante el menii directo

También se puede ajustar el funcionamiento de la
deteccion facial AF mediante el ment directo
(pdgina 34).

Barras de color/tono aciistico de
referencia

Puede seleccionar las barras de color en lugar de
la imagen de la camara si establece Color Bars
(pdgina 74) >Setting, en el ment Camera en On.
La seleccion de imédgenes se restablece al
ajustarlo en Off.

También puede seleccionar un tono actstico de
1 kHz con las barras de color si establece Audio
Input (pdgina 81) >1kHz Tone on Color Bars, en
el menud Audio, en On.

La sefal de la barra de color y la sefial del tono de
referencia se emiten desde los conectores SDI
OUT y HDMI OUT.

Puede establecer el tipo de barras de color

mediante Color Bars >Type, en el meni Camera.

¢ Las barras de color no se pueden emitir cuando la

videocdmara estd en el modo de Cdmara lenta y rdpida.

* No puede cambiar a las barras de color mientras graba
(pero puede cambiar de las barras de color a la imagen
de la camara).

Revision de una grabacion (Rec
Review)

Se puede comprobar el dltimo clip grabado en la
pantalla (Rec Review).

Cuando detenga la grabacién, pulse el

botén asignable al que se ha asignado la
funcion Rec Review.
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Aparecerdn los dltimos 3 segundos, 10 segundos
o el clip completo, dependiendo del ajuste de Rec
Review (pdgina 89), en el ment Recording.

El clip se reproduce hasta el final, Rec Review
finaliza y el camcorder vuelve al modo STBY (en
espera).

Para detener Rec Review

Pulse el botén STOP/CAM o un botén
asignable al que le haya asignado la funcién
Rec Review.

* Rec Review no es compatible si el formato de video se
cambia después de grabar un clip.

* Los menis de configuracién no se pueden utilizar
durante Rec Review.

Botones asignables

Existen ocho botones asignables (pdgina 6) en la
videocdmara a los que puede asignar diversas
funciones.

Modificacion de funciones

Utilice el Assignable Button (pdgina 95) del
mend System.

Puede visualizar las funciones asignadas en la
pantalla de estado de los botones asignables
(pdgina 14).

Funciones asignadas por defecto

Botén 1 Zebra

Botén 2 Peaking

Botén 3 Video Signal Monitor
Botén 4 Off

Botén 5 Off

Botén 6 Off

Botén 7 Direct Menu

Botén 8 Focus Magnifier

Funciones asignables
Para obtener mds detalles acerca de cada funcidn,
consulte pdgina 95.

e Off

¢ Push AF/Push MF

» Face Detection AF
* Focus Macro

¢ Auto ND Filter

¢ Push Auto ND

¢ Push Auto Iris

* Turbo Gain

* AGC

* Shutter



« Auto Exposure Level
* Spotlight

* Backlight

« Flash Band Reduce

* Digital Extender x2
¢ Handle Zoom

« SteadyShot

* Color Bars

* Preset White Select
« ATW

* ATW Hold

* Marker

¢ Zebra

¢ Peaking

* Video Signal Monitor
« Focus Magnifier
 Lens Info

* LCD/VF Adjust

* VF Mode

¢ Gamma Display Assist
« Display

* Rec

* S&Q Motion

* Clip Continuous Rec
* Picture Cache Rec

* Proxy Rec Start/Stop
* Rec Review

« Last Clip Delete

¢ Thumbnail

* NFC

« Direct Menu

* User Menu

* Menu

Grabacidn a intervalos (Interval
Rec)

Puede grabar imdgenes automaticamente a
intervalos establecidos si establece el nimero de
fotogramas por toma (Number of Frames) y el
intervalo de filmacion (Interval Time).

Esta funcion es una manera efectiva de filmar
sujetos que se mueven lentamente.
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Intervalo de filmacioén (Interval Time)

—

Numero de fotogramas en una toma
(Number of Frames)

Se recomienda fijar la videocdmara en un tripode
o similar y utilizar el control remoto web para
iniciar/detener la grabacién en lugar de pulsar el
botén de grabacion de la videocdmara.

* No es posible grabar audio en el modo Interval Rec.
No se puede ajustar el modo Interval Rec en On al
mismo tiempo que Picture Cache Rec, S&Q Motion,
Clip Continuous Rec, 2-slot Simul Rec o Proxy Rec.
Al ajustar Interval Rec en On, estas otras funciones se
establecen forzosamente en Off.

Configuracién antes de la filmacion

Configure Interval Rec (pdgina 88) en el meni
Recording antes de filmar.

Cuando se ajusta Setting en On, se activa el modo
Interval Rec y aparece “Int Stby” en la pantalla.

Cuando se monta a luz de video compatible con la
zapata de interfaz miltiple, puede ajustar Interval
Rec >Pre-Lighting en el meni Recording en On,
de forma que la luz se encienda automdticamente
aproximadamente 2, 5 o 10 segundos antes de
grabar.

¢ Cuando se ajusta Pre-Lighting en On, la luz de video
permanece encendida si el tiempo de apagado de la luz
de video es inferior a 5 segundos, de acuerdo con el
ajuste Interval Time, incluso cuando el Video Light Set
estd configurado en Rec Link o Rec Link + Stby en el
mend Camera.

Grabacion en el modo Interval Rec

Inicie la grabacién tras completar el ajuste
requerido.



Pulse el botén de grabacién.

Cuando empiece a grabar, el indicador “Int Stby”

cambia y alterna entre “Int @Rec” e “Int @Stby”.

Mientras graba en el modo Interval Rec, no se pueden
cambiar los ajustes Interval Time ni Number of
Frames. Para cambiar los ajustes, deje de grabar
primero.

Tras iniciar la grabacién en el modo Interval Rec, la
operacién Rec Review se deshabilita, incluso durante
los intervalos.

El cédigo de tiempo se graba en el modo Rec Run
durante la grabacién en el modo Interval Rec

(pdgina 87).

Es posible que se graben algunos fotogramas
adicionales si se detiene la grabacién o se cambia de
ranura de tarjeta mientras la grabacion estd detenida en
el modo Interval Rec.

Interval Rec >Setting se ajusta automdticamente en
Off cuando el interruptor ON/STANDBY se ajusta en
la posicion STANDBY. Sin embargo, los ajustes
Interval Time y Number of Frames se mantendran.

Grabacidn continua (Clip
Continuous Rec)

Normalmente, los clips se crean como archivos
independientes cada vez que inicia y detiene la
grabacién. No obstante, el modo Clip Continuous
Rec le permite iniciar y detener la grabacion
mientras graba de manera continua en el mismo
clip mientras el modo permanezca activado.
Esto resulta conveniente cuando no desea generar
un nimero elevado de clips cortos y cuando desea
grabar sin tener que preocuparse por exceder el
limite de clips. Resulta sencillo encontrar puntos
de inicio de grabaciones, debido a que se registra
una marca de inicio de grabacién en el punto de
inicio de la grabacion cada vez que comienza a
grabar.

Si desea obtener informacién detallada acerca de
los formatos de grabacién compatibles con Clip
Continuous Rec, consulte (pdgina 104).

Configuracion antes de la filmacion

Configure Clip Continuous Rec (pdgina 88) en el
menu Recording antes de filmar.

Cuando se ajusta Setting en On, se activa el modo
Clip Continuous Rec y aparece “Cont Stby” en la
pantalla (pdgina 11).

Configuracion mediante los botones asignables
También puede asignar Clip Continuous Rec a un
botén asignable (pdgina 36), y ajustar el modo
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Clip Continuous Rec en On/Off pulsando el
botén.

* Clip Continuous Rec no puede ajustarse en On al
mismo tiempo que Interval Rec, Picture Cache Rec,
S&Q Motion o 2-slot Simul Rec. Cuando Clip
Continuous Rec estd ajustado en On, estos otros modos
de grabacién se establecen de forma forzosa en Off.

* El modo Clip Continuous Rec no puede utilizarse al
grabar.

Grabacion en el modo Clip Continuous
Rec

Inicie la grabacién tras completar el ajuste
requerido.

Pulse el boton de grabacion.

Cuando comience a grabar, la indicacién “Cont
Stby” cambia a “Cont @Rec” (@ se vuelve de
color rojo).

Durante la grabacién o en el modo de espera de la
grabacion (cuando se muestre la indicacién “Cont
Stby™), si retira la tarjeta de memoria, la bateria o la
fuente de alimentacion, deberd restaurar la tarjeta de
memoria. Cancele del modo Clip Continuous Rec y, a
continuacion, retire la tarjeta de memoria. Si la
indicacién “Cont Stby” parpadea (una vez por
segundo), puede retirar las tarjetas de memoria.
Detenga la grabacién una vez que hayan transcurrido
dos o mds segundos de esta.

Para salir, detenga la grabacion.

Para cancelar del modo Clip Continuous Rec
En el modo de grabacién en espera, establezca
Clip Continuous Rec (pdgina 88) >Setting, en el
menu Recording, en Off o pulse un botén
asignable al que le haya asignado Clip
Continuous Rec.

Limitaciones

No se puede crear un solo clip continuo si lleva a

cabo una de las siguientes operaciones mientras la

videocdmara estd grabando o en el modo de

espera de grabacion. Se creard un nuevo clip la

proxima vez que inicie una grabacion.

* Lleve a cabo acciones sobre un clip (bloquéelo,
eliminelo o cambiele el nombre)

» Cambie la ranura de la tarjeta de memoria

* Cambie el formato de grabacion

« Sitte el interruptor ON/STANDBY en
STANDBY.

* Active la pantalla de miniaturas



¢ Reproduzca un clip
« Cancele del modo Clip Continuous Rec

Grabacion de la caché de
imagenes (Picture Cache Rec)

La videocdmara siempre guarda una caché de los
datos de audio y video durante un intervalo
establecido (médximo 28 segundos) en la memoria
de almacenamiento interno mientras filma, lo que
le permite grabar varios segundos de metraje
antes de empezar a grabar de verdad.

El modo Picture Cache Rec puede utilizarse
cuando el formato de grabacién (pdgina 94) se
establece en XAVC-L.

Picture Cache Rec no puede ajustarse en On al mismo
tiempo que Interval Rec, Clip Continuous Rec, S&Q
Motion, 2-slot Simul Rec o Proxy Rec. Cuando Picture
Cache Rec estd ajustado en On, estos otros modos de
grabacion se establecen de forma forzosa en Off.

El modo Picture Cache Rec no se puede seleccionar
mientras se graba o cuando Rec Review estd en
proceso.

Cuando Picture Cache Rec estd fijado en On, el c6digo
de tiempo se graba en el modo Free Run
independientemente del ajuste del meni TC/UB
(pdgina 87).

Configuracion antes de la filmacion

Configure Picture Cache Rec (pdgina 88) en el
menud Recording antes de filmar.

Cuando se ajusta Setting en On, se activa el modo
Picture Cache Rec y aparece “Cache” en la
pantalla.

Configuracion mediante los botones asignables
Asigne Picture Cache Rec a un bot6n asignable
(pdgina 36), y ajuste la funcién en On/Off
pulsando el botén.

Grabacion en el modo Picture Cache Rec

Inicie la grabacién tras completar el ajuste
requerido.
Pulse el botén de grabacién.

Cuando comience a grabar, la indicacion “Cache”
cambia a “@Rec”.

Para salir, detenga la grabacion.

Para cancelar el modo Picture Cache Rec
Establezca Picture Cache Rec >Setting, en el
menu Recording, en Off o pulse un botén
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asignable al que le haya asignado Picture Cache
Rec.

El cambio del formato de grabacion borra el video de
la memoria intermedia almacenado hasta ese punto y
comienza a almacenar video nuevo. En consecuencia,
la grabacién de memoria intermedia de imdgenes no es
posible antes de cambiar el formato si empieza a grabar
inmediatamente después de cambiar el formato.

Si Picture Cache Rec comienza o se detiene
inmediatamente después de insertar una tarjeta de
memoria, los datos de la memoria intermedia pueden
no grabarse en la tarjeta.

El video se almacena en la memoria intermedia cuando
el modo Picture Cache Rec estd fijado en On. No se
almacena en la memoria media el video anterior al
establecimiento del modo en On.

El video no se almacena en la memoria intermedia
durante el acceso a una tarjeta de memoria, como por
ejemplo durante la reproduccion, Rec Review o la
visualizacién de miniaturas en la pantalla. Durante ese
intervalo, la grabacién de memoria intermedia de
imégenes de video no es posible.

Cuando se acopla una luz de video compatible con la
zapata de interfaz multiple, no se puede grabar en la
memoria intermedia antes de empezar a grabar, aunque
se ajuste Video Light Set, en el ment Camera, en Rec
Link o Rec Link + Stby. La luz se enciende y apaga al
pulsar el botén de grabacion.

Movimiento a camara lenta y
rapida

Cuando el formato de grabacion (pdgina 94) se
establece en uno de los formatos listados mds
abajo, puede especificar una velocidad de
fotograma de grabacion distinta a la velocidad de
fotograma de reproduccién.

Formato de Frecuencia Velocidad de

grabacion del sistema  fotograma
S&Q

XAVC-L 1080P 59.94/29.97/ De 1 a 60 fps

23.98/50/25
XAVC-L2160P 59.94/50

La funcién Slow & Quick Motion no se puede ajustar
durante la grabacién, la reproduccién ni durante la
visualizacién de la pantalla de miniaturas.

La funcién Slow & Quick Motion no puede ajustarse
en On al mismo tiempo que Interval Rec, Clip
Continuous Rec, Picture Cache Rec, 2-slot Simul Rec
o Proxy Rec. Cuando Slow & Quick Motion estd
ajustado en On, estos otros modos de grabacién se
establecen de forma forzosa en Off.

La grabacién automatica no es compatible con el modo
Slow & Quick Motion.

(1 unidad FPS)




Configuracion antes de la filmacion

Configure S&Q Motion (pdgina 87) en el mend

Recording antes de filmar.

Cuando se ajusta Setting en On, se activa el modo
Slow & Quick Motion y aparece “S&Q Stby” en
la pantalla.

Ajuste de la velocidad de fotograma de
grabacion mediante el menii directo

Puede ajustar la velocidad de fotograma en el
modo Slow & Quick Motion, mediante el mend
directo (pdgina 34).

Configuracion mediante los hotones asignables
También puede asignar S&Q Motion a un botén
asignable (pdgina 36), y ajustar el modo Slow &
Quick Motion en On/Off pulsando el botén.
Puede establecer la velocidad de fotograma para
grabaciones si mantiene pulsado un botén
asignable para mostrar la pantalla de
configuracion de la velocidad de fotograma de
grabacion.

Grabacion en modo Slow & Quick Motion

Inicie la grabacién tras completar el ajuste
requerido.

Pulse el boton de grabacion.

Cuando comience a grabar, la indicacién “S&Q
Stby” cambia a “S&Q @Rec”.

No se pueden modificar el ajuste de Frame Rate
mientras la grabacién Slow & Quick Motion estd en
curso. Para cambiar los ajustes, deje de grabar primero.
No se admite el funcionamiento de Rec Review
durante la grabacién Slow & Quick Motion.

El c6digo de tiempo se graba en modo Rec Run
durante la Grabacién Slow & Quick Motion

(pdgina 87).

Cuando graba a una velocidad de fotograma lenta, es
posible que la videocdmara continte grabando durante
varios segundos mas después de pulsar el botén de
grabacién para dejar de grabar.

Para salir, detenga la grabacion.

Para cancelar el modo Slow & Quick Motion
En el modo de grabacidn en espera, establezca
S&Q Motion >Setting, en el ment Recording, en
Off o pulse un botén asignable al que le haya
asignado S&Q Motion.

40

Grabacion simultanea en 2
ranuras (Simul Rec)

Puede grabar simultdneamente en las dos tarjetas
de memoria Ay B.

Configuracidn antes de la filmacidn

Configure Simul Rec (pdgina 88) en el meni
Recording antes de filmar.

* La funcién 2-slot Simul Rec no puede ajustarse en On
al mismo tiempo que Interval Rec, Clip Continuous
Rec, Picture Cache Rec 0 S&Q Motion. Cuando 2-slot
Simul Rec estd ajustado en On, estos otros modos de
grabacion se establecen de forma forzosa en Off.

Grabacion en el modo 2-slot Simul Rec

Inicie la grabacién tras completar el ajuste
requerido.

Pulse el boton de grabacion.

Utilice el mismo tipo y el mismo tamafio de tarjetas de
memora para grabar en 2-slot Simul Rec.

La funcién 2-slot Simul Rec no se puede ajustar
durante la grabacidn, la reproduccién ni durante la
visualizacién de la pantalla de miniaturas.

Cuando una tarjeta de una ranura se llena, si la tarjeta
de memoria de la otra ranura es grabable, la grabacién
continda como una grabacién normal. Cuando se
cambia de tarjeta de memoria durante una grabacién
continua normal, no estard disponible la grabacion
simultdnea ni en relé.

Cuando comience a grabar en el modo 2-slot Simul
Rec, si se inserta un soporte en solo una ranura o si el
soporte de una de las ranuras estd lleno, solo se grabard
el video en el soporte grabable.

Para salir, detenga la grabacion.

Para cancelar el modo 2-slot Simul Rec
En el modo de espera de grabacion, ajuste Simul
Rec >Setting, en el menu Recording, en Off.

Cambio del ajuste del botdn de
grabacion y del boton de grabacion del
asa

Puede iniciar/detener la grabacién en la tarjeta de
memoria de cada ranura de manera independiente
mediante el botn de grabacion de la empufiadura
y el botén de grabacién del asa.

El ajuste predeterminado inicia/detiene la
grabacion en las tarjetas de memoria A y B



simultineamente mediante la utilizacién de uno

de los botones.

* Rec Button:[ A » [ B »| Handle Rec
Button:

Para cambiar el ajuste

Seleccione Simul Rec >Rec Button Set en el
menu Recording.

Rec Button Set Botones y tarjetas de

memoria

Inicia/detiene la grabacion
simultdnea en las tarjetas de
memoria A y B con
cualquiera de los botones.

Rec Button:
Handle Rec
Button:| A » | B

Inicia/detiene la grabacién en
la tarjeta de memoria A
mediante el bot6n de
grabacién y en la tarjeta de
memoria B mediante la
utilizacién del botén de
grabacién del asa.

Rec Button:

Handle Rec

Button:| B »

Inicia/detiene la grabacién en
la tarjeta de memoria B
mediante el botén de
grabacién y en la tarjeta de
memoria A mediante la
utilizacién del botén de
grabacidn del asa.

Rec Button:

Handle Rec

Button:| A »

Grabacion de rango dinamico alto
(HDR)

Puede establecer el modo High Dynamic Range
(HDR) de imdgenes para grabar y emitir
imdgenes con un espacio de color equivalente a
BT.20202 y un rango dindmico extendido.

¢ No admite los formatos de archivos DVCAM.

Ajuste del rango dindmico

Ajuste Base Setting (pdgina 94) >Shooting
Mode, en el ment System, en HDR para
establecer el modo de rango dindmico alto.

Ajuste del tipo de HLG

Puede establecer el tipo de HLG cuando el modo
de rango dindmico alto estd seleccionado.

Si desea obtener informacion detallada, consulte
(pdgina 75).
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Ajustes de la funcion de asistencia de
visualizacion de gamma

La pantalla LCD/visor de la videocdmara no son
compatibles con HDR y no son adecuados para la
visualizaciéon HDR. En consecuencia, se puede
hacer que la pantalla sea mds visible para lograr
una filmacién més sencilla mediante la funcién de
asistencia de la visualizacién de gamma.

Puede cambiar la configuracién de la funcién de
asistencia de visualizacion de gamma mediante
Gamma Display Assist (pdgina 85), en el menui
LCD/VF.

* La funcién de asistencia de visualizacién de gamma
solo se utiliza para la pantalla LCD/visor. Los ajustes
no se aplican a la imagen grabada o emitida.

Guardar y cargar datos de
configuracion

Puede guardar los ajustes del menu de
configuracién en la memoria interna de la
videocdmara o en una tarjeta SD en la ranura
UTILITY SD/MS y en el soporte “Memory
Stick”. Le permitird cargar rapidamente el
conjunto de ajustes de menu apropiado para la
situacién actual.

Los datos de configuracién se guardan en las
categorias siguientes.

Archivos de usuario

Los archivos de usuario guardan los elementos de
configuracién del ment User personalizable.
Puede guardar hasta 64 archivos en una tarjeta SD
o en un soporte “Memory Stick”.

Si carga este archivo en la memoria de la
videocdmara, puede personalizar la configuracion
del ment User.

Archivos ALL (todos los ajustes)

Los archivos ALL guardan los datos de
configuracion de todos los menus. Puede guardar
hasta 64 archivos en una tarjeta SD o en un
soporte “Memory Stick”.

* Los datos especificos del dispositivo (sombreado,
niveles de emisién y otros datos que requieran ajustes
para el dispositivo en concreto) no se guardaran.

Archivos de escena

Los archivos de escena guardan los ajustes de los

elementos de pintura configurados en las escenas.

Puede guardar hasta 5 archivos en la memoria



interna de la videocamara y hasta 64 archivos en
una tarjeta SD o en un soporte “Memory Stick™.

Soportes admitidos para guardar datos
de configuracién

Tarjetas de memoria SDXC*

Tarjetas de memoria SDHC*

Tarjetas de memoria SD*

“Memory Stick PRO-HG Duo”**

“Memory Stick PRO Duo”**

* En este manual se denominan como “tarjeta SD”.

** En este manual se denominan como soporte “Memory
Stick”.

Los datos de configuracién se guardan en el

siguiente directorio del soporte.

/PRIVATE/SONY/PRO/CAMERA/PXW-

Z190V/ (o PXW-Z190T)

Soporte de formateo (inicializacion)

Es necesario formatear las tarjetas SD y los
soportes “Memory Stick” la primera vez que se
van a utilizar en la videocdmara.

Las tarjetas SD o soportes “Memory Stick” que
vayan a utilizarse con esta videocdmara deben
formatearse utilizando la funcién de formateo de
esta videocdmara. Si aparece un mensaje cuando
la tarjeta SD o soporte “Memory Stick” se
introduce en la videocdmara, formatee el soporte
de almacenamiento.

1 Insertela tarjeta SD o el soporte
“Memory Stick” en la ranura UTILITY
SD/MS (pdgina 8) con la etiqueta
orientada hacia la derecha.

2  Seleccione Format Media (pdgina 90)
>Utility SD/MS >Execute, en el meni
Media. Cuando aparezca un mensaje de
confirmacion, vuelva a seleccionar
Execute.

Se mostrard un mensaje y el estado de avance
durante el formateo y el indicador de acceso
se iluminard en rojo.

Cuando se haya completado el formateo, se

mostrard un mensaje de finalizacion. Pulse el
botén SET o el dial SEL/SET para ignorar el
mensaje.

 El formateo de la tarjeta SD o del soporte “Memory
Stick” borra todos los datos. Los datos no se podran
restaurar.
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Comprobacion de la capacidad restante

Puede comprobar la capacidad restante de una
tarjeta SD o de un soporte “Memory Stick’en la
pantalla de estado de los soportes (pdgina 14).

« Sila tarjeta SD o el soporte “Memory Stick”estd
protegido se mostrard la marca @

Para utilizar un soporte formateado en la videocamara
en la ranura de otro dispositivo, haga una copia de
seguridad de los datos y vuelva a formatear el soporte
en el dispositivo en el que lo vaya a utilizar.

Guardar un archivo de usuario/un archivo
ALL

1 Insertela tarjeta SD o el soporte
“Memory Stick” enla ranura UTILITY
SD/MS (pdgina 8) con la etiqueta
orientada hacia la derecha.

2 Para un archivo de usuario, seleccione
User File (pdagina 91) >Save Utility SD/
MS >Execute, en el meni File.

Para un archivo ALL, seleccione All
File >Save Utility SD/MS >Execute, en
el meni File.

Aparecera una pantalla de destino de
almacenamiento del archivo.

3 Seleccione una fila “No File”, en la

ventana de destino de almacenamiento,
con el boton 4/¥/«/# o el dial SEL/SET.
A continuacion, pulse el botén SET o el
dial SEL/SET.
Si selecciona una fila con una entrada de File
ID, se sobrescribira el archivo seleccionado.
La File ID se genera automdaticamente, pero
puede modificarla.

4 Seleccione Execute, en la pantalla de
confirmacion, con el boton 4/¥/«/% o el
dial SEL/SET. A continuacién, pulse el
botén SET o el dial SEL/SET.

Carga de un archivo de usuario/un
archivo ALL

1 Insertela tarjeta SD o el soporte
“Memory Stick” en el que ha guardado
el archivo en la ranura UTILITY SD/



MS (pdgina 8) con la etiqueta orientada
hacia la derecha.

2 Para un archivo de usuario, seleccione
User File (pdgina 91) >Load Utility SD/
MS >Execute, en el meni File.

Para un archivo ALL, seleccione All
File >Load Utility SD/MS >Execute, en
el mena File.

Aparecerd una pantalla con la lista de
archivos.

3 Seleccione el archivo que desea cargar
con el botén 4/¥%/«/» o el dial SEL/SET.
A continuacion, pulse el botén SET o el
dial SEL/SET.

Aparecerd una pantalla de confirmacién.

4 Seleccione Execute con el botén 4/%/4/
» o el dial SEL/SET y pulse el botén
SET o el dial SEL/SET.

* La videocdmara se reiniciard autométicamente
después de cargar los datos de configuracion.

¢ Cuando se ajusta All File >Load Network Data, en el
menu File, en Off, se cargan todos los ajustes del
archivo ALL, salvo los ajustes del ment Network.

Guardar un archivo de escena

Para guardarlo en la memoria interna

1 Seleccione Scene File >Store Internal
Memory >Execute en el meni File
(pdgina 91).

Aparecera una pantalla con la lista de
archivos de escena.

SilaFile ID estd establecida en la destinacion
“Standard”, se guardaran los ajustes estdndar
preconfigurados.

2 Seleccione un destino de
almacenamiento con el boton 4/¥%/«/% o
el dial SEL/SET. A continuacién, pulse
el boton SET o el dial SEL/SET.

El archivo de la escena se guardard en el
destino seleccionado, sobrescribiendo
cualquier archivo existente.

3 Seleccione Execute, en la pantalla de
confirmacion, con el botén 4/¥/«/» o el
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dial SEL/SET. A continuacién, pulse el
botén SET o el dial SEL/SET.

Para guardar en una tarjeta SD o en un soporte
“Memory Stick”

1 Insertela tarjeta SD o el soporte
“Memory Stick” enla ranura UTILITY
SD/MS (pdgina 8) con la etiqueta
orientada hacia la derecha.

2 Seleccione Scene File >Save Utility SD/
MS >Execute en el ment File
(pdgina 91).
Aparecera una pantalla de destino de
almacenamiento del archivo de escena.

3 Seleccione una fila “No File”, en la
ventana de destino de almacenamiento,
con el botén 4/¥/«/» o el dial SEL/SET.
A continuacion, pulse el botén SET o el
dial SEL/SET.

Si selecciona una fila con una entrada de File
ID, se sobrescribira el archivo seleccionado.
La File ID se genera automdticamente, pero
puede modificarla.

4 Seleccione Execute, en la pantalla de
confirmacion, con el botén 4/¥/«/% o el
dial SEL/SET. A continuacién, pulse el
botén SET o el dial SEL/SET.

Carga de un archivo de escena

Para cargar desde la memoria interna

1 Seleccione Scene File >Recall Internal
Memory >Execute en el meni File
(pdgina 91).

Aparecerd una pantalla con la lista de
archivos de escena.

2 Seleccione el archivo que desea cargar
con el boton #/¥/«/# o el dial SEL/SET.
A continuacion, pulse el botén SET o el
dial SEL/SET.

Aparecerd una pantalla de confirmacion.

3 Seleccione Execute con el boton 4/¥/«/
# 0 el dial SEL/SET y pulse el boton
SET o el dial SEL/SET.



Los archivos de escena también pueden
cargarse en la videocdmara utilizando el
ment directo (pdgina 34).

Para cargar desde una tarjeta SD o en un soporte
“Memory Stick”

1 Insertela tarjeta SD o el soporte
“Memory Stick” en el que ha guardado
el archivo en la ranura UTILITY SD/
MS (pdgina 8) con la etiqueta orientada
hacia la derecha.

2 Seleccione Scene File >Load Utility SD/
MS >Execute en el meni File
(pdgina 91).
Aparecera una pantalla con la lista de
archivos de escena.

3 Seleccione el archivo que desea cargar
con el boton 4/¥/«/% o el dial SEL/SET.
A continuacion, pulse el botén SET o el
dial SEL/SET.

Aparecera una pantalla de confirmacién.

4 Seleccione Execute con el botén 4/%/4/
» o el dial SEL/SET y pulse el boton
SET o el dial SEL/SET.

Para cambiar la File ID

1 Para un archivo de usuario, seleccione
User File >File ID, en el meni File
(pdgina 91).

Para un archivo ALL, seleccione All
File >File ID, en el meni File

(pdgina 91).

Para un archivo de escena, seleccione
Scene File >File ID, en el meni File
(pdgina 91).

Aparecerd una pantalla para editar la File ID.

2 Seleccione un caracter con el boton 4/%/
«/% o el dial SEL/SET. A continuacion,
pulse el boton SET o el dial SEL/SET.

3 Repita el paso 2 segiin sea necesario.

4 Cuando haya terminado de introducir
caracteres, seleccione Done con el boton
4/%/«/% o el dial SEL/SET. A
continuacion, pulse el boton SET o el
dial SEL/SET.

Obtencion de la informacion de
ubicacion (GPS)

Cuando se activa el posicionamiento, la
informacién de ubicacién y tiempo de la toma de
video se graba en el soporte cargado en la ranura
para tarjetas de la videocdmara y se puede emitir
como SDI.

1. Pulse el botén MENU durante el modo de
espera.

2. Ajuste GPS en On en el mend System.

MO se mostrard cuando el camcorder esté
buscando satélites de GPS. Cuando se
establece el posicionamiento, la informacién
de ubicacion se graba mientras se filma el
video.

 Elicono que se muestra varia seguin la recepcion de
sefial de los satélites GPS.

Estado de Pantalla Estado de recepcion

posiciona- de GPS
miento
Off Sin visua- GPS se ha ajustado en Off

lizacién o se ha producido un error.

Ubicacién no NO GPS
disponible SIGNAL

No se ha podido obtener la
informacién de ubicacién
porque no se ha podido
recibir la sefial de GPS.
Desplécese hasta una
ubicacién con una vista
despejada del cielo.

Buscando P Buscando satélites. Puede
satélites 0\® que tarde varios minutos
en encontrar satélites.

Posiciona- P Se recibe una sefial débil
miento ** de GPS.
P Se recibe una sefial de

'\II GPS. Se puede conseguir
la informaci6n de
ubicacién.

P Se recibe una seiial fuerte
»’III de GPS. Se puede
conseguir la informacién
de ubicacién.




* GPS se ajusta en On de manera predeterminada.
El camcorder grabara la informacién de
ubicacién y de tiempo del video grabado
cuando el posicionamiento esté activado. Para
grabar la informacién de posicionamiento,
ajuste GPS en On.

Es posible que el posicionamiento tarde unos
instantes en iniciarse tras encender la
videocdmara.

Si después de varios minutos no se muestra un
icono de posicionamiento, es posible que exista
un problema con la recepcién de seiial.
Comience a filmar sin informacion de ubicacién
o despldcese a una zona con una vista clara del
cielo. Si filma cuando no se muestra un icono de
posicionamiento, la informacién de ubicacion
no se grabara.

Es posible que no se reciba sefial de GPS
cuando esté en interiores o cerca de estructuras
altas. Despldcese hasta una ubicacién con una
vista despejada del cielo.

Es posible que se interrumpa la grabacién de
informacidn de ubicacién, segin la fuerza de la
sefial recibida, incluso si se muestra el icono de
posicionamiento.

Grabacion de proxy

Puede grabar datos de proxy en una tarjeta SD en
la ranura UTILITY SD/MS simultdneamente
mientras graba en las tarjetas de memoria en las
ranuras para tarjetas de memoria.

Tarjetas SD compatibles

Tarjeta de memoria SDXC* (clase de
velocidad: 4 o superior)

Tarjeta de memoria SDHC* (clase de
velocidad: 4 o superior)

Tarjetas de memoria SD* (clase de velocidad:
4 o superior)

* En este manual se denominan como “tarjeta SD”.

Formateo (inicializacion) de
tarjetas SD

Es necesario formatear las tarjetas SD la primera
vez que se van a utilizar en el camcorder.

Las tarjetas SD que se vayan a utilizar en el
camcorder se deben formatear mediante la
funcién de formateo del camcorder. Si aparece un
mensaje cuando la tarjeta SD se introduce en el
camcorder, formatee la tarjeta SD.

1 Insertela tarjeta SD en la ranura
UTILITY SD/MS (pdgina 8) con la
etiqueta orientada hacia la derecha.

2 Seleccione Format Media (pdgina 90)
>Utility SD/MS >Execute en el meni
Media. Cuando aparezca un mensaje de
confirmacion, vuelva a seleccionar
Execute.

Se mostrard un mensaje y el estado de avance
durante el formateo y el indicador de acceso
se iluminard en rojo.

Cuando se haya completado el formateo, se
mostrard un mensaje de finalizacién. Pulse el
botén SET o el dial SEL/SET para ignorar el
mensaje.

Al formatear una tarjeta SD se borran todos los datos
de esta. La tarjeta no se podrd restaurar.



¢ Las tarjetas SDXC se formatean en exFAT, las tarjetas
SDHC se formatean en FAT32 y las tarjetas SD se
formatean en FAT.

Comprobacion de la capacidad
restante

Puede comprobar la capacidad restante de una
tarjeta SD en la pantalla Media Status
(pdgina 14).

« Silatarjeta SD estd protegida se mostrard la marca @

Para utilizar un soporte formateado con la
videocamara en la ranura de otro dispositivo
En primer lugar, realice una copia de seguridad de la
tarjeta y, a continuacion, vuelva a formatear la tarjeta en
el dispositivo que se va a utilizar.

Grabacion de proxy (Proxy Rec)

Configuracion antes de la filmacion

1 Ajuste Proxy Rec >Setting en el meni
Recording en On.

2 Insertela tarjeta SD en la ranura
UTILITY SD/MS (pdgina 8) con la
etiqueta orientada hacia la derecha.

La funcién Proxy Rec no puede ajustarse en On al
mismo tiempo que Interval Rec, Picture Cache Rec o
S&Q Motion. Al ajustar Proxy Rec en On, estas otras
funciones se establecen forzosamente en Off.

Grabacion de un proxy

Inicie la grabacién tras completar el ajuste
requerido.

Pulse el boton de grabacion.

« Siel camcorder estd apagado o si se extrae la tarjeta SD
mientras se estd accediendo a esta, no se podrad
garantizar la integridad de los datos de la tarjeta. Es
posible que se pierdan todos los datos grabados en la
tarjeta. Asegirese de que el indicador de acceso esté
siempre apagado antes de apagar la videocdmara o
extraer la tarjeta SD.

Tenga cuidado para evitar que la tarjeta SD se caiga al
introducirla o extraerla.

Para salir, detenga la grabacion.

Cuando se detiene la grabacion en las tarjetas de
memoria en las ranuras para tarjeta de memoria,
también se detiene la grabacién proxy.

Cambio en los ajustes de
grabacion de proxy

Ajuste del tamafio de la imagen

Seleccione Proxy Rec >Proxy Format en el menud
Recording y establezca el tamafo de imagen.

Ajuste del canal de audio

Seleccione Proxy Rec >Audio Channel, en el
menu Recording, y configure el canal de imagen
para la grabacién de proxy.

Acerca del archivo grabado

La extensién del nombre del archivo es “.mp4”.
El c6digo de tiempo también se graba
simultdneamente.

Destino del almacenamiento del
archivo grabado

El archivo grabado se almacenara en el directorio
“/PRIVATE/PXROOT/Clip”.

Acerca del nombre del archivo

El nombre de archivo consiste en el nombre del

clip grabado en las tarjetas de memoria en las

ranuras para tarjeta de memoria y un sufijo

numérico consecutivo.

En el modo 2-slot Simul Rec, el nombre del clip

de la ranura A tiene prioridad.

 El nimero consecutivo se mantiene aunque se apague
la videocamara. El nimero consecutivo regresa al
0001 al ejecutar All Reset.

Para mds detalles sobres los nombres de clips,

consulte Clip Naming (pdgina 91), en el menii

Media.



Grabacion de solamente datos de
proxy

Puede grabar datos de proxy por separado en una
tarjeta SD en la ranura UTILITY SD/MS sin
grabar en una tarjeta de memoria en la ranura para
tarjeta de memoria.

El formato de grabacion de los datos de proxy es
el mismo que en la grabacion simultdnea.

Sin embargo, el nombre del archivo se deriva del
c6digo de tiempo del momento inicial de la
grabacion.

Ejemplo: si el c6digo de tiempo en el momento
inicial de la grabacion es “14:30:20:057, el
nombre del archivo pasa a ser
“14_30_20_05.mp4”.

Configuracion antes de la filmacion

1 Asigne Proxy Rec Start/Stop a un botén
asignable (pdgina 36).

2 Ajuste Proxy Rec >Setting en el meni
Recording en On.

3 Insertela tarjeta SD en la ranura
UTILITY SD/MS (pdgina 8) con la
etiqueta orientada hacia la derecha.

Grabacion

Inicie la grabacion tras completar el ajuste
requerido.

Pulse el botén asignable al que le haya
asignado Proxy Rec Start/Stop.

Para detener la grabacidn, pulse el botén
asignable.

Conexion a otros
dispositivos a través de
una LAN

La videocdmara se puede conectar a smartphones,
tablets y otros dispositivos que utilicen una
conexion LAN.

El establecimiento de una conexiéon LAN entre un
dispositivo y la videocdmara le permite llevar a
cabo lo siguiente mediante el control remoto web
(pdgina 53) o la aplicacion “Content Browser
Mobile”.

* Funcionamiento remoto a través de una LAN
Puede controlar la videocdmara desde un
smartphone, una tablet o un ordenador
conectados a esta a través de una LAN.

* Seguimiento de video mediante una LAN
Podré crear una transmisién (H.264) a partir de
la cdmara o el video de reproduccién de la
videocdmara y seguir la transmisién mediante la
aplicacion “Content Browser Mobile” desde un
dispositivo a través de una LAN.

Aplicacion “Content Browser Mobile”

Puede utilizar la videocdmara de manera remota
en la pantalla del dispositivo mientras controla
desde la videocdmara y configurar los ajustes de
la videocdmara mediante la aplicacién “Content
Browser Mobile”.

Para obtener mds informacion acerca de la
aplicacion “Content Browser Mobile”, pongase
en contacto con el servicio de asistencia técnica

o de ventas de Sony.

Conexion con el modo de punto de
acceso de LAN inalambrica

La videocdmara funciona como un punto de
acceso y se conecta a un dispositivo a través de
una red LAN inaldmbrica.



Ordenador

Smartphone/
tablet

Conexidn a un dispositivo compatible
con NFC mediante un toque

Los dispositivos compatibles con NFC se pueden
conectar (conexién con un toque) mediante NFC.

1 Abra [Settings] en el dispositivo,
seleccione [More] y marque la casilla de
[NFC].

=

z
3
&

Encienda la videocdmara.

Active la funcién NFC.

Mantenga pulsado (durante 3 segundos) un
botdn asignable al que le haya asignado NFC
o seleccione Wireless LAN >NFC, en el
menu Network, para activar el modo de
conexion NFC.

La funcién NFC se encuentra disponible
cuando aparece [§] en la pantalla.

4 Toque el camcorder con el dispositivo.

El dispositivo se conectard a la videocdmara
y se iniciard “Content Browser Mobile”.
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* Desactive previamente el modo de suspension y el
bloqueo de pantalla.

* Toque sin soltar el dispositivo hasta que se inicie la
aplicacién “Content Browser Mobile” (1 o
2 segundos).

Conexion con un dispositivo compatible
con WPS

Los dispositivos compatibles con WPS pueden
conectarse mediante WPS.

1 Seleccione Wireless LAN >Setting
>Access Point Mode, en el meni
Network.

2 Seleccione Wireless LAN >WPS
>Execute, en el meni Network.

3 AbraNetwork Settings o Wi-Fi Settings
en el dispositivo y active el Wi-Fi.

4 Seleccione el SSID de la videocimara en
la lista de SSID de Wi-Fi Network en el
dispositivo y, a continuacién, seleccione
el pulsador WPS en Option, en el
dispositivo, para conectarlo.

* El método de funcionamiento varia en funcién del
dispositivo.

* Para obtener informacion acerca del SSID y la
contrasefia de la videocdmara, consulte AP Mode
Settings (pdgina 93) >Camera SSID & Password en el
ment Network.

O  Visualizacién del control remoto web
(pdgina 53). O conexion con la
aplicacion Content Browser Mobile.



Conexion mediante la introduccion de un
SSID y una contraseiia en un dispositivo

Puede conectar la videocdmara a un dispositivo
mediante la introduccién de un SSID y una
contrasefa en un dispositivo.

1 Seleccione Wireless LAN >Setting
>Access Point Mode, en el menu
Network.

2 AbraNetwork Settings o Wi-Fi Settings
en el dispositivo y active el Wi-Fi.

3 Conecte el dispositivo a la videocamara
seleccionando el SSID de la
videocamara en la lista de SSID de
Wi-Fi Network e introduciendo la
contraseiia.

Para obtener informacién acerca del SSID y
la contrasefia de la videocdmara, consulte AP
Mode Settings (pdgina 93) >Camera SSID &
Password en el mend Network.

¢ El método de funcionamiento varia en funcion del
dispositivo.

4 Visualizacién del control remoto web
(pdgina 53). O conexion con la
aplicacion Content Browser Mobile.

Conexion del modo de estacion de
LAN inalambrica

La videocdmara se conecta a un punto de acceso
existente de la red LAN inalambrica como
cliente. La videocdmara y el dispositivo se
conectan a través del punto de acceso.

Los 10 puntos de acceso conectados mas
recientemente se mostrardn en el historial.

El historial de conexién se guarda en un archivo
ALL, pero no se guardardn las contrasefias de
acceso. Es obligatorio introducir la contrasefia la
proxima vez que se conecte después de cargar el
archivo ALL.
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Ordenador

Smartphone/
tablet

Punto de
acceso

Conexion a un punto de acceso a través
de WPS

Si el punto de acceso es compatible con la funcién
WPS, puede conectarse al punto de acceso
mediante ajustes sencillos.

1 Activeel punto de acceso.
2 Encienda la videocamara.

3 Seleccione Wireless LAN >Setting
>Station Mode, en el meni Network.

4 Seleccione Wireless LAN >WPS
>Execute, en el ment Network.

5 Pulse el botén WPS del punto de acceso.

Para obtener mas informacion acerca de
cémo utilizar el boton WPS, consulte el
manual de instrucciones del punto de acceso.
Cuando la conexidn se realiza correctamente,
el icono indicador del estado de red mostrara
una fuera de 1 o superior en la pantalla LCD/
visor.

* En caso de que falle la conexidn, vuelva a llevar a cabo
los pasos a partir del 1.



6 Conecteel dispositivo al punto de

acceso.

Para obtener mds informacion acerca de la
conexion, consulte el manual de
instrucciones del dispositivo.

Visualizacién del control remoto web
(pdgina 53). O conexion con la
aplicaciéon Content Browser Mobile.

5 Configure los siguientes ajustes de

conexion.

« DHCP
Establezca el ajuste DHCP.
Cuando establezca el ajuste en On, la
direccion IP se asignard a la videocamara
automdticamente.
Para asignar la direccién IP a la
videocdmara manualmente, establezca el

ajuste Off.

IP Address

Introduzca la direccién IP de la
videocdmara. Este ajuste estd disponible
unicamente si DHCP estd ajustado en Off.

Conexion a un punto de acceso mediante
la deteccion automatica de red o
manualmente

Puede configurar la conexién a un punto de « Subnet Mask
acceso deseado desde el mend de configuracion. Introduzca la mascara de subred de la
Puede configurar la conexién a un punto de videocdmara.

acceso deseado a través de la funcion de
deteccion automadtica de red.

Este ajuste estd disponible tinicamente si
DHCP est4 ajustado en Off.

Gateway

Introduzca la pasarela predeterminada del
punto de acceso.

Este ajuste estd disponible tinicamente si
DHCP estd ajustado en Off.

Conexion mediante la funcion de deteccion
automatica de red

1 Sigalos pasosde 1a 3 en “Conexion aun
punto de acceso a través de WPS”

(pdgina 49). * DNS Auto
Establézcalo para adquirir el DNS
2 Seleccione ST Mode Settings >Scan automdticamente.

Cuando se establece en On, se adquiere
automdticamente la direccién del servidor
DNS. Este ajuste estd disponible
unicamente si DHCP estd ajustado en On.
Primary DNS Server

Introduzca el servidor DNS principal del
punto de acceso.

Este ajuste solamente se encuentra
disponible cuando DNS Auto se encuentra
ajustado en Off.

Secondary DNS Server

Introduzca el servidor DNS secundario del
punto de acceso.

Este ajuste solamente se encuentra
disponible cuando DNS Auto se encuentra
ajustado en Off.

Networks (pdgina 93) >Execute, en el
menu Network.

La videocamara comienza a detectar los
destinos de conexion.

Los destinos de conexion detectados se
muestran en la lista de resultados Scan
Networks.

3 Seleccione una conexion con el boton 4/
¥/«/% o el dial SEL/SET. A
continuacion, pulse el boton SET o el
dial SEL/SET.

Aparecera la pantalla de detalles de la red
(punto de acceso) de forma momentdnea. La
conexion seleccionada se muestra en SSID.

4 Seleccione Password y defina la 6
contrasefia en la pantalla de
introduccion de contraseiia.

Cuando haya terminado, seleccione
Connect para conectarse al punto de

acceso.
Si se conecta antes de la deteccién

automdtica de red, se mostrard una pantalla
de contraseifia al seleccionar el SSID.
Establezca la contrasefia para volver a la
pantalla de detalles de red (punto de acceso).

Conexion manual

1 Sigalos pasosde 1a3en “Conexion aun
g P
punto de acceso a través de WPS”
(pdgina 49).
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Seleccione ST Mode Settings >Manual
Register (pdgina 93) >Execute, en el
ment Network.

Aparecerd la pantalla de detalles de la red
(punto de acceso) de forma momenténea.

Configure los siguientes ajustes de
conexion.

SSID

Introduzca el SSID del punto de acceso.
Security

Seleccione el método de encriptacion.
Password

Introduzca la contrasefia del punto de
acceso.

Se activa cuando Security no se fija en
None.

DHCP

Establezca el ajuste DHCP.

Cuando establezca el ajuste en On, la
direccion IP se asignard a la videocamara
automaticamente.

Para asignar la direccién IP a la
videocdimara manualmente, establezca el
ajuste Off.

IP Address

Introduzca la direccién IP de la
videocdmara. Este ajuste estd disponible
unicamente si DHCP est4 ajustado en Off.
Subnet Mask

Introduzca la mascara de subred de la
videocdmara.

Este ajuste estd disponible tinicamente si
DHCEP esta ajustado en Off.

Gateway

Introduzca la direccién de la puerta de
enlace.

Este ajuste estd disponible tinicamente si
DHCEP esta ajustado en Off.

DNS Auto

Establézcalo para adquirir el DNS
automdticamente.

Cuando se establece en On, se adquiere
automaticamente la direccion del servidor
DNS. Este ajuste estd disponible
unicamente si DHCP estd ajustado en On.
Primary DNS Server

Introduzca la direccién del servidor DNS
principal.

Este ajuste solamente se encuentra
disponible cuando DNS Auto se encuentra
ajustado en Off.
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» Secondary DNS Server
Introduzca la direccién del servidor DNS
secundario.
Este ajuste solamente se encuentra
disponible cuando DNS Auto se encuentra
ajustado en Off.

Cuando haya terminado, seleccione
Connect para conectarse al punto de
acceso.



Lista de funciones para las conexiones de red

La siguiente lista muestra la disponibilidad de las funciones de red en cada modo de conexién de red.

Funcion de red Estado de la conexion de red

Access Point Station Off
Supervision ob ob X
(pdgina 47)
Control remoto de la videocdmara ob ob x
(pdgina 53)

1) Funciones del dispositivo conectado con la videocdmara a través de una red
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Uso del control remoto
web

Puede acceder al control remoto web integrado en
la videocdmara desde una tablet o un ordenador
con una conexién de red.

El control remoto web le permite utilizar la
videocdmara de forma remota. Puede iniciar/
detener la grabacion y establecer los ajustes de
grabacion mediante un dispositivo conectado.
Esta funcion resulta util para colocar la
videocdmara en un lugar remoto, como en la parte
superior de una grua, etc.

Pantalla Camera Control
Pantalla Main

= Camera Control * Connected

00:00

Assign Main

Lock =™

Playback  Cursor

Vs, U8

116

Shutter

1/60 STDS

Auto ND Filter

Auto White

» Estado

« Botdn Iniciar/Detener grabacion

¢ Control deslizante ND

» Control deslizante Iris

 Control deslizante Focus

 Control deslizante Zoom

* Ajustes de disparo
S&Q FPS, Shutter, White, Gamma, Auto Iris, Auto
Shutter, AGC, Auto ND Filter, ATW, Gain, Color
Bars, Auto White
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Pantalla Playback

= Camera Control

00:00:00.00

Assign

* Estado
* Botones de funcionamiento de reproduccion:
F Rev, Play/Pause, F Fwd, Prev, Stop, Next

Pantalla Cursor
= Camera Control

00:00:00.0

Assign  Main Cursor

Playback

Menu

Thumbnail

Status

* Estado

* Botones de funcionamiento del cursor:
Up, Left, Set, Right, Down, Cancel/Back, Menu,
Status, Thumbnail

Pantalla Assign

= Camera Control *C Lock=~
Ch 37min - pc
[ 48min 128V
(% 999min

00:00:00.00 ==
a2

Main  Playback  Cursor

o
@ or

@ reaiin
@ or

* Estado
* Botones asignables:
Botones asignables del 1 al 8

Visualizacion del control remoto web

1 Conecte 1a videocimara y el dispositivo
mediante una conexion de red
(pdgina 47).



2 Ejecute un navegador en el dispositivo
Yy, a continuacion, acceda a “http://
direccion IP de la videocamara/
rm.html.”

Ejemplo: cuando la direccion IP sea
192.198.122.1, introduzca http://

192.168.1.1/rm.html en la barra de direccion.

Puede comprobar la direccién IP de la
videocdmara en la pantalla de estado de red
(pdgina 15).

3 Introduzca el nombre de usuario yla
contraseiia (meni Network — Access
Authentication — User Name y
Password) en el navegador.

Cuando la conexién se realiza correctamente,
en el dispositivo aparecerd la pantalla de
control remoto web.

Puede utilizar la pantalla de control remoto
web para controlar la videocdmara.

La funcién del botén se puede desactivar
arrastrando el interruptor de bloqueo hacia la
derecha.

Es posible que la pantalla de control remoto no

coincida con los ajustes de la videocdmara en las

siguientes circunstancias. Si esto ocurre, vuelva a

cargar la ventana del navegador.

— Si el camcorder se reinicia mientras estd conectado

— Si el camcorder se utiliza directamente mientras
estd conectado

— Si el dispositivo se ha reconectado

— Si se han utilizado los botones de adelante/atrds del
navegador

Es posible que el control remoto web no funcione si la

sefial inaldmbrica es débil.

Dispositivos compatibles con el control
remoto web

Puede utilizar una tablet u ordenador para
configurar y utilizar la videocdmara. En la
siguiente se indican los dispositivos, sistemas
operativos y navegadores compatibles.

Dispositivo SO Navegador
Tableta Android 6/7 Chrome

i0S 11 Safari
Ordenador Windows 7/8.1/ Chrome

10

macOS 10.12/  Safari

10.13

Para obtener mas informacién acerca de los
dispositivos compatibles con la aplicacion
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“Content Browser Mobile”, pongase en contacto
con el servicio de asistencia técnica o de ventas de
Sony.



Pantalla de imagenes en miniatura

Configuracion de la pantalla de imagenes en
miniatura

Al pulsar el botéon THUMBNAIL (pdgina 10), los clips grabados en la tarjeta de memoria aparecen como
imdgenes en miniatura en la pantalla.

Puede seleccionar un clip en la pantalla de imdgenes en miniatura e iniciar la reproduccion de dicho clip.
La imagen reproducida se puede ver en la pantalla LCD/del visor y en monitores externos.

Si pulsa el boton THUMBNAIL de nuevo, se cierra la pantalla de imdgenes en miniatura y vuelve a la
imagen de la cdmara.

« Solo los clips grabados con el formato de grabacién seleccionado actualmente se mostraran en la pantalla de imagenes
en miniatura. Si un clip grabado esperado no se muestra, compruebe el formato de grabacion. Tenga en cuenta esto
antes de formatear (inicializar) soportes.

La informacion para el clip sobre el que se encuentra el cursor se muestra en la parte inferior de la pantalla.

Indicador de la tarjeta de memoria seleccionada actualmente
(Se muestra un icono de bloqueo si la tarjeta esta protegida.)

Numero del clip/Numero total de clips

d)

e, —NTTIY ArFEn

TCROO:OO:O TCR00:00:00:12  TCR00:00:00:15 TCﬁ"OO:OOZOO:Sﬁ

~ [}
- =5 | = ‘

TCROOEO:[H:ZZ TCR00:00:01:56 TCR00:00:02:02  TCR 00:00:02:35

TCR 00:00:04:45

3 4

1. Miniaturas (im4genes indice) 4. Informacién del modo de grabacién

Muestra la imagen indice de un clip. Cuando se
graba un clip, su primer fotograma se ajusta
automdticamente como imagen indice.

La informacion del clip/fotograma se muestra
debajo de la imagen en miniatura. Puede
cambiar la informacién que aparece mediante
Customize View (pdgina 60) >Thumbnail
Caption, en el mend Thumbnail.

. Nombre del clip
Muestra el nombre del clip seleccionado.

. Formato de grabacion del video
Muestra el formato de archivo del clip
seleccionado.

especial

Muestra el modo de grabacion solo si el clip se
grab6 con un modo especial de grabacién.

En clips con Slow & Quick Motion, la velocidad
de fotogramas se muestra a la derecha.

5. Duracién del clip

6. Fecha de creacion



Reproduccion de clips

Reproduccion de clips grabados

Puede reproducir clips grabados cuando el
camcorder esté en modo de espera (Stby).

1 Introduzca una tarjeta de memoria
para la reproduccién.

2 Pulse el botén PLAY/PAUSE de los
botones de control de la reproduccion.

3 Pulse el botén PREV o NEXT para
buscar el clip que desee.

4 Pulse el botén PLAY/PAUSE.

La reproduccién aparece en el visor.

Puede controlar la reproduccién con los

siguientes botones.

Boton PLAY/PAUSE: pausa la reproduccion.
Para reanudar la reproduccidn, pulse este
botén de nuevo.

Boton F FWD/botén F REV: reproduce a més
velocidad. Para volver a la reproduccion
normal, pulse el botén PLAY/PAUSE.

Boton STOP/CAM: detiene la reproduccién o
la grabacion.

Para seleccionar la primera imagen en
miniatura

Mantenga pulsado el botén F REV y pulse el
botén PREV.

Para seleccionar la Gltima imagen en miniatura
Mantenga pulsado el botén F FWD y pulse el
botén NEXT.

Reproduccion del clip
seleccionado y los siguientes por
orden

1 Pulse el botén 4/%/«/» o gire el dial
SEL/SET para mover el cursor hasta la
imagen en miniatura del clip que desea
reproducir.

2 Pulse el botén SET o el dial SEL/SET.

La reproduccion comienza desde el principio
del clip seleccionado.

Pueden existir roturas momentdneas de imagen o
visualizarse imdgenes fijas en el cambio de un clip a
otro. Durante este periodo no podrd utilizar el
camcorder.

Cuando selecciona un clip en la pantalla de imagenes
en miniatura y comienza la reproduccién, pueden
existir roturas momentdneas de imagen al principio del
clip. Para iniciar la reproduccién sin distorsién, una
vez pausada la grabacién después de iniciarla, pulse el
botén PREV de los botones de control de la
reproduccion para regresar al principio del clip y, a
continuacion, reinicie la reproduccién.

Control de audio durante la
reproduccion

Durante el modo de reproduccién normal, puede
monitorizar las sefiales de audio grabadas con el
altavoz integrado o con unos auriculares
conectados.

Si conecta unos auriculares a la toma del
micréfono (pdgina 9), se interrumpird el altavoz
integrado.

Ajuste el volumen con los botones VOLUME
(pdgina 10).

Puede seleccionar el canal que desea controlar
mediante Audio Output (pdgina 82), en el ment
Audio.



Operaciones con clips

El mend Thumbnail se utiliza para proteger/
eliminar clips, comprobar propiedades y otras
tareas.

Thumbnail operaciones del menii

El mend Thumbnail puede usarse solo cuando se
muestra la pantalla de imdgenes en miniatura.

1 Pulse el botén THUMBNAIL.

Aparecerd la pantalla de imdgenes en
miniatura.

2 Pulse el botén MENU.

Aparecerd la pantalla del mend.

3 Seleccione Thumbnail con el botén 4/%/
«/* o el dial SEL/SET y pulse el boton
SET o el dial SEL/SET.

Para ocultar el mentd Thumbnail, pulse el botén
MENU de nuevo.

Seleccione los elementos y subelementos del
menud mediante el siguiente método.

Seleccione un elemento o un subelemento
con el botén #/¥/«/% o el dial SEL/SET y
pulse el boton SET o el dial SEL/SET.
Pulse el botéon de CANCEL/BACK (pdgina 9)
para volver a la pantalla anterior.

¢ Cuando la tarjeta de memoria estd protegida contra
escritura, algunas operaciones no estdn disponibles.

* Algunos elementos no pueden seleccionarse,
dependiendo del estado, cuando se visualiza el menu.
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Seleccione Display Clip Properties, en el mend Thumbnail.

45 6 7
Clip Properties 2006 / 2250) (@ 960min)
(clipooot ]
1
[7C Index 00:05:00:02)| Video codec  XAVC-L50
2 Start 00:05:00:00||| Size 1920x1080 8
End 00:08:19:23||| FPS 59.94P
(Duration 00:03:19:23||| Audio Codec  LPCM
(Created || chyBit 4ch 24bit
3 Aug-23-201410:58:42 | o Mode Interval Rec

M v 952014 105842 | Reo Device  PXW-Z190V(SNO0001014)

1. Imagen del clip actual

2. Indicador del cédigo de tiempo
TC Index: cédigo de tiempo del fotograma
mostrado
Start: c6digo de tiempo en el punto de inicio de
la grabacién
End: cédigo de tiempo en el punto de
finalizacion de la grabacion
Duration: duracién del clip

3. Fecha de creacién y fecha de modificacién

4. Tarjeta de memoria seleccionada
actualmente

5. Icono de proteccién del soporte
6. Niimero del clip/Niimero total de clips
7.1cono de la bateria

8. Informacién del clip
Nombre del clip
Formato de grabacién
Informacién del modo de grabacién especial
Nombre del dispositivo de grabacién
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Proteccion de los clips

Puede proteger un clip determinado o todos los
clips para impedir que se borren.

Se afiadird (§) a las imdgenes en miniatura de los
clips protegidos.

Los clips se pueden proteger en la pantalla de
imédgenes en miniatura.

Proteccion de un clip determinado

1 Seleccione Lock/Unlock Clip >Select
Clip >Execute, en el meni Thumbnail.

Aparecerd la pantalla de seleccion del clip.

2 Seleccione el clip que desea proteger.

Se aiiadird una casilla al clip seleccionado.

3 Pulse el botén MENU.
Aparece una pantalla de confirmacion.

4 Seleccione Execute.

El clip estard protegido y aparecerd un
mensaje de finalizacion.

9 Pulse el botén SET o el dial SEL/SET
para ignorar el mensaje.

Proteccidn de todos los clips

1 Seleccione Lock/Unlock Clip >Lock All
Clips, en el meni Thumbnail.

Aparece una pantalla de confirmacion.

2 Seleccione Execute.

Todos los clips estardn protegidos y
aparecerd un mensaje de finalizacion.

3 Pulse el botén SET o el dial SEL/SET
para ignorar el mensaje.

Desbloqueo de todos los clips

1 Seleccione Lock/Unlock Clip >Unlock
All Clips, en el menid Thumbnail.

Aparece una pantalla de confirmacion.

2 Seleccione Execute.

Todos los clips estardn desbloqueados y
aparecerd un mensaje de finalizacion.
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3 Pulse el botén SET o el dial SEL/SET
para ignorar el mensaje.

Copia de clips

Puede copiar clips a otra tarjeta de memoria.
Los clips que se copien a otra tarjeta de memoria
tendrdn el mismo nombre que los clips originales.

« Si ya existe un clip con el mismo nombre en la tarjeta
de memoria de destino, se afiadird un nimero entre
paréntesis al nombre original.
El nimero entre paréntesis serd el nimero mas
pequefio que no exista en el destino de la copia.
Ejemplos: ABCD0002 — ABCD0002(1)
ABCDO0002(1) — ABCD0002(2)
ABCDO0005(3) — ABCD0005(4)
Si ya existen los nimeros entre paréntesis del (1) al
(999), ya que se ha copiado un archivo mds de 1000
veces, no se podrdn copiar mds archivos con ese
nombre.
Si en la tarjeta de memoria de destino de la copia no
hay suficiente espacio libre, se muestra un mensaje.
Cambie la tarjeta por otra con mds espacio libre.
Si copia una tarjeta de memoria con varios clips
grabados, es posible que no se puedan copiar todos los
clips, incluso si las tarjetas de memoria tienen la
misma capacidad. Esto dependera de las caracterfsticas
de la memoria y del uso de las tarjetas de memoria.

Copia de un clip determinado

1 Seleccione Copy Clip >Select Clip
>Execute, en el meni Thumbnail.

Aparecerd la pantalla de seleccion del clip.

2 Seleccione el clip que desea copiar.
Se afiadird una casilla al clip seleccionado.

3 Pulse el botén MENU.
Aparece una pantalla de confirmacién.

4 Seleccione Execute.

Se habra copiado el clip y aparecerd un
mensaje de finalizacion.

5 Pulse el botén SET o el dial SEL/SET
para ignorar el mensaje.

Copia de todos los clips

Se pueden copiar todos los clips almacenados en
una tarjeta de memoria a otra tarjeta de memoria
al mismo tiempo.



1 Seleccione Copy Clip >All Clips, en el
ment Thumbnail.

Aparece una pantalla de confirmacion.

2 Seleccione Execute.

Se habran copiado todos los clips y aparecera
un mensaje de finalizacion.

3 Pulse el botén SET o el dial SEL/SET
para ignorar el mensaje.

Eliminacion de clips

Puede eliminar clips de tarjetas de memoria.

* No se pueden eliminar los clips protegidos. Para
eliminar un clip protegido, desbloquéelo primero.

Eliminacion de un clip determinado

1 Seleccione Delete Clip >Select Clip
>Execute, en el meni Thumbnail.

Aparecerd la pantalla de seleccion del clip.

2 Seleccione el clip que desea eliminar.

Se afiadird una casilla al clip seleccionado.

3 Pulse el botén MENU.

Aparece una pantalla de confirmacion.

4 Seleccione Execute.

Se habra eliminado el clip y aparecerd un
mensaje de finalizacién.

5 Pulse el botén SET o el dial SEL/SET
para ignorar el mensaje.

Eliminacidn de todos los clips

1 Seleccione Delete Clip >All Clips, en el
mend Thumbnail.

Aparece una pantalla de confirmacion.

2 Seleccione Execute.

Se habran eliminado todos los clips y
aparecerd un mensaje de finalizacion.

3 Pulse el botén SET o el dial SEL/SET
para ignorar el mensaje.

Filtracion de los clips
(fotogramas) mediante la pantalla
de imagenes en miniatura de
marcas de esencia

Cuando se ha grabado una marca de inicio de
grabacién en un clip, solo puede visualizar
imdgenes en miniatura de los fotogramas con una
marca de inicio afiadida.

Esta pantalla se conocerd como la pantalla de
imdgenes en miniatura de marcas de esencia.

Seleccione Thumbnail View >Essence Mark

Thumbnail, en el meni Thumbnail, para

seleccionar el tipo de marca de esencia que

desea filtrar.

All: todos los fotogramas con marcas de esencia
afiadidas

Rec Start: fotogramas con una marca de inicio
de grabacién y el primer fotograma de los
clips que no tienen una marca de inicio de
grabacion

Aparecerd la pantalla en miniatura de marcas de
esencia, filtrada segun el tipo de marca de esencia
seleccionado.

Cambio de la informacion
mostrada en la pantalla de
iméagenes en miniatura

Puede cambiar la informacién de fotogramas/
clips que se muestra debajo de la imagen en
miniatura.

Seleccione Customize View >Thumbnail

Caption, en el meni Thumbnail, y

seleccione la informacion que desea

mostrar.

Date Time: fecha y la hora de creacién del clip
y de su tdltima modificacion.

Time Code: cédigo de tiempo

Duration: duracién

Sequential Number: nimero de imagen en
miniatura



Conexion de dispositivos de grabacion y monitores

externos

Para mostrar imédgenes de grabacién o
reproduccién en un monitor externo, seleccione la
sefial de salida del camcorder y utilice un cable
adecuado para conectar el monitor.

También puede conectar dispositivos de
grabacion, como una videograbadora y grabar la
sefial de salida desde el camcorder.

Puede mostrar la misma informacién que aparece
en el visor, como por ejemplo, la informacién de
estado y los menus, en un monitor externo. Ajuste
Output Display (pdgina 83) en el menud Video en
On para el tipo de sefial correspondiente que se
emitird al monitor.

Conector SDI OUT (tipo BNC)

Configure la activacién o la desactivacién de la
salida y el formato de salida desde el menu Video
(pdgina 83).

Utilice un cable coaxial de 75 Q disponible en el
mercado para realizar la conexion.

« Compruebe que la conexion entre el camcorder y el
dispositivo externo estd conectada a tierra antes de
encender los dispositivos.

(Se recomienda que la videocdmara y el dispositivo
externo se enciendan después de conectar el cable
coaxial de 75 Q.)

Si el dispositivo externo se debe conectar a la
videocdmara mientras este estd encendido, conecte
primero el cable coaxial de 75 Q al dispositivo externo
y, a continuacién, conéctelo a la videocamara.

Para iniciar una grabacion en el camcorder y en

el dispositivo externo simultaneamente

Con la salida de sefial SDI habilitada, ajuste SDI/

HDMI Rec Control (pdgina 83) >Setting, en el

menu Video, en On para habilitar la salida de una

sefial de activacion REC hacia el dispositivo
externo conectado en el conector SDI OUT. Esto
sincronizard la grabacion en el dispositivo
externo con el camcorder.

« Si el dispositivo externo conectado no es compatible
con la sefial de activacién REC, el dispositivo no se
podra utilizar.

Conector HDMI OUT (conector tipo A)

Configure la activacion o la desactivacion de la
salida y el formato de salida desde el mend Video
(pdgina 83).

Utilice un cable HDMI de alta velocidad
disponible en el mercado para realizar la
conexion.

Conector Multi/Micro USB

Pueden emitirse sefiales de audio de 2 canales a
través del cable VMC-15MR2 AV (se vende por
separado).




Gestion/Edicion de clips
con un ordenador

Conexidn con un cable USB

Conecte la videocamara con el cable USB
suministrado e introduzca una tarjeta de memoria
en laranura. La tarjeta de memoria se reconocerd
como una unidad de extension del ordenador.
Cuando se insertan dos tarjetas de memoria en la
videocamara, el ordenador las reconoce como dos
unidades de extension independientes.

¢ La videocdmara no funciona con la alimentacién del
bus del ordenador. Prepare una fuente de alimentacién
independiente.
¢ La videocdmara no se reconoce como una unidad de
extension en los siguientes casos.
— Durante la grabacién (incluidos los modos de
grabacidén especiales)
— Durante la reproduccién (incluida reproduccién a
alta velocidad y en pausa)
— Durante la visualizacién en pantalla de miniaturas
— Al dar formato (incializar) a los medios
— Al restaurar tarjetas de memoria o actualizar
archivos de administracion (incluido durante la
confirmacion antes de la ejecucion)

1 Conecte el conector Multi/Micro USB
de la videocamara al ordenador
mediante un cable USB.

2 Ajuste el interruptor ON/STANDBY en
ON.

En la pantalla LCD/la pantalla del visor
aparecerd un mensaje solicitindole que
confirme que desea habilitar la conexion
USB.

Si desaparece el mensaje de confirmacién,
desconecte y, a continuacion, vuelva a conectar el
cable USB. El mensaje de confirmacién no se
muestra durante la visualizacién de la pantalla
grabacién/reproduccién/miniatura.

3 Seleccione Execute con el boton 4/¥%/«/
» o el dial SEL/SET.

4 En Windows, compruebe que la tarjeta
se ha afiadido como un disco extraible
en la ventana “Mi Equipo”.

62

En Macintosh, compruebe que se crea
una carpeta “NO NAME?” o “Untitled”
(editable) en el escritorio.

No realice las siguientes operaciones si la luz de acceso

se ilumina en rojo.

— Apagar el dispositivo o desconectar el cable de
alimentacion

— Extraccion de una tarjeta de memoria

— Desconectar el cable USB

Al retirar una tarjeta de memoria de un Macintosh, no

seleccione “Card Power Off” en el icono de la tarjeta

de memoria que aparece en la barra de mentis.

* No se garantiza el funcionamiento en todos los

ordenadores.

Utilizacion del software de aplicacion

Para copiar clips en el disco local de su
ordenador, el software de aplicacién especifico
debe descargarse e instalarse en su ordenador.
Para obtener mas detalles acerca de la descarga de
software, consulte “Descargas de software”
(pdgina 119).

Aunque los datos concernientes a los materiales
grabados estdn almacenados en varios archivos y
carpetas, es posible manejar con facilidad los
clips sin tener en cuenta la estructura de los datos
y los directorios si se utiliza el software de
aplicacién especifico.

« Si realiza operaciones, como copiar clips de la tarjeta
de memoria usando Explorer (Windows) o Finder
(Macintosh), es posible que no se conserven los datos
relacionados incluidos en los clips.

Uso de un sistema de edicion no lineal

En un sistema de edicién no lineal, es necesario
disponer de software de edicion (opcional) que
sea compatible con los formatos grabados por el
camcorder.

Utilice el software especifico de aplicaciones para
guardar previamente los clips que desee editar en
el disco duro del ordenador.



Conexion de un soporte externo
HDD/USB

Cuando se conecta un soporte externo HDD o
USB al conector USB 3.0 (HOST) de la
videocdmara, puede copiar clips del soporte de
grabacidn insertado en una ranura para tarjeta de
memoria al soporte externo HDD o USB.

Copia de clips a un soporte USB

1 Seleccione USB >Select Folder
(pdgina 90), en el mena Media.

2 Seleccione la carpeta de destino de la
copia de la lista de carpetas y pulse el
botén SET o el dial SEL/SET.

También puede seleccionar New, en la
pantalla, para crear una nueva carpeta.

« Si no se especifica la carpeta, se creard
automdaticamente una carpeta con la fecha de
creacién del primer archivo que se copie como
nombre y se copiardn los archivos a esa carpeta.

3 Seleccione USB >Copy to USB
(pdgina 90) en el menti Media, inserte el
soporte de grabacién de destino para
copiar y seleccione la ranura para
tarjeta de memoria.

Media(A) to USB: copiar todos los clips
del soporte de grabacién insertado en la
ranura A.

Media(B) to USB: copiar todos los clips
del soporte de grabacién insertado en la
ranura B.

Media(A)(B) to USB: copiar todos los clips
del soporte de grabacién insertado en las
ranuras A 'y B.

Cuando se especifica una carpeta de destino de
copiaen el paso 2 y se selecciona Media(A)(B) to
USB, los clips de la ranura A se copian a la
carpeta de destino especificada. Los clips de la
ranura B se copiardn a una carpeta que se creard
automdticamente con la fecha de creacion del
primer clip como nombre.

4 Seleccione Execute con el botén 4/%/4/
» o el dial SEL/SET y pulse el boton
SET o el dial SEL/SET.
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Se copiardn todos los clips del soporte de
grabacion de destino al soporte USB.

« Si ya existe un clip con el mismo nombre de
archivo que el clip que se va a copiar en la carpeta
de destino, entonces no se copiard.

Visualizacion de una lista de clips en un
soporte externo HDD/USB

Puede visualizar una lista de los clips que
contiene un soporte externo HDD/USB mediante
USB >View Clip List (pdgina 90), en el ment
Media.

Cambio de nombre de una carpeta en un
soporte externo HDD/USB

1 Seleccione USB >Rename Folder
(pdgina 90), en el menti Media.

2 Seleccione la carpeta a la que desea
cambiarle el nombre de la lista de
carpetas y pulse el boton SET o el dial
SEL/SET.

Aparecera una pantalla de introduccién de
nombre.

3 Introduzca un nombre de carpeta y
seleccione Done.

Se cambiard el nombre de la carpeta.

Comprobacidn de errores de lectura de
copia

Puede comprobar si hay errores de lectura tras
grabar un clip mediante USB >Error Check
(pdgina 90), en el menu Media, en On.

Formateo (inicializacion) de un soporte
externo HDD/USB

1 Seleccione USB >Format USB
(pdgina 90), en el ment Media.

2 Seleccione Execute con el boton 4/¥/«/
» 0 el dial SEL/SET y pulse el boton
SET o el dial SEL/SET.

Comenzara la inicializacion (formateo).



3 Aparecera un mensaje cuando finalice
el formateo. Seleccione OK.

Comprobacion de la capacidad restante
en un soporte externo HDD/USB

Se mostrara el espacio libre en un soporte externo
HDD/USB en la fila Media Remain en la pantalla
mostrada cuando se selecciona USB en el menud
Media.

Acerca del nombre de una carpeta en un
soporte externo HDD/USB

Al realizar una operacién en el elemento de ment
USB, en el ment Media, se suministrara
alimentacion al soporte externo HDD/USB
automdticamente desde el conector USB 3.0
(HOST).

Sin embargo, no se comenzard a suministrar
alimentacion en las siguientes condiciones,
incluso cuando se realiza una operacién en el
elemento del mentd USB en el mend Media. Para
comenzar el suministro de alimentacion, lleve a
cabo la solucién que se muestra en la tabla.

Estado Solucién
Durante la grabacién de Finalice la operacion
clips, reproduccién, anterior.

visualizacién de imdgenes
en miniatura, grabacion de
proxy, formateo/restauracién
de soporte, actualizacién de
archivos de gesti6n,
actualizacion de software,
reinicio de la videocdmara,
reinicio de la red, conexion
al ordenador, visualizacién
de la pantalla de
confirmacién

Tension de suministro Cambie la baterfa o

insuficiente sustituya el suministro
de alimentacién de
entrada.

 Los clips de un soporte externo HDD/USB no se
pueden copiar a un soporte de grabacién insertado en
una ranura para tarjeta de memoria.

* No se pueden grabar los clips mientras se suministra
alimentacion al conector USB 3.0 (HOST). Para
comenzar a grabar clips, finalice el funcionamiento del
elemento del mend USB en el ment Media.
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Pantalla de meniis y ajustes

Configuracion del mena de ajustes y jerarquia

Pulse el botén MENU para mostrar el ment de
configuracién en el visor o en la pantalla LCD
con el fin de especificar los distintos elementos
para filmar, grabar y reproducir (el menu también
se puede visualizar en un monitor externo). El
menu de configuracién incluye los siguientes
mends.

User Menu: Meni con elementos configurados
por el usuario (se editan con Edit User
Menu).

Menu Edit User Menu: Mend para editar
elementos del mend User.

Menu Camera: Contiene ajustes relacionados
con la filmacion.

Menu Paint: Contiene ajustes relacionados con
la calidad de la imagen.

Menu Audio: Contiene ajustes relacionados con
el audio.

Menu Video: Contiene ajustes relacionados con
la salida de video.

Menu LCD/VF: Contiene ajustes para la pantalla
LCD y la pantalla del visor.

Ment TC/UB: Contiene ajustes relacionados

con el cédigo de tiempo y los bits de usuario.

Menu Recording: Contiene ajustes
relacionados con la grabacion.

Menu Thumbnail: Contiene ajustes
relacionados con la pantalla de imdgenes en
miniatura.

Menu Media: Contiene ajustes relacionados con
los soportes.

Menu File: Contiene ajustes relacionados con
los archivos.

Menu Network: Contiene ajustes relacionados
con las redes.

Menu System: Contiene ajustes relacionados
con el sistema.

Jerarquia del meni de
configuracién

MENU

User

Base Setting
Rec Format
S&Q Motion
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+ Edit User Menu

- Camera

 Paint

 Audio

— Picture Cache Rec
— Simul Rec

- Proxy Rec

- Output Format

I Assignable Button
- Delete Clip

— Wireless LAN

- Format Media

— Menu Settings

L Edit User Menu

Add ltem
Customize Reset

— Focus

 ND Filter

— Gain

— Shutter

I Auto Exposure

- Color Bars

I Flicker Reduce

- Flash Band Reduce
- SteadyShot

- Handle Zoom

- Speed Zoom

I Auto Black Balance
L Video Light Set

— HDR Paint Setting
— White

— White Setting
— Offset White
 Black

— Gamma

- Knee

— White Clip

- Detail(QFHD)
- Detail(HD)

- Detail(SD)

- Skin Detail

— Aperture

— Matrix

L Maintenance

—|: Audio Input
Audio Output



 Video

— LCD/VF

—TC/UB

— Recording

I Thumbnail

— Media

- File

— Network

L System

— Output On/Off

- Output Format

- Output Display

- SDI/HDMI Rec Control
L Down Converter

— LCD Setting

- VF Setting

- Peaking

— Marker

- Zebra

— Gamma Display Assist
L Display On/Off

— Timecode
- Users Bit
L HDMI TC Out

— S&Q Motion

- Interval Rec

- Picture Cache Rec
 Clip Continuous Rec
- Simul Rec

— Proxy Rec

L Rec Review

— Display Clip Properties
- Lock/Unlock Clip

- Delete Clip

I Copy Clip

- Thumbnail View

L Customize View

— Update Media
- Format Media
—USB

L Clip Naming

— User File
- All File
L Scene File

— Access Authentication
— Wireless LAN

— AP Mode Settings

- ST Mode Settings

L Network Reset

— Base Setting
— Rec Format
- Assignable Button

— Tally

- Language

I~ Clock Set

— Hours Meter

— GPS

I Battery Alarm

— DC Voltage Alarm
— Menu Settings

I Fan Control

- All Reset

L Version
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Operaciones del menii
de configuracion

Pulse el botén MENU para mostrar el ment de
configuracién en el visor o en la pantalla LCD
con el fin de especificar los distintos elementos
para filmar, grabar y reproducir (el mend también
se puede visualizar en un monitor externo).

Controles del menii

Boton MENU (pdgina 9)
Active y desactive el modo de ment para la
operacion del meni de configuracion.

Dial SEL/SET (pagina 9)

Gire el dial para mover el cursor hacia arriba y
hacia abajo para seleccionar elementos o ajustes
del mend.

Pulse el dial SEL/SET para aplicar el elemento
seleccionado.

Boton CANCEL/BACK (pdgina 9)
Pilselo para volver al ment anterior. Los cambios
sin finalizar se cancelan.

Boton 4/¥/«/»/SET

Pulse los botones 4/%/«/# para mover el cursor
hacia arriba, hacia abajo, hacia la izquierda o
hacia la derecha y seleccionar elementos o ajustes
del mend.

Pulse el botén SET para aplicar el elemento
seleccionado.

« El ment de configuracion no se puede utilizar cuando
el modo de pantalla de ampliacién de enfoque estd
activado (pdgina 26).

Elementos del menii de configuracidn

Mueva el cursor hasta el elemento deseado
pulsando el botén 4/¥/«/# o girando el dial SEL/
SET y pulse el botén SET o el dial SEL/SET para
aplicar el ajuste.

« El drea de seleccion del elemento del mend
puede mostrar hasta 9 lineas. Si las opciones
disponibles para un elemento no se pueden
mostrar al mismo tiempo, despldcese por la
pantalla moviendo el cursor hacia arriba/abajo.

 En el caso de los subelementos con una amplia
gama de opciones (por ejemplo, de —99 a +99),
el drea de configuracion no se visualiza. El
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ajuste actual se resalta para indicar que el valor
se puede cambiar.

Si selecciona Execute para una funcién, la
funcién correspondiente se ejecutara.

Si selecciona un elemento que requiere
confirmacién antes de su ejecucion, el ment se
ocultard temporalmente y se mostrard un
mensaje de confirmaciéon. Compruebe el
mensaje y a continuacion selecciones si desea
ejecutar o cancelar la funcién.

Introduccion de una cadena de
caracteres

Cuando selecciona un elemento, como por
ejemplo un nombre de archivo, que requiere la
introduccién de caracteres, aparecerd la pantalla
para introducir caracteres.

1

Edit File Name

Kurokawa_Scene_001 a

Bbcdefgh.i

nopagqr s

2 3

1 Gire el dial SEL/SET para seleccionar
un tipo de caracter y, a continuacion,
pulse el dial.

ABC: caracteres alfabéticos en maytsculas
abc: caracteres alfabéticos en mintsculas
123: caracteres numéricos

1#$: caracteres especiales

2 Seleccione un caricter del tipo de
caracter seleccionado y, a continuacion,
pulse el dial.

El cursor pasa al campo siguiente.

Space: introduce un caricter de espacio en la
posicion del cursor.

«/%: mueve la posicion del cursor.

BS: elimina el cardcter a la izquierda del
cursos (retroceso).

3 Cuando acabe, seleccione Done y pulse
el dial.



La cadena de caracteres se confirma y la
pantalla de introduccién de caracteres
desaparece.

Bloqueo y deshloqueo del menii

Puede bloquear el menu de configuracién para
que solo se muestre el ment User.

Bloqueo del menii

1 Mantenga pulsado el dial SEL/SET y
pulse el botén MENU.

2 Seleccione Menu Settings >User Menu
with Lock en el meni System.

Cuando solo se pulsa el botén MENU para
mostrar el mend de configuracién normal, User
Menu Only se muestra en Menu Settings, en el
mend System. Mantenga pulsado el dial SEL/
SET y pulse el botéon MENU para mostrar User
Menu with Lock.

3 Ajistelo en Ony pulse el botén SET o el
dial SEL/SET.
La visualizacién de la pantalla del visor o de

la pantalla LCD cambia a la pantalla de
introduccion del ndmero del cédigo de

Elemento del ment de

configuracion

Opciones de
seleccion de los
botones asignables

Camera >Focus >Face
Detection AF

Face Detection AF

Camera >Focus >Focus
Macro

Focus Macro

Camera >Gain >Gain
<Turbo>

Turbo Gain

Camera >Auto Exposure
>Level

Auto Exposure Level

Camera >Auto Exposure Spotlight
>Mode

Camera >Auto Exposure Backlight
>Mode

Camera >Auto Exposure Auto ND Filter
>Auto ND Filter

Camera >Auto Exposure AGC

>AGC

Camera >Auto Exposure Shutter

>Auto Shutter

Camera >Color Bars Color Bars
>Setting

Camera >Flash Band Reduce Flash Band Reduce
>Setting

Camera >SteadyShot SteadyShot
>Setting

Camera >Handle Zoom
>Setting

Handle Zoom

Paint >White >Preset White Preset White Select

acceso.
LCD/VF >VF Setting >Color VF Mode
4 Introduzca un nimero arbitrario Mode
. L. LCD/VF >Peaking >Setting Peaking
Introduzca un nimero de 4 digitos que se L CD/VE SMarker ~Sett ok
arker ettin arker
encuentre entre 0000 y 9999. El valor - e
LCD/VF >Zebra >Setting Zebra

predeterminado es 0000.

LCD/VF >G: Displ:
Introduzca un niimero y pulse el botén SET o amma Dispiay

Assist >Setting

Gamma Display Assist

el dial SEL/SET para mover el curso hasta el

Lo .. LCD/VF >Display On/Off
siguiente digito.

>Lens Info

Lens Info

Cuando haya introducido todos los digitos,

LCD/VF >Display On/Off
mueva el cursor hasta SET.

>Video Signal Monitor

Video Signal Monitor

5 Recording >S&Q Motion S&Q Motion

Pulse el botén SET o el dial SEL/SET. >Setting

Se aplica el nimero introducido.
Aparece un mensaje de confirmacion y la

Recording >Picture Cache Picture Cache Rec

Rec >Setting

pantalla cambia a la pantalla del menu User. Recording >Clip Continuous

Rec >Setting

Clip Continuous Rec

Recording >Rec Review Rec Review
» Si el mend estd bloqueado y no se han registrado >Setting
elementos del menu de configuracion de las siguientes Network >Wireless LAN NFC
tablas en el menu User, esas funciones no se pueden
- . >NFC
asignar a los botones asignables.
User User Menu

Si esas funciones ya estaban asignadas a botones
asignables, cuando se bloquea el ment se fuerza la
desactivacion del ajuste asignable.
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Deshloqueo del menii

1 Mantenga pulsado el dial SEL/SET y
pulse el boton MENU.

2 Seleccione Menu Settings >User Menu
with Lock en el meni System.

Cuando solo se pulsa el botéon MENU para
mostrar el menu de configuracién normal, User
Menu Only se muestra en Menu Settings, en el
menu System. Mantenga pulsado el dial SEL/
SET y pulse el boton MENU para mostrar User
Menu with Lock.

3 Ajistelo en Off y pulse el botén SET o el
dial SEL/SET.

La visualizacién de la pantalla del visor o de
la pantalla LCD cambia a la pantalla de
introduccién del nimero del cédigo de
acceso.

4 Introduzca el nimero del codigo de
acceso que se utilizo para bloquear el
menu.

Introduzca un niimero y pulse el botén SET o
el dial SEL/SET para mover el curso hasta el
siguiente digito.

Cuando haya introducido todos los digitos,
mueva el cursor a Set.

9 Pulse el botén SET o el dial SEL/SET.

Se aplica el nimero introducido.

Si el nimero del cédigo de acceso
introducido coincide con el nimero del
c6digo de acceso que se utilizo para bloquear

el menu, el menu se desbloquea y se muestra.

Si el nimero del c6digo de acceso introducido no
coincide con el nimero del c6digo de acceso que se
utiliz6 para bloquear el mend, el mend no se
desbloquea.

Se recomienda que anote el nimero del cédigo de
acceso en un lugar cercano por si lo olvida. Si se olvida
del nimero del cédigo de acceso, pongase en contacto
con su representante de atencién al cliente de Sony.

Edicion del menu User

Puede editar el menu User, como afiadir, eliminar
y reorganizar elementos, para aportar mayor
utilidad al ment User mediante el uso de Edit
User Menu.
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Anadir elementos y subelementos

1 Seleccione Edit User Menu >Add Item
en el menua User.

Se muestran los elementos que puede afiadir.

2 Seleccione un elemento para afadirlo.

Aparece una pantalla para la seleccion de los
subelementos que desea afadir.

3 Seleccione un subelemento para
afiadirlo.
Marque la casilla de seleccién All para afiadir
todos los subelementos.
Marque casillas de seleccion individuales
para especificar los subelementos que desea
afiadir.

4 Seleccione OK y pulse el botén SET o el
dial SEL/SET.

Se afiaden el elemento y los subelementos.

* No se puede registrar el mismo elemento o
subelemento dos veces.
Ademds, el nombre del elemento o subelemento no se
puede cambiar.

Editar los subelementos

Puede especificar qué subelementos desea que se
muestren.

1 Seleccione Edit User Menu en el ment
User y seleccione el elemento que desea
editar.

Aparece la lista de funciones de edicién.

2 Seleccione Edit Sub Item.

Aparece la pantalla Edit Sub Item.

Cuando se abre la pantalla por primera vez,
todos los subelementos estdn seleccionados
(funcién para mostrar todos los
subelementos).

Anule la seleccién de los subelementos que
no desea que se muestren en el mend User.

3 Seleccione OK y pulse el botén SET o el
dial SEL/SET.

La edicion se ha finalizado.



Eliminar un elemento

1

Seleccione Edit User Menu en el meni
User y seleccione el elemento que desea
eliminar.

Aparece la lista de funciones de edicién.

Seleccione Delete.

Se elimina el elemento.

Mover un elemento

1

Seleccione Edit User Menu en el meni
User y seleccione el elemento que desea
mover.

Aparece la lista de funciones de edicion.

Seleccione Move.

El elemento que se va a mover aparece
destacado y una linea y una marca triangular
indican la posicién de destino.

Mueva la linea y la marca triangular al
destino del elemento y pulse el boton
SET o el dial SEL/SET.

Se mueve el elemento.

Restaurar el estado predeterminado del
menii User

1

Seleccione Edit User Menu >Customize
Reset en el meniu User.

Aparece la pantalla Customize Reset.

Seleccione Reset y pulse el botén SET o
el dial SEL/SET.

Aparece una pantalla de confirmacion.

Seleccione Execute y pulse el boton SET
o el dial SEL/SET.

Se restaura el estado predeterminado del
ment User.
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Lista del meni de configuracion

Esta seccion describe la funcion y los ajustes de los elementos en cada menu.
Los ajustes predeterminados de fabrica se muestran en negrita (por ejemplo, 18dB).

Meni User

User

Elementos registrados Descripcion
predeterminados

Base Setting Elemento System >Base Setting
Rec Format Elemento System >Rec Format
S&Q Motion Elemento Recording >S&Q Motion

Picture Cache Rec

Elemento Recording >Picture Cache Rec

Simul Rec

Elemento Recording >Simul Rec

Proxy Rec

Elemento Recording >Proxy Rec

Output Format

Elemento Video >Output Format

Assignable Button

Elemento System >Assignable Button

Delete Clip

Elemento Thumbnail >Delete Clip

Wireless LAN

Elemento Network >Wireless LAN

Format Media

Elemento Media >Format Media

Menu Settings

Elemento System >Menu Settings

Edit User Menu

Muestra la pantalla Edit User Menu.

Menu Edit User Menu

Edit User
Menu

Elemento Subelementos y ajustes Descripcion

Add ltem - Afiade elementos y subelementos.

Customize Reset Restaura el estado predeterminado del ment User.
Reset

Elementos Delete Elimina un elemento.

mostrados cuando “Njove

Mueve un elemento.

se selecciona el
elemento
registrado

Edit Sub Item

Edita un subelemento.
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Menu Camera

Camera

Elemento Subelementos y ajustes Descripcion

Focus Face Detection AF Habilita/deshabilita el enfoque automatico de la deteccién de
Ajustes de enfoque Face Only AF / caras.

automdtico de la
deteccion de caras

Face Priority AF / Off

Focus Macro
On / Off

Activa y desactiva el modo macro.

ND Filter
Ajustes del filtro
ND

Preset1
1/128/1/64 /1 1/32/1/16/
1/8/1/4

Establece el valor preajustado 1 del filtro ND.

Preset2
1/128 /1/64/1/32 /116 /
1/8 7 1/4

Establece el valor preajustado 2 del filtro ND.

Preset3
1/128/1/64 /1/32/1/16 /
1781 1/4

Establece el valor preajustado 3 del filtro ND.

Gain
Ajustes de
ganancia

Gain<L>
18dB/15dB/ 12dB /9dB / 6dB
/3dB/0dB /-3dB

Establece la ganancia cuando el interruptor GAIN se ajusta en
la posicion L.

Gain<M>
18dB / 15dB / 12dB / 9dB /
6dB /3dB /0dB /-3dB

Establece la ganancia cuando el interruptor GAIN se ajusta en
la posicién M.

Gain<H>
18dB / 15dB / 12dB / 9dB /
6dB /3dB /0dB /-3dB

Establece la ganancia cuando el interruptor GAIN se ajusta en
la posicién H.

Gain <Turbo>
30dB / 18dB / 15dB /
12dB /9dB / 6dB / 3dB / 0dB /
-3dB

Establece el valor de la ganancia cuando se pulsa un botén
asignable que tiene la funcién Turbo Gain asignada.

High Sensitivity Mode
On / Off

Activa/desactiva el modo de sensibilidad alta.

Shockless Gain
On / Off

Activa y desactiva la funcién de ganancia sin vibraciones.
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Camera

Elemento Subelementos y ajustes Descripcion

Shutter Mode Selecciona el modo de operacién del obturador electrénico.
Ajustes de las Speed / Angle Se utiliza para filmar con claridad sujetos que se mueven
condiciones rdpidamente. Selecciona el modo para ajustar la velocidad de
operativas del obturacién en segundos (Speed) o como el dngulo del
obturador obturador (Angle).

electrénico Shutter Speed Ajusta la velocidad de obturacion cuando se selecciona el

64F, 32F, 16F, 8F, TF, 6F, 5F,
4F, 3F, 2F, 1/24, 1/25, 1/30,
1/32, 1/33, 1/40, 1/48, 1/50,
1/60, 1/96, 1/100, 1/120, 1/125,
17250, 1/500, 1/1000, 1/2000,
174000, 1/8000

modo Speed. Los ajustes disponibles dependen de la
frecuencia de fotogramas del formato de video seleccionado.

Shutter Angle
64F /32F / 16F / 8F / TF /
6F /5F/4F /3F / 2F /
360.0° /300.0° /270.0° /
240.0°/216.0°/210.0° /
180.0°/172.8°/150.0° /
144.0° /120.0° 7 90.0° / 86.4° /
72.0°/45.0°/30.0°/22.5°/
11.25°/5.6°

Ajusta el dngulo del obturador cuando se selecciona el modo
Angle.

ECS
On / Off

Activa/desactiva el modo ECS.
Se utiliza para filmar sin que aparezcan barras horizontales de
desplazamiento en la pantalla del visor o en la pantalla LCD.

ECS Frequency
De 8000 a 23.99
(Area NTSC: 60.00, drea PAL:
50.00)

Ajusta la frecuencia ECS cuando se selecciona el modo ECS.
Los ajustes disponibles dependen de la frecuencia de
fotogramas del formato de video seleccionado.

Auto Exposure Level

Ajustes de la
exposicion
automdtica del
brillo

+3.0/42.75/+2.5/+2.25/
+2.0/+1.75/+1.5/+1.25/
+1.0/40.75/+0.5/+0.25/
+0/-0.25/-0.5/-0.75/
-1.0/-1.25/-1.5/-1.75/
—2.0/-225/-25/-275/
-3.0

Establece el nivel de compensacion.

Mode Ajusta el modo de control.
Backlight / Standard / Backlight: modo de retroiluminacién (modo para reducir el
Spotlight oscurecimiento de un sujeto cuando dicho sujeto estd
retroiluminado)
Standard: modo estandar
Spotlight: modo de luz direccional (modo para reducir los
toques de luz apagados cuando el sujeto recibe un
iluminacion direccional)
Speed Establece la velocidad de control.
De 99 a +99 (x0)
Auto ND Filter Activa y desactiva la funcién de ajuste automatico de la
On / Off densidad del filtro ND.
AGC Activa y desactiva la funcién AGC (Control automdtico de
On / Off ganancia).
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Camera

Elemento

Subelementos y ajustes

Descripcion

Auto Exposure
Ajustes de la

AGC Limit
0dB /3dB /6dB /9dB / 12dB /

Ajusta la ganancia maxima de la funcién AGC.

exposicion 15dB / 18dB
au}omzilica del AGC Point Establece el valor F-stop de los iris si la operacion AGC
brillo F2.8/F4/F5.6 empieza cuando la funcién AGC estd ajustada en On.
Auto Shutter Activa/desactiva la funcion de control del obturador
On / Off automatico.
A.SHT Limit Ajusta la velocidad mds rdpida del obturador en la funcién de
1/100/1/150 / 1/200 / obturador automadtico.
1/250/1/2000
A.SHT Point Establece el valor F-stop de los iris si se inicia la operacién de
F5.6/F8/F11 obturacién automdtica.
Clip High light Activa/desactiva la funcién que ignora las zonas mds
On / Off iluminadas para proporcionar una respuesta menor a la
luminosidad alta.
Detect Window Ajusta el rango del medidor de luz para ajustar
1/2/3/4/5/6 automdticamente la exposicion de acuerdo con la luminosidad
del sujeto. (No disponible cuando se ajusta la exposicién
manualmente)
Detect Window Indication Activa/desactiva la funcion para visualizar la Detect Window
On / Off utilizando un marcador.
Color Bars Setting Activa y desactiva las barras de colores.
Ajustes de las On / Off
barras de colores  Type Selecciona el tipo de barras de colores.
ARIB / 100% / 75% / SMPTE
Flicker Reduce Mode Ajusta el modo de correccién de parpadeo.
Ajustes de Auto / On / Off
correccién de Frequency Ajusta la frecuencia de la fuente de alimentacién que
parpadeo 50Hz / 60Hz proporciona la iluminacién causante del parpadeo.
(Area NTSC: 60.00, drea PAL:
50.00)
Flash Band Setting Activa y desactiva la funcion de reduccién de la luz intensa.
Reduce On / Off Reduce los toques de luz apagados en la parte superior o la
Ajustes de parte inferior de la imagen cuando se filma con un flash para
correccion de la una cdmara fija.
luz intensa
SteadyShot Setting Ajusta la funcién de estabilizacién de la imagen.
Ajustes de Active / Standard / Off
estabilizacion de la m
imagen » El ajuste Active no estard disponible en los siguientes casos.
— Cuando Video Format es 3840x2160
— Durante la grabacién Slow & Quick Motion
Handle Zoom  Setting Ajusta la velocidad del zoom del asa.
Ajustes de la Off / Low / High / Variable
velocidad del High Establece la velocidad del zoom de la palanca de zoom del asa
zoom del asa De 1a8(8) cuando se selecciona la velocidad High del zoom del asa.
Low Establece la velocidad del zoom de la palanca de zoom del asa
De1a8(3) cuando se selecciona la velocidad Low del zoom del asa.
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Camera

Elemento Subelementos y ajustes Descripcion

Speed Zoom  Setting Activa y desactiva la funcién de velocidad del zoom.
Ajustes de la On / Off

funcién de

velocidad del

zoom

Auto Black Auto Black Balance Ejecuta la funcién del balance de negros automético.
Balance Execute / Cancel

Ajustes del m

balance * No se puede establecer durante la grabacién ni cuando se
automadtico de muestran las barras de colores.

negros * No se puede establecer con el modo Grabacién a intervalos,

el modo de grabacién de fotogramas o el modo de obturador
lento.

Video Light Video Light Set
Set Power Link / Rec Link / Rec
Ajustes de la luz Link + Stby

de video

Ajusta el método de control de iluminacién para la luz de

video acoplada a la zapata de interfaz multiple.

Power Link: activa y desactiva la luz de video cuando la
videocdmara se enciende y se apaga.

Rec Link: activa y desactiva la luz de video cuando la
videocdmara inicia y detiene la grabacién.

Rec Link + Stby: la luz de video se activa o se pone en espera
cuando la videocdmara inicia o detiene la grabacion.

Menu Paint

Elemento Subelementos y ajustes Descripcion
HDR Paint HLG Type Establece el tipo de HLG cuando Shooting Mode est4 ajustado
Setting HLG/HLGI /HLG2/HLG3 enHDR.

Ajustes del modo
de rango dindmico

HLG: ajuste equivalente a ITU-R BT.2100.

HLG1: ajuste que proporciona mayor supresién de ruido que
HLG?2. Sin embargo, el rango dindmico que puede filmarse
es mds estrecho.

HLG?2: ajuste con equilibrio entre el rango dindmico y la
supresion de ruido.

HLGS3: ajuste que proporciona un rango dindmico mas amplio
que HLG2. Sin embargo, el nivel de ruido aumenta.

HLG1, HLG2 y HLGS3 utilizan la misma caracteristica de
curva gamma, pero con un balance de ruido y rango
dindmico diferentes.

HDR Black Offset
De -95 a +103 (x0)

Establece la compensacion de negros de HDR relativa al
ajuste SDR (Master Black) cuando Shooting Mode estd
ajustado en HDR.

HDR Knee
On/ Off

Activa y desactiva la funcién de correccién de inflexién de la
sefial HDR cuando Shooting Mode estd ajustado en HDR.

HDR Knee Point
De -99 a +99 (x0)

Ajusta el punto de inflexién para las senales HDR cuando
HDR Knee estd ajustado en On.

HDR Knee Slope
De —99 a +99 (x0)

Ajusta la pendiente de inflexi6n para las sefiales HDR cuando
HDR Knee estd ajustado en On.
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Elemento Subelementos y ajustes Descripcion
White Preset White Ajusta la temperatura del color predeterminado cuando se
Ajustes del De 10000K a 2100K (3200K) selecciona un ajuste predeterminado en el modo de balance de

balance de blancos

blancos.

* No se puede comprobar el cambio en la pantalla aunque se
cambie el ajuste Preset White cuando no se seleccione un
ajuste predeterminado en el modo de balance de blancos.

Color Temp <A>
De 50000K a 1500K (3200K)

Visualiza la temperatura de color del balance de blancos que
estd guardada en la memoria A.

Color Temp Balance <A>
De 99 a +99 (x0)

Ajusta los valores de ganancia del balance de blancos que
estdn guardados en la memoria A (relacionado con ganancia R
y ganancia B).

R Gain <A>
De -99 a +99 (x0)

Ajusta la ganancia R del balance de blancos que estd guardada
en la memoria A.

B Gain <A>
De -99 a +99 (x0)

Ajusta la ganancia B del balance de blancos que esta guardada
en la memoria A.

Color Temp <B>
De 50000K a 1500K (3200K)

Visualiza la temperatura de color del balance de blancos que
estd guardada en la memoria B.

Color Temp Balance <B>
De 99 a +99 (x0)

Ajusta los valores de ganancia del balance de blancos que
estdn guardados en la memoria B (ganancia R y ganancia B
unidas).

R Gain <B> Ajusta la ganancia R del balance de blancos que estd guardada
De -99 a +99 (+0) en la memoria B.
B Gain <B> Ajusta la ganancia B del balance de blancos que estd guardada
De —99 a +99 (+0) en la memoria B.
White Setting Shockless White Ajusta la velocidad de respuesta del balance de blancos
Configuracion del Off/1/2/3 cuando se cambia el modo de balance de blancos.
ajuste del balance Off: cambia instantdneamente.
de blancos De 1 a 3: cambia mds lentamente cuanto mayor es el nimero.
ATW Speed Ajusta la velocidad de respuesta en el modo ATW.
1/2/3/4/5 1: Velocidad de respuesta mds rapida
White Switch<B> Selecciona el modo de ajuste de balance de blancos
Memory / ATW seleccionado cuando el interruptor WHT BAL estd ajustado
en B.
Filter White Memory Activa y desactiva la funcién que ajusta el drea de memoria
On / Off del balance de blancos para cada filtro ND.
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Elemento Subelementos y ajustes Descripcion
Offset White  Offset White <A> Selecciona si se debe afiadir (On) o no (Off) un valor de
Ajustes de On / Off desviacién al balance de blancos especificado en la memoria

desviacion del

A.

balance de blancos

Warm Cool <A>
De -99 a +99 (x0)

Cuando Offset White <A> estd ajustado en On, se especifica
la desviacién (como una temperatura de color) que se va a
afiadir al balance de blancos de la memoria A. (Tenga en
cuenta que el error aumenta para las temperaturas de color de
mayor desviacién. Ajdstelo mientras mira la imagen real).

Warm Cool Balance <A>
De -99 a +99 (x0)

Ajusta una temperatura de color mds precisa que se puede
utilizar cuando no se obtiene una imagen satisfactoria con
Warm Cool <A>.

Offset White <B>
On / Off

Selecciona si se debe afiadir (On) o no (Off) un valor de
desviacion al balance de blancos especificado en la memoria
B.

Warm Cool <B>
De -99 a +99 (x0)

Cuando Offset White <B> estd ajustado en On, se especifica la
desviacion (como una temperatura de color) que se va a afladir
al balance de blancos de la memoria B. (Tenga en cuenta que
el error aumenta para las temperaturas de color de mayor
desviacién. Ajistelo mientras mira la imagen real).

Warm Cool Balance <B>
De -99 a +99 (x0)

Ajusta una temperatura de color més precisa que se puede
utilizar cuando no se obtiene una imagen satisfactoria con
Warm Cool <B>.

Offset White<ATW> Selecciona si se debe afiadir (On) o no (Off) un valor de
On / Off desviacién al balance de blancos ATW.
Warm Cool<ATW> Ajusta la desviacién afiadida al balance de blancos ATW como

De 99 a +99 (x0)

una temperatura de color cuando Offset White<ATW> estd
ajustado en On.

Warm Cool Balance<ATW>
De —99 a +99 (x0)

Ajusta una temperatura de color més precisa que se puede
utilizar cuando no se obtiene una imagen satisfactoria con
‘Warm Cool<ATW>.

Black
Ajustes de negro

Setting Activa y desactiva la correccién de negro.
On / Off
Master Black Ajusta el nivel de negro maestro.

De 99 a +99 (x0)
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Elemento Subelementos y ajustes Descripcion
Gamma Setting Activa y desactiva la funcion de correccién gamma.
Ajustes de On / Off
correccion de Master Gamma Ajusta el nivel de gamma maestro.
gamma De —99 a +99 (x0)
Gamma Category Selecciona una gamma estiandar (STD) o HG.
STD/HG
Gamma Select Selecciona la tabla de gamma utilizada para la correccion
Cuando Gamma Category estd gamma.
ajustado en STD:
STD1 DVW /STD2 x4.5/
STD3 x3.5/ STD4 240M /
STD5 R709 / STD6 x5.0
Cuando Gamma Category estd
ajustado en HG:
HGI 3250G36/
HG2 4600G30 /
HG3 3259G40 /
HG4 4609G33
Knee Setting Activa y desactiva la funcion de correccién de inflexion.
Ajustes de On / Off (Habilitado cuando Gamma >Gamma Category estd ajustado
correccion de la en STD)
inflexién Auto Knee Activa/desactiva la funcion Auto Knee.
On/ Off
Point Ajusta el punto de inflexién.
De 75% a 109% (90%)
Slope ajusta la pendiente de inflexion.
De —99 a +99 (x0)
Knee Saturation Habilita/inhabilita el ajuste de la saturacion de inflexion
On / Off (ajusta los colores por encima del punto de inflexién).
Knee Saturation Level Ajusta el nivel de ajuste de colores por encima del punto de
De —99 a +99 (+0) inflexién (saturacion de inflexion).
White Clip Setting Activa y desactiva la funcién de ajuste de los clips blancos.
Ajustes de ajuste On/Off

de picos del blanco [ aye]

Entre 90.0% y 109.0%

Ajusta el nivel de limitacién de picos del blanco.
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Elemento

Subelementos y ajustes

Descripcion

Detail(QFHD)

Opciones de ajuste

Manual Setting
On / Off

Activa y desactiva la funcién de ajuste de detalles.

de detalles

Level

Ajusta el nivel de detalle.

(QFHD) De -99 a +99 (+0)
Frequency Ajusta la frecuencia central del detalle (grosor del detalle). E1
De 99 a +99 (x0) detalle serd mds fino cuanto mayor sea la frecuencia central y
serd mas grueso cuanto menor sea la frecuencia central.
Knee Aperture Activa y desactiva la funcion de apertura de inflexion.
On / Off
Knee Aperture Level Establece el nivel de apertura de inflexion.
De 99 a +99 (x0)
White Limit Ajusta el limitador del detalle de los blancos.
De 99 a +99 (+0)
Black Limit Ajusta el limitador del detalle de los negros.
De 99 a +99 (x0)
V Detail Creation Ajusta la fuente de sefial para crear el detalle V.en NAM (G o
NAM/Y/G/G+R R, el que sea mayor), Y, G o G+R.
Detail(HD) Manual Setting Activa y desactiva la funcién de ajuste de detalles.
Opciones de ajuste ~ On / Off
de detalles (HD) 1 evel Ajusta el nivel de detalle.
De —99 a +99 (0)
Frequency Ajusta la frecuencia central del detalle (grosor del detalle).

De —99 a +99 (+0)

El detalle serd mds fino cuanto mayor sea la frecuencia central
y serd mds grueso cuanto menor sea la frecuencia central.

Knee Aperture
On / Off

Activa y desactiva la funcion de apertura de inflexion.

Knee Aperture Level
De 99 a +99 (x0)

Establece el nivel de apertura de inflexion.

White Limit Ajusta el limitador del detalle de los blancos.
De 99 a +99 (+0)
Black Limit Ajusta el limitador del detalle de los negros.

De 99 a +99 (x0)

V Detail Creation
NAM /Y /G/G+R

Ajusta la fuente de sefal para crear el detalle V.en NAM (G o
R, el que sea mayor), Y, G o G+R.
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Elemento

Subelementos y ajustes

Descripcion

Detail(SD)

Opciones de ajuste

Manual Setting

Activa y desactiva la funcién de ajuste de detalles.

de detalles (SD)

On / Off
Level Ajusta el nivel de detalle.
De —99 a +99 (0)
Frequency Ajusta la frecuencia central del detalle (grosor del detalle).

De 99 a +99 (x0)

El detalle serda mds fino cuanto mayor sea la frecuencia central
y serd mds grueso cuanto menor sea la frecuencia central.

Knee Aperture
On / Off

Activa y desactiva la funcion de apertura de inflexion.

Knee Aperture Level
De 99 a +99 (x0)

Establece el nivel de apertura de inflexion.

White Limit Ajusta el limitador del detalle de los blancos.
De —99 a +99 (+0)
Black Limit Ajusta el limitador del detalle de los negros.

De 99 a +99 (x0)

V Detail Creation

Ajusta la fuente de sefal para crear el detalle V.en NAM (G o

NAM/Y/G/G+R R, el que sea mayor), Y, G o G+R.
Skin Detail Setting Activa y desactiva la funcién de correccién de las
Ajustes de On/ Off imperfecciones de la piel.

correccion de las
imperfecciones de
la piel

Area Detection
Execute / Cancel

Detecta el color utilizado para la correccién de las
imperfecciones de la piel.
Execute: ejecuta la funcién.

Area Indication

Activa y desactiva la funcién que muestra el patrén de cebra

On / Off en el drea de color de destino para la correccién del detalle de
la piel.
Level Ajusta el nivel de detalle de la piel.

De 99 a +99 (x0)

Saturation Ajusta la saturacion del color que es objeto de la correccién de
De -99 a +99 (x0) las imperfecciones de la piel.
Hue Ajusta el matiz del color que es objeto de la correccién de las
De 0a 356 imperfecciones de la piel.
Width Ajusta el rango del matiz del color que es objeto de la
De 0 a 90 (40) correccién de las imperfecciones de la piel.
Aperture Setting Habilita/inhabilita la correccion de la apertura (procesamiento
Ajustes de On / Off que mejora la resolucion al afiadir una sefial de apertura de alta
correccion de frecuencia a la sefial de video para corregir el deterioro
apertura producido por las caracteristicas de alta frecuencia).
Level Establece el nivel de correccién de apertura.
De 99 a +99 (x0)
Matrix Setting Activa y desactiva la funcién de correccién matricial.
Ajustes de On/ Off
correccion Adaptive Matrix Activa y desactiva la funcién de matriz adaptable.
matricial On / Off
Preset Matrix Activa y desactiva la funcién de matriz predeterminada.
On / Off
Preset Select Selecciona una matriz predeterminada.
1:SMPTE 240M /

2:1TU-709 / 3:SMPTE Wide /
4:NTSC/5:EBU/ 6:PAL
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Elemento Subelementos y ajustes Descripcion

Maintenance  Test Saw Activa y desactiva la sefial de prueba.
Ajustes de On / Off

mantenimiento

Meni Audio

Audio
Elemento Subelementos y ajustes Descripcion
Audio Input CH2 EXT Input Select Selecciona la entrada para la grabacién en el canal 2.
Ajustes de entrada INPUT1 / INPUT2 Habilitado solo cuando se selecciona la fuente de audio EXT.
de audio CH3 Input Select Selecciona la entrada para la grabacién en el canal 3.

Off / INPUT1 / Internal MIC /

Shoe CH1

CH4 Input Select Selecciona la entrada para la grabacién en el canal 4.

Off /INPUT1 / INPUT2 /
Internal MIC / Shoe CH2

INPUT1 MIC Reference Selecciona el nivel de entrada de referencia cuando el
-80dB /-70dB / -60dB / conmutador INPUT1 estd ajustado en MIC.
—50dB / -40dB / -30dB

INPUT2 MIC Reference Selecciona el nivel de entrada de referencia cuando el
-80dB / -70dB / -60dB / interruptor INPUT2 estd ajustado en MIC.
—50dB / —40dB / -30dB

Internal MIC Level Selecciona el nivel del micréfono interno. Puede seleccionar
—12dB /-6dB /0dB /+6dB / el nivel independientemente del ajuste del dial AUDIO
+12dB LEVEL.

Line Input Reference Selecciona el nivel de entrada de referencia cuando los
+4dB / 0dB / -3dB / EBUL interruptores INPUT1/INPUT?2 estdn ajustados en LINE.

Reference Level Selecciona el nivel de grabacién de la sefial del tono de
—20dB /-18dB / -16dB / referencia de 1 kHz.
—12dB / EBUL

CH1 Wind Filter Activa y desactiva el filtro de reduccién del ruido del aire para
On / Off la grabacién en el canal 1.

CH2 Wind Filter Activa y desactiva el filtro de reduccién del ruido del aire para
On / Off la grabacion en el canal 2.

CH3 Wind Filter Activa y desactiva el filtro de reduccién del ruido del aire para
On / Off la grabacién en el canal 3.

CH4 Wind Filter Activa y desactiva el filtro de reduccién del ruido del aire para
On / Off la grabacién en el canal 4.

CH3 Level Control Selecciona el ajuste automdtico/manual del nivel de entrada
Auto / Manual para grabar en el canal 3.

CH4 Level Control Selecciona el ajuste automdtico/manual del nivel de entrada
Auto / Manual para grabar en el canal 4.

CH3 Input Level Establece el nivel de entrada para grabar en el canal 3 cuando
De 0a 99 (49) se selecciona el ajuste manual.

CH4 Input Level Establece el nivel de entrada para grabar en el canal 4 cuando
De 0a 99 (49) se selecciona el ajuste manual.
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Elemento Subelementos y ajustes

Descripcion

Audio Input Limiter Mode
Ajustes de entrada Off / —6dB / -9dB / -12dB /
de audio —-15dB /-17dB

Selecciona la caracteristica del limitador (nivel de saturacién)
para las sefiales grandes cuando se ajusta el nivel de entrada de
audio manualmente.

CH1&2 AGC Mode
Mono / Stereo

Selecciona el modo de ajuste de nivel automadtico para la
grabacion en el canal 1y en el canal 2. Cuando se selecciona
Stereo, AGC se vincula entre los canales.

CH3&4 AGC Mode Selecciona el modo de ajuste de nivel automadtico para la

Mono / Stereo grabacion en el canal 3 y en el canal 4. Cuando se selecciona
Stereo, AGC se vincula entre los canales.

AGC Spec Selecciona la caracteristica AGC (nivel de saturacién) para las
-6dB /-9dB /-12dB / sefiales grandes cuando se ajusta el nivel de entrada de audio
—15dB /-17dB manualmente.

1kHz Tone on Color Bars Activa y desactiva la sefial de tono de referencia de 1 kHz
On / Off cuando se muestran las barras de colores.

Audio Output  Monitor CH
Ajustes de salida CH1/CH2 / CH3/CH4 / MIX
de audio ALL/CHI1/CH2/CH3/CH4

Selecciona la salida del canal de audio para el conector de
auriculares y el altavoz incorporado.

Headphone Out
Mono / Stereo

Ajusta la salida de auriculares en monoaural (Mono) o estéreo
(Stereo).

Alarm Level Ajusta el volumen de la alarma.
De0Oa7(4)

HDMI Output CH Selecciona la combinacién de canales de audio en la salida
CH1/CH2 / CH3/CH4 HDMI.

Analog Output CH Selecciona la combinacién de canales de audio en la salida de
CH1/CH2/ CH3/CH4 audio analdgica.
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Menu Video

Video

Elemento Subelementos y ajustes

Descripcion

Output On/Off SDI

Activa y desactiva la salida SDI.

Ajustes de salida On/ Off

de video HDMI Activa y desactiva la salida HDMI.
On / Off

Output Format SDI Ajusta la resolucién de la salida SDI.

Ajustes del

formato de salida

* Para obtener mas
detalles acerca
de los ajustes,

SET: ajusta la funcién.

consulte HDMI
“Formatos de

video y sefiales
de salida”

(pdgina 106).

Ajusta la resolucién de la salida HDMI.
SET: ajusta la funcién.

Output Display SDI/HDMI

Selecciona si desea afiadir el menu o el estado en la sefial de

Ajustes de la sefial ~ On/ Off salida de SDI/HDMI.

de salida

SDI/HDMI Rec  Setting Activa y desactiva el control de inicio/parada de grabacién de
Control On / Off un dispositivo externo mediante la sefial de salida SDI/HDMI.
Ajustes de control

del dispositivo

externo conectado

Down Down Converter Ajusta el modo de salida (aspecto) de las sefiales SD.
Converter Edge Crop / Letter Box / Edge Crop: corta los lados de la imagen de 16:9 para emitirla
Modo de Squeeze como una imagen de 4:3.

funcionamiento de Letter Box: enmascara las zonas superior e inferior de la
conversor imagen de 4:3 y muestra una imagen de 16:9 en el centro
descendente de la pantalla.

Squeeze: reduce horizontalmente la imagen de 16:9 para
emitirla como una imagen de 4:3.

Menu LCD/VF

LCD/VF

Elemento Subelementos y ajustes

Descripcion

LCD Setting
Ajustes de la
pantalla LCD

Brightness
De 99 a +99 (+0)

Ajusta el brillo de la pantalla LCD.

VF Setting Brightness Ajusta el brillo de la imagen del visor.
Ajustes del visor De -99 a +99 (x0)
Color Mode Selecciona el modo de visualizacion del visor en modo E-E/
Color / B&W grabacién.
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LCD/VF

Elemento Subelementos y ajustes Descripcion
Peaking Setting Activa y desactiva la funcién de nitidez.
Ajustes de nitidez On/ Off
Type Selecciona el tipo de nitidez.
Normal / Color Normal: nitidez normal

Color: nitidez del color

Normal Peaking Frequency
Normal / High

Selecciona la frecuencia de nitidez estandar (Normal) o la
frecuencia de nitidez elevada (High).

Normal Peaking Level
De 0299 (50)

Ajusta el nivel de nitidez normal.

Color
B&W /Red / Yellow / Blue

Selecciona el color de la sefial de nitidez de color.

Color Peaking Level
De 0a 99 (50)

Ajusta el nivel de nitidez de color.

Marker
Ajustes de
visualizacién de
marcadores

Setting Activa y desactiva la visualizacion de todos los marcadores.
On / Off
Color Selecciona el color de visualizacién de los marcadores.
White / Yellow / Cyan / Green
/ Magenta / Red / Blue
Center Marker Activa y desactiva el marcador central.
1/2/374/Off
Safety Zone Activa y desactiva el marcador de la zona de seguridad.
On / Off
Safety Area Selecciona el tamafo del marcador de la zona de seguridad
80% /90% / 92.5% / 95% (como un porcentaje del tamaiio total de la pantalla).
Aspect Marker Selecciona el marcador de aspecto.
Line / Mask / Off Line: muestra las lineas blancas.
Mask: muestra un nivel mds bajo de la sefial de video para las
zonas situadas fuera del drea del marcador.
Off: no se muestra.
Aspect Mask Selecciona el brillo de la imagen situada fuera del marcador de
DeOal5(12) aspecto cuando Aspect Marker estd ajustado en Mask.
Aspect Safety Zone Activa y desactiva el marcador de la zona de seguridad de
On / Off aspecto.

Aspect Safety Area
80% /90% / 92.5% 1 95%

Selecciona el tamafio del marcador de la zona de seguridad de
aspecto (como un porcentaje del tamafio total de la pantalla).

Aspect Select
4:3/13:9/14:9/15:9/
16:9/17:9/1.66:1/1.85:1/
2.35:1/2.4:1

Selecciona la relacién del marcador de aspecto.

Guide Frame

Activa y desactiva la visualizacién del fotograma de la

On / Off imagen.

100% Marker Activa y desactiva el marcador de la zona de seguridad 100%.
On / Off

User Box Activa y desactiva la visualizacién del cursor de cuadro.
On / Off

User Box Width Ajusta la amplitud del cursor de cuadro (distancia del centro a
De 40 a 999 (500) los bordes derecho e izquierdo).

User Box Height Ajusta la altura del cursor de cuadro (distancia del centro a los
De 70 a 999 (500) bordes superior e inferior).
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LCD/VF

Elemento Subelementos y ajustes Descripcion
User Box H Position Ajusta la posicién horizontal del centro del cursor de cuadro.
De —479 a +479 (x0)
User Box V Position Ajusta la posicién vertical del centro del cursor de cuadro.
De —464 a +464 (+0)
Zebra Setting Activa y desactiva la funcién de cebra.
Ajustes de los On/ Off
patrones de cebra  Zehra Select Selecciona el tipo de patrén de cebra (Zebral, Zebra2, Both).
1/2/Both

Zebral Level
De 0% a 107% (70%)

Establece el nivel de visualizacién de Zebral.

Zebral Aperture Level
De 1% a20% (10%)

Establece el nivel de apertura de Zebral.

Zebra2 Level Establece el nivel de visualizacién de Zebra2.
De 0% a 109% (100%)
Gamma Setting Selecciona los ajustes de la funcién de asistencia de la
Display Assist HLG—709 (800%) / Off visualizacién de gamma.

Ajustes de la
asistencia de la
visualizacién de
gamma

Display On/Off

Ajustes de los

Network Status
On / Off

elementos de la
pantalla

Rec/Play Status
On / Off

Tally
On / Off

Battery Remain
On / Off

Focus Mode
On / Off

Focus Position
Meter / Feet / Off

Focus Macro
On / Off

Face Detection Frame
On / Off

Lens Info
Meter / Feet / Off

Rec Format
On / Off

Frame Rate
On / Off

Zoom Position
Number / Bar / Off

Digital Extender
On / Off

GPS
On / Off

Selecciona los elementos a visualizar en la pantalla LCD/del
visor.
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LCD/VF

Elemento Subelementos y ajustes Descripcion

SteadyShot
On / Off

Gamma
On / Off

SDI/HDMI Rec Control
On / Off

Gamma Display Assist
On / Off

Proxy Status
On / Off

Focus Assist Indicator
On / Off

Focus Assist Area
On / Off

Media Status
On / Off

Video Signal Monitor
Off / Waveform / Vector /
Histogram

Clip Name
On / Off

White Balance
On / Off

Scene File
On / Off

Auto Exposure Mode
On / Off

Auto Exposure Level
On / Off
Timecode
On / Off
ND Filter
On / Off
Iris
On / Off
Gain
On / Off
Shutter
On / Off
Audio Level Meter
On / Off
Video Level Warning
On / Off
Clip Number
On / Off

Notice Message
On / Off
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Menti TC/UB

TC/UB

Elemento Subelementos y ajustes Descripcion
Timecode Mode Ajusta el modo de ejecucién del cédigo de tiempo.
Ajustes de cédigo Preset / Regen / Clock Preset: inicia el c6digo de tiempo desde el valor especificado.
de tiempo Regen (regeneracion): inicia el c6digo de tiempo continuando
desde el c6digo de tiempo del clip anterior.
Clock: utiliza el reloj interno como cédigo de tiempo.
Run Rec Run: funciona solo durante la grabacion.
Rec Run / Free Run Free Run: funciona siempre, independientemente del
funcionamiento de la videocamara.
Setting Ajusta el cédigo de tiempo en un valor arbitrario.
SET: ajusta el valor.
Reset Restablece el valor del cédigo de tiempo a 00:00:00:00.
Execute / Cancel Execute: ejecuta la funcién.
TC Format Ajusta el formato del cédigo de tiempo.
DF / NDF DF: Omision de fotograma
NDF: No omisién de fotograma
Users Bit Mode Ajusta el modo de bit de usuario.
Configuracién de Fix / Time Fix: utiliza un valor fijo arbitrario en bits de usuario.
bits de usuario Time: utiliza la fecha y la hora actuales en bits de usuario.
Setting Ajusta los bits de usuario en un valor arbitrario.
HDMI TC Out  Setting Ajusta si enviar la salida del codigo de tiempo a dispositivos
Ajustes de salida On / Off con otros objetivos, mediante HDMI.
de codigo de
tiempo

Menii Recording

Descripcion

Activa/desactiva el modo Slow & Quick motion.

Elemento Subelementos y ajustes
S&Q Motion Setting

Ajustes del modo On / Off

de movimiento Frame Rate

lento y rdpido De 1 fps a 60 fps

Ajusta la velocidad de fotogramas durante la toma con la
funcién Slow & Quick motion cuando S&Q estd ajustado en
On.

Los ajustes disponibles dependen de la frecuencia del sistema,
el cédec y el formato de video seleccionados.
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Elemento Subelementos y ajustes Descripcion

Interval Rec Setting Activa y desactiva el modo de grabacién a intervalos.
Ajustes del modo On/ Off

de grabacion a Interval Time Selecciona el intervalo entre grabaciones en el modo Interval
intervalos 1sec/2sec/3sec/4sec/5sec/ Rec (cuando Interval Rec estd ajustado en On).

6sec / Tsec / 8sec / 9sec / 10sec
/ 15sec / 20sec / 30sec / 40sec /
50sec / Imin / 2min / 3min /
4min / 5min / 6min / 7min /
8min /9min / 10min / 15min /
20min / 30min / 40min / 50min
/ Thour / 2hour / 3hour / 4hour /
6hour / 12hour / 24hour

Number of Frames Ajusta el nimero de fotogramas que se desea grabar por toma
Los ajustes varian en funcién  en el modo Interval Rec (cuando Interval Rec estd ajustado en
del ajuste de frecuencia del On).
sistema.

2frames / 6frames / 12frames Cuando la velocidad de fotogramas del formato de grabacién

es 50P 0 59.94P.
1frame / 3frames / 6frames /  Cuando la velocidad de fotogramas del formato de grabacién
9frames no es S0P ni 59.94P.
Pre-Lighting Ajusta el nimero de segundos que se enciende la luz de video
Off / 2sec / 5sec / 10sec antes del inicio de la filmacién Interval Rec. Seleccione Off si

no desea que se encienda la luz de video.

Picture Cache Setting Activa y desactiva el modo de grabacién de memoria

Rec On/ Off intermedia.

Ajustes del modo  Cache Rec Time Ajusta la hora de acumulacion de las imdgenes en la memoria
de grabaci6n de Los ajustes varian en funcién  intermedia de imdgenes (hora de grabacién de memoria
memoria del ajuste del formato de intermedia de imdgenes).

intermedia grabacion.

Clip Setting Activa y desactiva el modo de grabacion continua de clips.
Continuous On / Off

Rec Find Mode Selecciona la operacién cuando se pulsan el botén NEXT o el
Ajustes del modo Clip / Rec Start botén PREV.

de grabacién
continua de clips

Simul Rec Setting Activa y desactiva el modo de grabacién simultdnea y ajusta el
Ajustes del modo On / Off soporte de destino.

d? grabacién Rec Button Set Asigna los botones de grabacion utilizados para controlar cada
simultdnea Rec Button:| A | [ B | soporie de grabacién.

Handle Rec Button:| A )|
/ Rec Button:
Handle Rec Button: /
Rec Button: Handle Rec
Button:
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Elemento Subelementos y ajustes Descripcion
Proxy Rec Setting Activa y desactiva el modo de grabacion de proxy.
Ajustes del modo On/ Off
de grabaciénde  proxy Format Ajusta el tamafio de la imagen del archivo proxy.
proxy 1920x1080(9Mbps) / Al establecer 1920x1080(9Mbps) y la frecuencia de sistema
1280x720(9Mbps) / en 23.98, la grabacién utiliza el escaneo progresivo. En el caso
1280x720(6Mbps) / de que sean frecuencias de sistema distintas a 23.98, la
640x360(3Mbps) / grabacion utiliza el escaneo entrelazado.
480x270(1Mbps) / Para configuraciones distintas de 1920x1080(9Mbps), la
480x270(0.5Mbps) grabacion siempre utiliza el escaneo progresivo,
independientemente de la frecuencia del sistema.
Audio Channel Selecciona el canal de audio en el que se grabaran los datos de
CH1/CH2 / CH3/CH4 Proxy.
Rec Review Setting Selecciona la hora de reproduccion de los clips recién

Ajustes de la
revisién de la
grabacion

3sec / 10sec / Clip

grabados para revisar la grabacién.

Meni Thumbnail

Thumbnail

Elemento Subelementos y ajustes Descripcion
Display Clip Muestra la pantalla de propiedades de visualizacién de clips.
Properties

Display clip
properties screen

Lock/Unlock
Clip

Ajustes de
proteccion de los
clips

Select Clip

Selecciona y bloque/desbloquea un clip.

Lock All Clips

Bloquea todos los clips.

Unlock All Clips

Desbloquea todos los clips.

Delete Clip Select Clip Elimina el clip seleccionado.

Elimina un clip All Clips Elimina todos los clips mostrados.

Copy Clip Select Clip Copia los clips seleccionados.

Copia los clips All Clips Copia todos los clips del soporte.

Thumbnail Essence Mark Thumbnail Muestra las imdgenes en miniatura de fotogramas con
View All / Rec Start marcadores de inicio de grabacién.

Ajustes de la Clip Thumbnail Muestra las imdgenes en miniatura de clips grabados.
pantalla de

imégenes en

miniatura

Customize Thumbnail Caption Cambia la informacién mostrada debajo de las imdgenes en
View Date Time / Time Code / miniatura.

Ajustes de la
pantalla de
imdgenes en
miniatura de las
imégenes fijas

Duration / Sequential Number
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Menu Media

El mend Media no estd disponible cuando no se han cargado soportes.

Media

Elemento Subelementos y ajustes Descripcion

Update Media Media(A) Actualiza el archivo de gestién de la tarjeta de memoria

Actualiza los Execute / Cancel situada en la ranura A.

soportes Media(B) Actualiza el archivo de gestién de la tarjeta de memoria
Execute / Cancel situada en la ranura B.

Format Media Media(A) Formatea la tarjeta de memoria situada en la ranura A.

Formatea los Execute / Cancel Execute: ejecuta la funcion.

soportes Media(B) Formatea la tarjeta de memoria situada en la ranura B.
Execute / Cancel Execute: ejecuta la funcién.

Utility SD/MS Formatea el soporte situado en la ranura UTILITY SD/MS.

Execute / Cancel Execute: ejecuta la funcién.

USB Select Folder Selecciona una carpeta en el soporte USB.

Ajustes Crea una nueva carpeta en el soporte USB.

relacionados con la
copia de clips en
un soporte USB
desde el soporte de
grabacién
insertado en una
ranura para tarjetas
de memoria.

View Clip List

Muestra una lista de clips en el soporte USB.

Rename Folder

Cambia el nombre de una carpeta en el soporte USB.

Error Check Selecciona si se realizard una comprobacién de errores al
On / Off copiar los clips en el soporte USB.

Format USB Formatea (inicializa) el soporte USB.
Execute / Cancel Execute: ejecuta la funcién.

Copy to USB Selecciona la ranura de destino al copiar clips desde una

Media(A) to USB / Media(B) ranura para tarjetas de memoria en una carpeta del soporte
to USB / Media(A)(B) to USB  USB.

Media Remain Muestra el espacio disponible restante en el soporte USB (solo

pantalla).
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Elemento Subelementos y ajustes

Descripcion

Clip Naming  Title Prefix

Ajustes nnn_ (nnn son los 3 dltimos
relacionados con el digitos del niimero de serie)
nombre y la (Visualizacién de un méaximo
eliminacién de los de 7 digitos)

clips

Muestra la pantalla Edit File Name para ajustar la parte del
titulo (entre 4 y 46 caracteres) de los nombres de los clips.

Estructura de la pantalla Edit File Name
Area de seleccion de caracteres (3 lineas):
Selecciona los caracteres que se van a introducir en la
posicién del cursor del drea Title Prefix.
1#$%()+.-.;=@[ 1"_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
Area de funcionamiento del cursor (1 linea):
Espacio: introduce un espacio en la posicién del cursor.
<«—: mueve el cursor hacia la izquierda.
—: mueve el cursor hacia la derecha.
BS: elimina el carécter situado a la izquierda del cursor.
Area Title Prefix (1 linea):
Area para introducir el titulo.

Para establecer el titulo

1 Seleccione el cardcter que desea insertar en la posicién del
cursor en el drea Title Prefix desde el drea de seleccion de
caracteres con el botén 4/%/</® y pulse el dial SEL/SET.
(Se inserta el cardcter seleccionado y el cursor se mueve
hacia la derecha).

2 Repita el paso 1 para establecer el titulo. (Utilice BS segtin
sea necesario.)

3 Tras establecer el titulo, seleccione Done para cerrar la
pantalla Edit File Name.

Number Set
De 0001 a 9999

Establece el sufijo formado por un nimero de 4 digitos del
nombre del clip.

Menti File

Elemento Subelementos y ajustes Descripcion
User File Load Utility SD/MS Carga un archivo de usuario desde una tarjeta SD o un soporte
Ajustes del Execute / Cancel “Memory Stick”.
funcionamiento Execute: ejecuta la funcién.
del ar_chivo de Save Utility SD/MS Guarda un archivo de usuario en una tarjeta SD o0 un soporte
usuario Execute / Cancel “Memory Stick”.
Execute: ejecuta la funcién.
File ID Muestra una pantalla para editar el identificador de archivo de

los archivos de usuario.

Load Customize Data

Establece si desea cargar la informacién personalizada del

On / Off mend User al ejecutar Load Utility SD/MS.
Load White Data Establece si desea cargar la informacion del balance de
On / Off blancos al ejecutar Load Utility SD/MS.
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Elemento Subelementos y ajustes

Descripcion

All File Load Utility SD/MS
Ajustes para ALL Execute / Cancel
file

Carga un archivo ALL desde una tarjeta SD o un soporte
“Memory Stick”.
Execute: ejecuta la funcion.

Save Utility SD/MS
Execute / Cancel

Guarda un archivo ALL en una tarjeta SD o un soporte
“Memory Stick”.
Execute: ejecuta la funcién.

File ID

Muestra una pantalla para editar el identificador de archivo de
los archivos ALL.

Load Network Data

Establece si desea cargar la informacion de los ajustes del

On / Off menu Network al ejecutar Load Utility SD/MS.
Scene File Recall Internal Memory Carga un archivo de escena desde la memoria interna.
Ajustes de Execute / Cancel Execute: ejecuta la funcion.

archivos de escena  Store Internal Memory
Execute / Cancel

Guarda un archivo de escena en la memoria interna.
Execute: ejecuta la funcién.

Load Utility SD/MS
Execute / Cancel

Carga un archivo de escena desde una tarjeta SD o un soporte
“Memory Stick”.

Save Utility SD/MS
Execute / Cancel

Guarda un archivo de escena en una tarjeta SD o un soporte
“Memory Stick”.

File ID

Muestra una pantalla para editar el identificador de archivo de
los archivos de escena.

Scene White Data

Ajusta si se deben aplicar los datos de balance de blancos

On / Off cuando se cargan archivos de escena.
Menu Network
Elemento Subelementos y ajustes Descripcion
Access User Name Establece el nombre del usuario para la autenticacién de
Authentication acceso.
Ajustes de Password Establece la contrasefia para la autenticacion de acceso.
autenticacion
Wireless LAN  Setting Selecciona el modo de funcionamiento de la conexién LAN
Ajustes de Access Point Mode / Station inaldmbrica.
conexién LAN Mode / Off
inaldmbrica WPS Establece una conexién mediante WPS (configuracién Wi-Fi

Execute / Cancel

segura).
Execute: ejecuta la funcion.

NFC
Execute / Cancel

Establece una conexion mediante NFC (comunicacién de
campo cercano).
Execute: ejecuta la funcién.

MAC Address

Muestra la direccién MAC de la interfaz LAN inaldmbrica de
la videocdmara (solo pantalla).
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Network

Elemento Subelementos y ajustes Descripcion

AP Mode Channel Ajusta el canal LAN inalambrico.

Settings Auto(5GHz) / Auto / CH1/  Auto(5GHz) estd disponible solo en la PXW-Z190V.
Ajustes de CH2/CH3/CH4/CH5/ CH6

conexién del modo /CH7/CH8/CH9/CHI0/
de punto de acceso ~ CHI11

Camera SSID & Password

Muestra el SSID y la contrasefia de la videocdmara.

Regenerate Password
Execute / Cancel

Crea una nueva contrasefa.
Execute: ejecuta la funcién.

IP Address Muestra la direccién IP de la videocdmara en el modo de
punto de acceso.
Subnet Mask Muestra la mdscara de subred de la videocdmara en el modo
de punto de acceso.
ST Mode Camera Remote Control Establece si se habilita el control remoto desde un dispositivo
Settings Enable / Disable conectado a la videocdmara mediante LAN inaldmbrica en el

Ajustes de

modo de estacion.

conexién del modo  Connected Network

Muestra la red LAN inaldmbrica conectada (punto de acceso).

de estacién
Scan Networks

Detecta las redes LAN inaldmbricas (puntos de acceso) y
muestra una lista.

Seleccione un destino de entre las opciones de la lista para la
realizar la conexién.

Manual Register

Registra los ajustes para la conexién manual a un punto de
acceso.

SSID Introduzca el SSID del destino que se va a conectar.
Security Introduzca el tipo de seguridad del destino que se va a
None / WEP / WPA conectar. Seleccione WPA si el tipo de seguridad del punto de
acceso de destino es WPA o WPA2.
Password Cuando Security no se establece en None, introduzca la
contrasefia del punto de acceso que se va a conectar.
DHCP Activa y desactiva DHCP.
On/ Off
IP Address Introduzca la direccién IP de la videocdmara cuando DHCP
esté ajustado en Off.
Subnet Mask Introduzca la mdscara de subred de la videocdmara cuando
DHCP esté ajustado en Off.
Gateway Introduzca la puerta de enlace predeterminada de la
videocdmara cuando DHCP esté ajustado en Off.
DNS Auto Activa y desactiva la adquisicién automatica de DNS.
On/ Off

Primary DNS Server

Introduzca el servidor principal de DNS cuando DNS Auto
esté ajustado en Off.

Secondary DNS Server

Introduzca el servidor secundario de DNS cuando DNS Auto
esté ajustado en Off.

Network Reset Reset
Execute / Cancel

Restablece los ajustes de red.
Execute: ejecuta la funcién.
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Meni System

Elemento Subelementos y ajustes Descripcion
Base Setting  Shooting Mode Selecciona el modo de rango dindmico.
Ajustes del modo SDR/HDR
de filmacién
Rec Format Frequency Selecciona la frecuencia del sistema.
Ajustes de formato 59.94/50/29.97/25/23.98
de grabacion (Area NTSC: 59.94,
drea PAL: 50)
Codec Ajusta el modo de grabacién/reproduccion.
XAVC-L /DVCAM(MXF)
Video Format Ajusta el formato de grabacién.
Los ajustes disponibles SET: ajusta la funcién.

dependen de la configuracién
de Frequency y Codec.

Sistema de  Frequency  Codec Opciones de seleccion
archivos

exFAT 59.94 XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

DVCAM(MXEF) 720x480i

50 XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35
1920x1080i 50
1920x1080i 35
1920x1080i 25
1280x720P 50

DVCAM(MXF) 720x576i

29.97 XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

25 XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

23.98 XAVC-L 3840x2160P
1920x1080P 50
1920x1080P 35

Aspect Ratio (SD) Ajusta la relacion de aspecto de la grabacion DVCAM.
16:9/4:3
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Elemento Subelementos y ajustes Descripcion
Assignable De <1>a <8> Asigna funciones a los botones asignables.
Button Off / Push AF/Push MF / Face Push AF/Push MF: ejecuta la funcién de enfoque automatico

Ajustes de la
asignacién de la
funcién de los
botones asignables

Detection AF / Focus Macro /
Auto ND Filter / Push Auto ND
/ Push Auto Iris / Turbo Gain /
AGC/ Shutter / Auto Exposure
Level / Spotlight / Backlight /
Flash Band Reduce / Digital
Extender x2 / Handle Zoom /
SteadyShot / Color Bars /
Preset White Select / ATW /
ATW Hold / Marker / Zebra /
Peaking / Video Signal Monitor
/ Focus Magnifier / Lens Info /
LCD/VF Adjust/ VF Mode /
Gamma Display Assist /
Display / Rec / S&Q Motion /
Clip Continuous Rec / Picture
Cache Rec / Proxy Rec Start/
Stop / Rec Review / Last Clip
Delete / Thumbnail / NFC /
Direct Menu / User Menu /
Menu

mediante una pulsacién o la funcién de enfoque manual
mediante una pulsacion.

Face Detection AF: activa y desactiva la funcién de enfoque
automatico de deteccion de caras.

Focus Macro: activa y desactiva el modo macro.

Auto ND Filter: activa/desactiva la funcién Auto ND Filter.

Push Auto ND: ejecuta temporalmente la funcién Auto ND
Filter.

Push Auto Iris: ejecuta la funcién de iris automdtico mediante
una pulsacion.

Turbo Gain: activa y desactiva Turbo Gain.

AGC: cambia la funcién de control automdtico de ganancia.

Shutter: alterna entre el obturador automadtico y el obturador
manual.

Auto Exposure Level: ajusta el nivel de exposicién
automatica.

Spotlight: cambia el modo de exposicion automadtica a
Spotlight.

Backlight: cambia el modo de exposicion automadtica a
Backlight.

Flash Band Reduce: activa y desactiva la funcién de
correccion de la luz intensa.

Digital Extender x2: activa y desactiva la funcién de aumento
de la pantalla (x2).

Handle Zoom: cambia el funcionamiento del zoom del asa.

SteadyShot: cambia la funcién de estabilizacion de la imagen.

Color Bars: activa/desactiva las barras de color.

Preset White Select: cambia el valor del modo predeterminado
del balance de blancos.

ATW: activa y desactiva ATW.

ATW Hold: retiene el funcionamiento de ATW
temporalmente.

Marker: activa y desactiva la funcién de marcador.

Zebra: activa y desactiva la funcién de cebra.

Peaking: activa y desactiva la funcién de nitidez.

Video Signal Monitor: cambia la sefial de video (como el
histograma).

Focus Magnifier: activa y desactiva la funcién de ampliacion
de enfoque.

Lens Info: cambia el indicador de profundidad de campo.

LCD/VF Adjust: muestra las barras de nivel para el ajuste del
brillo de la pantalla LCD/del visor.

VF Mode: alterna entre la visualizacién en color y en blanco y
negro en el visor.

Gamma Display Assist: cambia la funcién de asistencia de
visualizacién de gamma.

Display: activa y desactiva los indicadores de la pantalla del
monitor.

Rec: inicia y detiene la grabacion.

S&Q Motion: activa y desactiva el modo Slow & Quick
Motion y muestra la pantalla de configuracién de la
velocidad de fotogramas.
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Elemento Subelementos y ajustes Descripcion
Assignable Clip Continuous Rec: activa y desactiva el modo de grabacién
Button continua de clips.

Ajustes de la
asignacion de la
funcién de los

botones asignables

Picture Cache Rec: activa y desactiva el modo de grabacién
de memoria intermedia de imdgenes.

Proxy Rec Start/Stop: inicia y detiene la grabacion de proxy
independiente.

Rec Review: inicia la revision de la grabacion.

Last Clip Delete: ejecuta la funcién de eliminacién del dltimo
clip (repetir).

Thumbnail: activa y desactiva la visualizacién de la pantalla
de imédgenes en miniaturas.

NEFC: ejecuta la funcién NFC.

Direct Menu: muestra el mend directo.

User Menu: muestra el menu User.

Menu: muestra el ment de configuracion.

Tally Front Enciende y apaga el indicador de grabacién/ldmpara
Ajustes de la On / Off indicadora (frontal).
%ém'para Rear Enciende y apaga el indicador de grabacion/lampara
indicadora/ On / Off indicadora (trasero).
indicador de
grabacion
Language Select Ajusta el idioma de visualizacion.
Ajustes de idioma SET: ajusta la funcién.
Clock Set Time Zone Ajusta la diferencia horaria desde UTC en intervalos de
Ajustes del reloj De las —12:00 UTC a las 30 minutos.
interno +14:00 UTC
Date Mode Selecciona el formato de visualizacion de la fecha.
YYMMDD / MMDDYY / YYMMDD: aiio, mes, dia
DDMMYY MMDDYY: mes, dia, afio
DDMMYYY: dia, mes, afio
12H/24H Ajusta el formato de visualizacion del reloj.
12H /24H 12H: modo de 12 hora
24H: modo de 24 hora
Date Ajusta la fecha actual.
SET: Ajustar el valor.
Time Ajusta la hora actual.
SET: Ajustar el valor.
Hours Meter Hours(System) Muestra el nimero de horas acumuladas de uso (no se puede
Ajustes del restablecer).
medidor de horas  Hours(Reset) Muestra el nimero de horas acumuladas de uso (se puede
restablecer).
Reset Restablece la visualizacién de Hours(Reset) a 0.
Execute / Cancel Execute: ejecuta la funcién.
GPS GPS Activa y desactiva la funcién GPS.
Ajustes de GPS On/ Off
Battery Alarm Low Battery Ajusta el nivel de bateria restante a partir del cual se mostrard

Ajustes de la
alarma de tensién
baja en la bateria

5% /10% / 15% / .../ 45% /
50%

una alarma de tensién baja en la baterfa (saltos de 5%).

Battery Empty
De 3% a 7%

Ajusta el nivel de baterfa restante a partir del cual se mostrara
una alarma de bateria agotada (intervalos de 1%).
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Elemento Subelementos y ajustes Descripcion
DC Voltage DC Low Voltagel Ajusta la tensién a partir de la cual se mostrard una alarma de
Alarm 11.2V a 14.0V (11.3V) tensién baja de la entrada DC IN (intervalos de 0,1V).

Ajustes de la
alarma de tensién
baja de la entrada
DCIN

DC Low Voltage2
11.0V a 14.0V

Ajusta la tensién a partir de la cual se mostrard una alarma de
subtension de la entrada DC IN (intervalos de 0,1V).

Menu Settings Direct Menu with <SET>
Ajustes del mend On / Off

Ajusta si se inicia el funcionamiento del menu directo
pulsando el botén SET.

¢ Cuando estd ajustado en On, la deteccion de las caras
registradas mediante la funcién de enfoque automético de
deteccion de caras no estd disponible. Ademds, se borra la
cara registrada actualmente.

User Menu Only
On / Off

Ajusta si solo se muestra el ment User (On) o si se muestra la
lista del ment (Off) cuando la videocdmara muestre el mend.

User Menu with Lock
On / Off

Ajusta si se bloquea la pantalla del ment y se muestra solo el
mend User.

Este elemento no se muestra durante el funcionamiento
normal de la pantalla del mend. Para obtener mds
informacién acerca del funcionamiento de la pantalla del
mend, consulte pdgina 68.

Fan Control
Ajustes del control
del ventilador

Setting
Auto / Minimum / Off in Rec

Selecciona el modo de control del ventilador.

All Reset Reset Restaura la configuracién de fabrica de la videocdmara.
Restablecimiento Execute / Cancel Execute: ejecuta la funcién.
de los ajustes Reset without Network Restablece los ajustes predeterminados del mend, con
predeterminados Execute / Cancel excepcion de los ajustes del mend Network.

Execute: ejecuta la funcién.
Version Version Number Muestra la versién del software del camcorder.
Visualizacién de la X.XX
versién de la Version Up Actualiza el camcorder.*

videocdmara Execute / Cancel

Execute: ejecuta la funcién.
* Esta funcién actualiza el software de la videocdmara.
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Notas importantes sobre el funcionamiento

Utilizacion de la videocamara en
el extranjero

Suministro de alimentacidn

Puede utilizar su videocdmara en cualquier pais o
region con el cargador BC-U1A (suministrado) o
el cargador opcional BC-U2A dentro de un rango
de CA de 100 V a 240 V 50 Hz/60 Hz.

Funcidn de correccién del huso horario
Cuando esté en el extranjero, ajuste Clock Set
>Time Zone (pdgina 96), en el mend System.

Utilizacidon y almacenamiento

No someta la unidad a golpes fuertes
El mecanismo interno se puede dafiar y el cuerpo
de la cdmara se puede deformar.

No cubra la unidad durante el funcionamiento
Por ejemplo, si se coloca una tela sobre la unidad

puede acumularse un calor excesivo en el interior.

Después de su uso

Ajuste siempre el interruptor ON/STANDBY en
STANDBY antes de desconectar el suministro de
alimentacion.

Antes de guardar la unidad durante un periodo
prolongado
Extraiga la bateria.

No deje la videocamara con los objetivos
apuntando hacia el sol

La luz solar directa puede entrar a través de los
objetivos, concentrarse en la videocdmara y
producir un incendio.

No exponga el objetivo a rayos, como los rayos
laser

Esto puede dafiar el sensor de imagen y provocar
un fallo de funcionamiento de la cdmara.

Transporte

« Extraiga las tarjetas de memoria antes de
transportar la unidad.

« Si se envia la unidad por carretera, mar, aire u
otro servicio de transporte, hdgalo en el
embalaje original de la unidad.
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Acerca de la bateria

Para cargar la bateria
* Asegtirese de cargar la bateria antes de empezar
a utilizar la videocdmara.

Para utilizar con eficacia la bateria

* El rendimiento de la bateria se reduce cuando la

temperatura ambiente es de 10 °C o inferior, por

lo que el tiempo de utilizacién de la bateria
disminuye. En ese caso, siga una de las
siguientes recomendaciones para poder utilizar
la bateria durante mds tiempo.

—Coloque la bateria en un bolsillo para
calentarla e instdlela en la videocdmara justo
antes de comenzar a filmar.

—Utilice una bateria de alta capacidad.

Asegtirese de situar el interruptor ON/

STANDBY en STANDBY cuando no esté

grabando o reproduciendo con la videocamara.

La bateria también se consume cuando la

videocdmara se encuentra en modo de espera de

grabacion o en modo de pausa de reproduccion.
Tenga listas baterias de repuesto para dos o tres
veces el tiempo de grabacién previsto y haga

pruebas antes de la grabacion real.
No exponga la bateria al agua. La bateria no es
resistente al agua.

Acerca del almacenamiento de la bateria

* Si no se utiliza la baterfa durante un tiempo
prolongado, cargue la baterfa completamente y
agotela con la videocdmara una vez al aio para
mantener un correcto funcionamiento. Para
almacenar la bateria, extrdigala de la
videocdmara y coldquela en un lugar seco y
fresco.

Para descargar completamente la bateria de la
videocdmara, deje la videocamara en modo de

espera de grabacion hasta que se desconecte la
alimentacion (pdgina 17).

Acerca de la vida itil de la bateria

* La capacidad de la baterfa disminuye a lo largo
del tiempo cuando se usa repetidas veces. Si el
tiempo de uso entre cargas disminuye de un
modo notable, significa que probablemente es
hora de reemplazar la bateria.



¢ La vidatil de cada bateria depende del entorno
de almacenamiento, de funcionamiento y de las
condiciones medioambientales.

Acerca de la carga de la bateria
« Utilice tinicamente el cargador (suministrado)
para cargar las baterias designadas. Si carga
otros tipos de bateria, es posible que estas
sufran fugas, se calienten, exploten o produzcan
una descarga eléctrica que ocasione
quemaduras o lesiones.
« Extraiga la bateria cargada del cargador.
« Elindicador de carga del cargador suministrado
tiene 2 patrones de parpadeo que funcionan de
la siguiente forma:
Parpadeo rapido...Se enciende y se apaga
rdpidamente a intervalos de aproximadamente
0,15 segundos.
Parpadeo lento...Se enciende y apaga
alternativamente durante 1,5 segundo y se
apaga completamente durante 1,5 segundo
aproximadamente. El indicador repite esta
secuencia.
Si el indicador de carga parpadea rapidamente,
extraiga la bateria que se esté cargando y vuelva
a instalar de nuevo esa misma baterfa. Si el
indicador de carga contintia parpadeando
rapidamente, puede ser que la bateria esté
dafada o que no sea del tipo designado.
Compruebe la bateria para confirmar si es 0 no
del tipo designado. Si es del tipo designado,
extraiga primero la bateria e instale, a
continuacién, una bateria nueva u otra bateria
que esté en buenas condiciones para ver si el
cargador funciona correctamente. Si el cargador
funciona correctamente, puede ser que la
bateria esté dafiada.
Si el indicador de carga parpadea lentamente, el
cargador estard en modo de espera y se habra
detenido la carga. Cuando la temperatura
ambiente estd fuera del rango de temperatura
apropiado para la carga, el cargador detiene
automdticamente la carga y entra en modo de
espera. Cuando la temperatura ambiente vuelve
a ser apropiada, el cargador reiniciala carga y el
indicador de carga se ilumina. Se recomienda
cargar la bateria con una temperatura ambiente
entre 10 °C y 30 °C.
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Acerca de como manipular la
videocamara

Uso y cuidados

* No utilice ni almacene la videocdmara y los

accesorios en los siguientes lugares:

—Cualquier lugar extremadamente cdlido o
frio.

No los deje expuestos a temperaturas
superiores a 60 °C como bajo la luz solar
directa, cerca de calefactores o en un
automovil estacionado bajo el sol. Se pueden
deformar o sufrir fallos de funcionamiento.

—Cerca de campos magnéticos intensos o
vibraciones mecdnicas.

La videocdmara podria sufrir fallos de
funcionamiento.

—Cerca de ondas radiofénicas fuertes o
radiaciones.

Es posible que la videocdmara no pueda
grabar correctamente.

—Cerca de receptores de AM y de equipos de
video.

Es posible que se produzcan ruidos.

—En una playa o cualquier lugar con mucho
polvo.

Si entra arena o polvo en la videocdmara,
pueden causar un fallo de funcionamiento.
En ocasiones, este fallo de funcionamiento
puede resultar irreparable.

—Cerca de ventanas o al aire libre, donde la
pantalla LCD, el visor o el objetivo podrian
estar expuestos a la luz solar directa.

Esto daiiarfa el interior del visor o la pantalla
LCD.

—Cualquier lugar extremadamente himedo.

Para alimentarla con cc o ca utilice los

accesorios recomendados en este manual de

instrucciones.

No permita que la videocdmara se moje; por

ejemplo, bajo la lluvia o por el agua del mar. Si

la videocdmara se moja, podria sufrir fallos de
funcionamiento. En ocasiones, este fallo de
funcionamiento puede resultar irreparable.

Si dentro de la videocdmara entra algtin objeto

o liquido, desconéctela y haga que sea revisada

por un distribuidor de Sony antes de volver a

utilizarla.

* Evite desmontar, modificar o manipular
bruscamente la videocdmara y exponerla a
golpes o impactos como martillazos, caidas o



pisotones. Sea especialmente cuidadoso con el
objetivo.

No utilice baterfas deformadas o dafiadas.
Mantenga el interruptor ON/STANDBY en
STANDBY cuando no utilice la videocdmara.
No utilice la videocdmara envuelta en una
toalla, por ejemplo. Si lo hace, puede
recalentarse internamente.

Cuando desconecte el cable de alimentacion,
tire siempre del enchufe, nunca del cable.
Procure no dafiar el cable de alimentacién al
colocar algtin objeto pesado sobre €l.
Mantenga limpios los contactos metélicos.
Mantenga el mando a distancia inaldimbrico y la
pila tipo botén fuera del alcance de los nifios. En
caso de ingestion de la pila, consulte a un
médico de inmediato.

Si se producen fugas del liquido electrolitico de
la pila,

—pdngase en contacto con un centro de
servicio técnico local autorizado de Sony.
—limpiese con agua cualquier liquido que haya

estado en contacto con su piel.
—si le cae liquido en los ojos, ldveselos con
agua abundante y consulte con un médico.

Cuando no utilice la videocamara durante un

tiempo prolongado

* Encienda la videocdmara y grabe y reproduzca
imédgenes aproximadamente una vez al mes para
mantenerla en un estado 6ptimo durante un
tiempo prolongado.

« Agote la bateria completamente antes de
guardarla.

Condensacion de humedad

Si traslada directamente la videocdmara de un
lugar frio a un lugar célido, se puede crear
condensacion de humedad en su interior y causar
un fallo de funcionamiento en la videocamara.

Si se ha condensado humedad
Deje sin encender la videocdmara durante 1 hora
por lo menos.

Nota sobre la condensacién de humedad

Puede condensarse humedad al trasladar la

videocdmara de un lugar frio a otro cdlido (o

viceversa) o si se utiliza en un lugar himedo

como se muestra a continuacion.

¢ Cuando traslada la videocdmara de una pista de
esqui a un lugar calentado por un equipo de
calefaccion.

* Cuando traslada la videocdmara de un
automovil o una sala con aire acondicionado a
un lugar cdlido al aire libre.

* Cuando utiliza la videocdmara después de una
tormenta o un chaparrén.

* Cuando utiliza la videocimara en un lugar
caluroso y himedo.

Como evitar la condensacion de humedad
Cuando traslade la videocdmara de un lugar frio a
otro célido, métala en una bolsa de pléstico y
séllela bien. Retirela de la bolsa cuando la
temperatura dentro de esta haya alcanzado la
temperatura ambiente (transcurrida 1 hora
aproximadamente).

Pantalla LCD

* No ejerza excesiva presion sobre la pantalla
LCD porque puede daarse.

» Cuando utilice la videocdmara en un lugar frio,
es posible que en la pantalla LCD aparezca una
imagen residual. No se trata de un fallo de
funcionamiento.

* Mientras utiliza la videocdmara, la parte
posterior de la pantalla LCD se puede calentar.
No se trata de un fallo de funcionamiento.

Para limpiar la pantalla LCD

La superficie de la pantalla LCD dispone de un

recubrimiento. Si rasca la superficie, es posible

que pueda retirar el recubrimiento.

Tenga cuidado con los siguientes puntos a la hora

de limpiarla y manipularla.

* Si quedan restos de grasa o crema de manos en
la pantalla, el recubrimiento podra retirarse mas
facilmente. Limpielo rdpidamente.

* El recubrimiento puede rascarse si limpia la
pantalla con un pafiuelo, etc.

* Retire el polvo o la arena con un soplador, etc.
antes de limpiar la suciedad.

« Utilice un pafio suave (un paiio de limpieza de
gafas, etc.) suavemente para limpiar la
suciedad.

Manipulacion de la unidad

* Si la unidad estd sucia, limpie el cuerpo de la
videocdmara con un paiio suave ligeramente
humedecido con agua y, a continuacién, limpie
la unidad con un pafio suave seco.

* No realice ninguna de las acciones siguientes
para evitar dafiar el acabado.

—Usar productos quimicos como diluyentes,
bencina, alcohol, pafios con productos
quimicos, repelentes, insecticidas y pantallas
solares.
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— Utilizar la unidad con las sustancias
mencionadas en las manos.
—Dejar la unidad en contacto con objetos de

goma o vinilo durante un tiempo prolongado.

Cuidado y almacenamiento del objetivo

« Frote la superficie del objetivo con un paiio

suave en los casos siguientes:

—Cuando haya huellas dactilares en la
superficie del objetivo.

—En lugares cdlidos o himedos

—Cuando el objetivo esté expuesto al aire
salado como, por ejemplo, a orillas del mar.

Guadrdelo en un lugar bien ventilado donde no

haya suciedad ni mucho polvo.

Para evitar la apariciéon de moho, limpie el

objetivo periédicamente como se ha descrito

anteriormente.

Carga de la bateria recargable preinstalada

La videocdmara incorpora una bateria recargable
preinstalada para conservar la fecha, la hora y
otros ajustes aunque el interruptor ON/
STANDBY esté situado en STANDBY. La
baterfa recargable preinstalada siempre se carga
mientras la videocdmara estd conectada a la toma
de pared a través del adaptador de alimentacién
de CA o cuando tiene la baterfa insertada. La
bateria recargable quedard totalmente descargada
en aproximadamente 3 MeSES si no se utiliza la
videocdmara en absoluto sin el adaptador de
alimentacién de CA conectado o la bateria
instalada. Utilice la videocdmara después de
cargar la bateria recargable preinstalada.

Sin embargo, aunque no esté cargada, el
funcionamiento de la videocdmara no se vera
afectado, siempre que no se esté grabando la
fecha.

Para evitar interferencias
electromagnéticas de teléfonos
portétiles, dispositivos inalambricos,
etc.

El uso de teléfonos portitiles, dispositivos
inaldmbricos, etc. cerca de esta unidad puede
producir un funcionamiento incorrecto e
interferencias con las sefiales de audio y video.
Se recomienda desconectar estos dispositivos
cuando se encuentren cerca de esta unidad.
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Acerca de la pantalla LCD

* No deje la pantalla LCD expuesta a la luz solar
directa, ya que de esta forma se podria dafiar.

* No empuje ni mueva la pantalla LCD a la
fuerza, ni coloque objetos sobre ella, ya que
podria provocar un fallo de funcionamiento
como por ejemplo irregularidades en la imagen,
etc.

* La pantalla LCD podria calentarse durante su
uso. No se trata de un fallo de funcionamiento.

Acerca de los pixeles muertos

La pantalla LCD/el panel EL orgénico de esta
unidad ha sido fabricado con tecnologia de alta
precision y ofrece un indice de pixeles
funcionales de al menos el 99,99%. Por ello, es
posible que quede una pequefia proporcién de
pixeles “atascados”, o bien siempre apagados
(negro), siempre encendidos (rojo, verde o azul),
o parpadeando. Ademds, a lo largo de un amplio
periodo de tiempo, esos pixeles “atascados”
pueden ir apareciendo espontdneamente debido a
las caracteristicas de la pantalla de cristal liquido
o del panel EL orgédnico. Estos problemas no
representan un fallo de funcionamiento, y no
quedardn registrados en el soporte de grabacion.

Acerca de la pantalla del panel EL
organico

Debido a las caracteristicas fisicas del panel EL
orgdnico, es posible que se muestren imdgenes
fantasma o se visualice un brillo reducido.
Estos problemas no son fallos de funcionamiento,
y el panel EL orgédnico podra utilizarse sin
problemas.

Algunos colores principales pueden hacerse
visibles en el visor si cambia su linea de vision,
pero esto no es un fallo de funcionamiento.
Estos colores no se graban en las tarjetas de
memoria.

Acerca de los consumibles

* El ventilador y la bateria son consumibles que
deben sustituirse periédicamente.
Si utiliza la unidad a temperatura ambiente, el
ciclo de sustitucién normal serd de 5 afios
aproximadamente.
Sin embargo, esto representa solo una directriz
general y no constituye ninguna garantia de su
vida itil. Para obtener mds informacién acerca



de la sustituciéon de componentes, pongase en
contacto con el distribuidor.

La vida til del adaptador de CA y del
condensador electrolitico es de unos 5 afios con
las temperaturas de funcionamiento habituales
y un uso normal (8 horas al dia, 25 dias al mes).
Si el uso supera la frecuencia normal indicada,
es posible que la vida dtil se vea reducida.

La terminal de la bateria de esta unidad (el
conector para paquetes de pilas y adaptadores
de CA) es una parte consumible.

Puede que la unidad no funcione correctamente
si los contactos de las pilas estdn doblados o
deformados debido a algtin golpe o a
vibraciones o si se han corroido debido a un uso
prolongado en el exterior.

Se recomienda realizar inspecciones periddicas
para que la unidad continte funcionando
correctamente y para prolongar su vida util.
Contacte con el servicio de asistencia técnica de
Sony o con el responsable de ventas para
obtener mds informacién sobre las
inspecciones.

Nota sobre la pantalla

¢ La imagen de la pantalla LCD y la pantalla del
visor puede verse distorsionada al realizar las
siguientes operaciones:
— Cambiar el formato de video
—Comenzar la reproduccion desde la pantalla
de imdgenes en miniatura

Fragmentacion de archivos

Si las imdgenes no se pueden grabar/reproducir
correctamente, intente formatear el soporte de
grabacién. Cuando se repite la grabacién/
reproduccion de una imagen con un soporte de
grabacion especifico durante un periodo
prolongado, es posible que los archivos del
soporte se fragmenten, y no se realice
correctamente la grabacién/el almacenamiento.
En ese caso, realice una copia de seguridad de los
clips del soporte y formatee el soporte mediante
Format Media (pdgina 90), en el mend Media.

Notas acerca de la seguridad en Internet

« Utilice la videocdmara tras un cortafuegos
diseniado con seguridad. No conecte la
videocdmara a una red que se pueda conectar a
un dispositivo no fiable.
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* SONY NO SE HACE RESPONSABLE POR
DANOS DE NINGUN TIPO DEBIDOS A LA
OMISION DE LAS MEDIDAS DE
SEGURIDAD ADECUADAS EN
DISPOSITIVOS DE TRANSMISION,
FUGAS DE DATOS INEVITABLES
DERIVADAS DE LAS ESPECIFICACIONES
DE TRANSMISION O PROBLEMAS DE
SEGURIDAD DE CUALQUIER TIPO.

En funcién del entorno operativo, es posible que

terceros no autorizados en la red puedan

acceder a la unidad. Al conectar la unidad a la
red, confirme siempre que la red esta
correctamente protegida.

Es posible que terceros no autorizados situados

cerca de las sefiales puedan interceptar sin

saberlo contenidos de la comunicacion. Al
utilizar la comunicacién LAN inaldmbrica,
aplique medidas de seguridad para proteger los
contenidos de la comunicacion.

Desde el punto de vista de la seguridad, al

utilizar la unidad conectada a la red, se

recomienda encarecidamente acceder a la
ventana de control a través de un navegador
web y modificar la limitacién de acceso de los

valores predeterminados de fabrica (pdgina 92).

Asimismo, se recomienda cambiar la

contrasefia periédicamente.

* No visite otros sitios web con el navegador web
mientras ajuste la configuracion o justo
después. El navegador web recuerda los ajustes
de inicio de sesion, por lo que debe cerrarlo al

completar la configuracion para evitar que
terceros no autorizados utilicen la unidad o
evitar la instalacion de programas maliciosos.

Acerca del GPS

El GPS (Global Positioning System) es un
sistema que calcula la ubicacién geogrifica
mediante satélites espaciales muy precisos de EE.
UU. Con este sistema se puede localizar su
ubicacion exacta en la Tierra.

Los satélites GPS estan situados en 6 orbitas, a
20000 km sobre la Tierra. El sistema GPS se
compone de 24 o mas satélites GPS. El receptor
GPS recibe sefales de radio de los satélites y
calcula la ubicacion actual a partir de la
informacidn orbital (datos de almanaque) y el
tiempo que tardan las sefiales en realizar el
recorrido, etc.

La determinacién de una ubicacién se denomina
“triangulacion”. El receptor GPS puede



determinar la latitud y la longitud de la ubicacion
mediante la recepcion de sefiales de 3 o mds
satélites.

* Como las posiciones de los satélites GPS varfan
constantemente, habrd veces que costard mas
tiempo determinar la ubicacién del receptor o
que incluso resultard imposible determinarla;
dependerd de en qué lugar y a qué hora se utilice
la videocdmara.

* El GPS es un sistema que determina la

ubicacion geogréfica triangulando sefales de

radio de satélites GPS. No utilice la
videocdmara en lugares en los que las sefiales de
radio se bloqueen o se reflejen, como por
ejemplo en lugares sombrios rodeados de
edificios o drboles, etc. Utilicela en espacios
abiertos al aire libre.

Es posible que no pueda grabar informacion de

ubicacion en ubicaciones o situaciones en las

que las sefales de radio de los satélites GPS no
lleguen a la cdmara, como las siguientes.

—En tineles, en interiores o a la sombra de los
edificios.

— Entre edificios altos o en calles estrechas
rodeadas de edificios.

—En ubicaciones subterrdneas, ubicaciones
rodeadas de arboles frondosos, o en
ubicaciones en las que se generan campos
magnéticos, p. €j., cerca de cables de alta
tension.

—Cerca de dispositivos que generan sefales de
radio de la misma banda de frecuencia que la
videocdmara: cerca de teléfonos méviles con
una banda de 1,5 GHz, etc.

« Si sube a Internet y comparte las imdgenes que
estdn grabadas con el ajuste de GPS a On, la
informacién de ubicacion podra quedar
expuesta en Internet aunque esa no sea su
intencién. Si no quiere grabar la informacion de
ubicacion, seleccione Off para GPS
(pdgina 96).

Acerca de los errores de triangulacion

« Si se desplaza a otra ubicacion después de
ajustar GPS en On en el mend, es posible que la
cdmara tarde mds tiempo en iniciar la
triangulacion que si se queda en el mismo
punto.

« Error causado por la posicion de los satélites
GPS
La videocdmara triangula automaticamente la
ubicacion actual cuando recibe sefiales de radio

de 3 o mis satélites GPS. El error de
triangulacion que permiten los satélites GPS es
de alrededor de 10 m. Segtin el entorno de la
ubicacion, el error de triangulacién puede ser
mayor. En tal caso, la ubicacidn real podria no
coincidir con la del mapa, que se determina a
partir de la informacion GPS. Ademds, los
satélites GPS estdn bajo el control del
Departamento de Defensa de los Estados
Unidos, que puede cambiar el grado de
precision de forma intencionada.

* Error durante el proceso de triangulacién
Durante la triangulacion, la videocimara
adquiere informacion de ubicacién de forma
periddica.

Restriccidn del uso del GPS

D¢ al GPS el uso que se contempla en las normas

aplicables en la situacién y los paises o regiones

correspondientes.

Acerca del sistema de coordenadas geograficas
Se utiliza el sistema de coordenadas geograficas
“WGS-84".



Formatos de video

Acerca del soporte de grabacion

Soporte de grabacion y formatos compatibles

M Grabacion normal

SDXC
Video Format Clase 10 Clase 10 Clase 10
UHS-1U3 UHS-1U1
XAVC-L exFAT 3840%x2160 @] - -
1920x1080 O O O
1280x720 O O O
DVCAM exFAT O O O
O: compatible
—: incompatible
W Modo S&Q
SDXC
Video Format Clase 10 Clase 10 Clase 10
UHS-1 U3 UHS-1U1
XAVC-L exFAT 3840x2160 O - -
19201080 O @]

O: compatible
—: incompatible

Modos de grabacion especial y formatos compatibles

XAVC-L DVCAM
exFAT

Interval Rec @] -

Clip Continuous Rec O -

Picture Cache Rec O -

Movimiento a cdmara lenta y O -

rdpida

Grabacion simultdnea enlas 2 |O -

ranuras

O: compatible
—: incompatible
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Tiempo de grabacion maximo de un clip

Formato de grabacion Tiempo de grabaciéon continua Tiempo de grabacion maximo
(por soporte) de Relay Rec*

XAVC-L Aproximadamente 6 horas Aproximadamente 13 horas

DVCAM

* Tiempo de grabacién maximo de Relay Rec utilizando un soporte con una grabacién de hasta 6 horas por soporte
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Limitaciones y formatos de salida

Formatos de video y sefiales de salida

Formatos de salida del conector SDI OUT

Ajuste del formato de grabacion Ajuste de la salida SDI |Senal de salida/método de
conversiéon
Rec Format Rec Format >Video |Output Format >SDI, |Seiial de salida

>Frequency, en el

Format, en el ment

en el meni Video

meni System System
59.94 3840x2160P 1920x1080P (Level A) 1920x1080 59.94P Level-A
1920x1080P (Level B) 1920x1080 59.94P Level-B
1920x1080i 1920x1080 59.94i
1920x1080P 1920x1080P (Level A) 1920x1080 59.94P Level-A
1920x1080P (Level B) 1920x1080 59.94P Level-B
1920x1080i 1920x1080 59.94i
720x486i 720x486 59.94i
1920x10801 1920x1080i 1920x1080 59.94i
720x486i 720%x486 59.94i
1280x720P 1280x720P 1280x720 59.94P
720x486i 720%x486 59.94i
720x4861 720x4861 720x486 59.94i
29.97 3840x2160P 1920x1080PsF 1920x1080 29.97PsF
1920x1080P 1920x1080PsF 1920x1080 29.97PsF
720x486i 720%x486 59.94i (PsF)
1280x720P 1280x720P 1280%720 59.94P (2-2RP)
720x486i 720%x486 59.94i (PsF)
23.98 3840x2160P 1920x1080PsF 1920x1080 23.98PsF
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
1920x1080P 1920x1080PsF 1920x1080 23.98PsF
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
720x486i (2-3PD) 720x486 59.94i (2-3PD)
1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)

720x486i (2-3PD)

720x486 59.94i (2-3PD)
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Ajuste del formato de grabacion Ajuste de la salida SDI |Seifial de salida/método de
conversion
Rec Format Rec Format >Video |Output Format >SDI, |Seiial de salida

>Frequency, en el

Format, en el meni

en el menu Video

menu System System
50 3840x2160P 1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x1080i 1920x1080 50i
1920x1080P 1920x1080P (Level A) 1920x1080 50P Level-A
1920x1080P (Level B) 1920x1080 50P Level-B
1920x10801 1920x1080 50i
7205761 720%576 50i
1920x10801 1920x10801 1920x1080 50i
720x576i 720x576 50i
1280x720P 1280x720P 1280x720 50P
720x5761 720x576 50i
720x5761 720x576i 720x576 50i
25 3840x2160P 1920x1080PsF 1920x1080 25PsF
1920x1080P 1920x1080PsF 1920x1080 25PsF
7205761 720576 50i (PsF)
1280x720P 1280x720P 1280x720 50P (2-2RP)
720x576i 720x576 50i (PsF)

Formatos de salida del conector HDMI OUT

Ajuste del formato de grabacion Ajuste de la salida Seiial de salida/método de
HDMI conversiéon
Rec Format Rec Format >Video |Output Format Seiial de salida

>Frequency, en el

Format, en el mend

>HDMI, en el meni

menu System System Video
59.94 3840x2160P 3840x2160P 3840x2160 59.94P
1920x1080P 1920%x1080 59.94P
1920x10801 1920x1080 59.94i
1920x1080P 1920x1080P 1920%x1080 59.94P
1920x1080i 1920x1080 59.94i
720x4801 720x480 59.94i
1920x10801 1920x1080i 1920x1080 59.94i
720%x4801 720%x480 59.941
1280x720P 1280x720P 1280x720 59.94P
720%x4801 720%x480 59.941
720%x4861 720%x4801 720x480 59.941
720x480P 720x480 59.94P
29.97 3840x2160P 3840x2160P 3840x2160 29.97P
1920x1080i 1920x1080 59.94i (PsF)
1920x1080P 1920x10801 1920x1080 59.94i (PsF)
720%x4801 720x480 59.94i (PsF)
1280x720P 1280x720P 1280%720 59.94P (2-2RP)
720x480i 720x480 59.94i (PsF)
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Ajuste del formato de grabacion Ajuste de la salida Seiial de salida/método de
HDMI conversion
Rec Format Rec Format >Video |Output Format Seiial de salida
>Frequency, en el Format, en el meni  |>HDMI, en el meni
menu System System Video
23.98 3840x2160P 3840x2160P 3840x2160 23.98P
1920x1080P 1920%x1080 23.98P
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
1920x1080P 1920x1080P 1920x1080 23.98P
1920x1080i (2-3PD) 1920x1080 59.94i (2-3PD)
720x480i (2-3PD) 720%480 59.94i (2-3PD)
1280x720P 1280x720P (2-3PD) 1280x720 59.94P (2-3PD)
720x480i (2-3PD) 720%480 59.94i (2-3PD)
50 3840x2160P 3840x2160P 3840x2160 50P
1920x1080P 1920x1080 50P
1920x1080i 1920x1080 50i
1920x1080P 1920x1080P 1920x1080 50P
1920x10801 1920x1080 50i
7205761 720x576 50i
1920x1080i 1920x10801 1920x1080 50i
720x576i 720x576 50i
1280x720P 1280x720P 1280x720 50P
720x576i 720x576 50i
720x576i 720x5761 720%576 50i
720x576P 720x576 50P
25 3840x2160P 3840x2160P 3840x2160 25P
1920x1080i 1920x1080 50i (PsF)
1920x1080P 1920x1080i 1920x1080 50i (PsF)
720x576i 720x576 50i (PsF)
1280x720P 1280x720P 1280x720 50P (2-2RP)
720x5761 720x576 50i (PsF)

« Si el tamafio de la imagen del clip de reproduccion es mds pequefio que el tamafio de la imagen configurado mediante
Output Format >SDI o HDMI, en el mend Video, no se emitird la sefial de video desde ese conector.

Limitaciones entre las funciones de grabacion

Meni Recording S&Q Interval Picture Clip Continuous |Simul |Proxy Rec
Motion |Rec Cache Rec |Rec Rec
S&Q Motion - X x X X X
Interval Rec X - X X X x
Picture Cache Rec  |x X - X X X
Clip Continuous Rec |x X X - X @)
Simul Rec X X X X _ X
Proxy Rec X X X e} X _

O: compatible, x: no compatible

108



Resolucion de problemas

Suministro de alimentacion

Sintoma

Causa

Soluciéon

La videocdmara no se
enciende.

La baterfa no esté colocada y no se estd
suministrando alimentacién al
conector DC IN.

Coloque una bateria (pdgina 16) o conecte la
videocdmara a la alimentaciéon de CA con un
adaptador de CA (pdgina 17).

La bateria estd completamente
agotada.

Sustituya la bateria por una bateria cargada por
completo (pdgina 16).

El suministro de
alimentacién se corta
durante el funcionamiento.

La bateria se agota por completo.

Sustituya la bateria por una bateria cargada por
completo (pdgina 16).

La bateria se agota muy
rapido.

La temperatura ambiente es muy baja.

Esto se debe a las caracteristicas de la bateria y
no es un defecto.

No se ha cambiado la bateria de forma
adecuada.

Sustituya la bateria (pdgina 16).

Si la baterfa se agota pronto, incluso después de
haberla cargado por completo, es posible que
haya llegado al final de su vida til. Sustitiyala
por una nueva.

Grabacidn/reproduccion

Sintoma

Causa

Soluciéon

La grabacién no comienza
al pulsar el bot6n de
grabacion.

La tarjeta de memoria estd protegida
contra escritura.

Desprotéjala o sustitiyala por una tarjeta de
memoria que no esté protegida.

La tarjeta de memoria estd llena.

Sustituya la tarjeta por otra con espacio
suficiente.

Es necesario restaurar la tarjeta de
memoria.

Restaure la tarjeta de memoria (pdgina 21).

No se puede grabar audio.

El nivel de grabacién de audio estd
configurado en el nivel minimo.

Ajuste el nivel de grabacién de audio
(pdgina 31).

El sonido grabado estd
distorsionado.

El nivel de audio es demasiado alto.

Ajuste el nivel de grabacién de audio
(pdgina 31).

El sonido grabado tiene un
alto nivel de ruido.

El nivel de audio es demasiado bajo.

Ajuste el nivel de grabaci6n de audio
(pdgina 31).

Al seleccionar un micréfono externo, ajuste
también la configuracién de INPUT MIC
Reference de Audio Input, en el mend Audio
(pdgina 81).

No se pueden reproducir
los clips.

Se estd editando el clip.

Es posible que no se muestre un error o
advertencia en funcién del estado de la
videocdmara. No se trata de un fallo de
funcionamiento.

Se estd grabando el clip en otro
dispositivo.

No se pueden reproducir los clips si ha
modificado los nombres o las carpetas de archivo
o si el clip se estd utilizando en un ordenador. No
se trata de un fallo de funcionamiento.
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Dispositivos externos

Sintoma Solucién

El ordenador no reconoce  Desconecte el cable USB del ordenador y vuelva a conectarlo de forma segura.

la videocdmara. Desconecte el cable USB del ordenador, reinicielo y vuelva a seguir los pasos en el orden
correcto.

No se pueden cargar los Desconecte el cable USB del ordenador, reinicie la videocimara y vuelva a conectarlo.

clips en el ordenador. Debe instalarse el software de aplicacion para cargar los clips en su ordenador
(pdgina 62).

Conexion LAN inalambrica

Las obstrucciones y la interferencia electromagnética entre la videocdmara y el punto de acceso de LAN inaldmbrico
o el dispositivo del terminal, o bien el entorno ambiental (tal como los materiales de la pared) podrian acortar el rango
de comunicacién o impedir las conexiones por completo. Si experimenta estos problemas, verifique el estado de
conexién/comunicacion tras mover la videocdmara a una nueva ubicacién o tras acercarla al punto de acceso/
dispositivo del terminal.

Sintoma Solucién

El dispositivo del terminal ¢ Compruebe la conexién LAN inaldmbrica (direccién IP, etc.).

no puede acceder a la » Es posible que el ajuste de comunicacién entre el punto de acceso y el cliente no sea
videocdmara. viélido. Para obtener més informacion, remitase a las instrucciones del punto de acceso.

No puede iniciar sesién en Compruebe el nombre de usuario y la contrasefia establecidos.
la videocdmara.

No aparece el control Compruebe la configuracién de la direccién IP.
remoto por web.
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Indicaciones de error/advertencia

La videocdmara informa en casos de advertencias y avisos, o en los que es necesario comprobar el
funcionamiento, mediante mensajes en la pantalla del visor, el indicador de grabacién/ldmpara indicadora
y un aviso acustico.

El pitido de advertencia se emite desde el altavoz incorporado y los auriculares conectados a la toma de
auriculares.

Indicaciones de error

El camcorder dejara de funcionar cuando se visualicen los siguientes mensajes.

Indicacion de error Sonido  Lampara Causa y solucion
en LCD/visor de adver- indicadora/
tencia indicador de
grabacion
E + error code Continuo  Parpadeo Indica una anomalia en el camcorder. La grabacion se detiene,
rdpido incluso si “@Rec” se muestra en el visor.

Apague el camcorder y compruebe si existe alglin problema
con los dispositivos, cables o soportes conectados. Si el error
continda cuando el camcorder se vuelve a encender, pongase
en contacto con el servicio de asistencia técnica de Sony.

(Si no es posible apagar la unidad situando el interruptor ON/
STANDBY en STANDBY, retire la bateria y/o desconecte la
fuente DC IN.)

Es posible que no se muestre un error o advertencia en funcién
del estado de la videocdmara.

Indicaciones de advertencia

Siga las instrucciones proporcionadas si se muestran los siguientes mensajes.

Indicacion de advertenciaen Sonido de Lampara Causay solucién

LCD/visor adverten- indicadora/
cia indicador
de
grabacion
Battery Near End Intermitente Parpadeo La capacidad restante de la bateria se estd agotando.
Recdrguela en cuanto pueda.
Battery End Continuo Parpadeo La bateria estd agotada. No se puede efectuar la
rdpido grabacion.

Detenga el funcionamiento y sustituya la baterfa.
Temperature High Intermitente Parpadeo La temperatura interna es elevada.

Apague el camcorder y deje que se enfrie antes de

volverlo a utilizar.

Voltage Low Intermitente Parpadeo La tensién de DC IN es baja (nivel 1). Compruebe
el suministro de alimentacién.
Insufficient Voltage Continuo Parpadeo La tensién de DC IN es demasiado baja (nivel 2).
rdpido No se puede efectuar la grabacion.

Conecte a una fuente de alimentacién distinta.
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Indicacion de advertenciaen Sonido de Lampara Causa y solucion
LCD/visor adverten- indicadora/
cia indicador
de
grabacion

Media Near Full Intermitente Parpadeo El espacio libre en la tarjeta de memoria es
insuficiente.

Sustitdyala en cuanto pueda.

Media Full Continuo Parpadeo No hay espacio libre en la tarjeta de memoria. No

rdpido se pueden grabar, copiar ni dividir clips.
Sustitiyala inmediatamente.

Clips Near Full Intermitente Parpadeo El niimero de clips adicionales que pueden grabarse
en la tarjeta de memoria estd alcanzando valores
bajos.

Sustitdyala en cuanto pueda.
Clips Full Continuo Parpadeo Se ha alcanzado el nimero maximo de clips que
rdpido pueden grabarse en la tarjeta de memoria.
No se pueden grabar o copiar més clips. Sustitiyala
inmediatamente.

Last Clip Recording Intermitente Parpadeo El clip que estd grabando actualmente es el tltimo
que puede grabar, ya que ha alanzado el nimero
méximo de clips.

Prepare una tarjeta de memoria nueva.

Media(A) Near Full" Intermitente Parpadeo Al utilizar la funcién Simul Rec.

Media(A) Full" Continuo Parpadeo Al utilizar la funcién Simul Rec.

rdpido

Media(A) Clips Near Full!) Intermitente  Parpadeo Al utilizar la funcién Simul Rec.

Media(A) Clips Full Continuo Parpadeo Al utilizar la funcién Simul Rec.

rapido

Media(A) Last Clip Rec! Intermitente Parpadeo Al utilizar la funcién Simul Rec.

1)“Media(B)” para la tarjeta de la ranura B.

Mensajes de precaucion y de funcionamiento

Es posible que los siguientes mensajes de precaucion y funcionamiento aparezcan en el centro de la
pantalla. Siga las instrucciones proporcionadas para resolver el problema.

Mensaje del visor

Causa y solucion

Battery Error
Please Change Battery

Se ha detectado un error en la baterfa.
Sustitdyala por una baterfa normal.

Unknown Media(A)"
Please Change

Se ha introducido una tarjeta de memoria particionada o una tarjeta de
memoria que contiene mds clips de los que puede manipular el
camcorder.

La tarjeta no se puede utilizar en el camcorder y se debe sustituir.

Cannot Use Media(A)”
Unsupported File System

Se ha introducido una tarjeta que utiliza un sistema de archivos diferente
o que no se ha formateado.

La tarjeta no se puede utilizar en el camcorder y se debe sustituir o
formatear con el camcorder.

Media Error
Media(A) Needs to be Restored !

Se ha producido un error en la tarjeta de memoria y se debe restaurar.
Restaure la tarjeta de memoria.
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Mensaje del visor

Causa y solucion

Media Error
Cannot Record to Media(A)])

Es posible que la tarjeta de memoria esté dafiada y ya no se puede
utilizar para la grabacion.

La reproduccién es posible, por tanto, se recomienda copiar y sustituir la
tarjeta de memoria.

Media Error
Cannot Use Media(A)”

Es posible que la tarjeta de memoria esté dafiada y ya no se puede
utilizar para la grabacién ni la reproduccién.
La tarjeta no se puede utilizar en el camcorder y se debe sustituir.

Media(A) Error"
Recording Halted
Playback Halted

La grabacién y la reproduccion se han detenido a causa de un error que
se ha producido mientras se utilizaba la tarjeta de memoria.
Si el problema continda, sustituya la tarjeta de memoria.

Media Reached Rewriting Limit
Change Media(A)U

La tarjeta de memoria ha llegado al final de su vida util.

Realice una copia de seguridad y sustituya la tarjeta inmediatamente. Si
continda utilizando la tarjeta, es posible que no pueda grabar o
reproducir.

Para obtener mds informacion, consulte las instrucciones de

funcionamiento de la tarjeta de memoria.

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again

El ajuste de formato para Clip Naming se ha restablecido porque se ha
cargado un archivo ALL no vilido.

Configure los ajustes de formato deseados e intente guardar el archivo
ALL de nuevo.

The specified address is invalid.

La direcci6n especificada no es valida.
Compruebe que el ajuste sea correcto.

Failed Este error puede aparecer si no se puede obtener una direccién con el
ajuste DHCP fijado en On.
Compruebe los ajustes de servidor de DHCP.

<SSID>Not found. No se pudo encontrar la red (punto de acceso) con el <SSID>

especificado.
Compruebe que el ajuste sea correcto.

<SSID>Authentication Failed

Fallo de autenticacién de conexién en la red (punto de acceso) con el
<SSID> especificado.
Compruebe que la contrasefia y el resto de ajustes sean correctos.

1)“Media(B)” para la tarjeta de la ranura B.

113



Diagramas de bloques

”»

Consulte los elementos relacionados en “Especificacion del audio que se va a grabar” (pdgina 31)y

(pdgina 71).

»

“Lista del menii de configuracion

Audio Input (CH1&2)

INPUT1
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MIC

Il‘r—

|
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|
- —

[CH2 EXT Input Select]

INPUT1
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<CH1 INPUT SELECT> [CH1 Wind Filter] <CH1 LEVEL CONTROL> <CH1 INPUT LEVEL>
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EXT
MI SHOE

N\

- ——

<CH2 INPUT SELECT> [CH2 Wind Filter] <CH2 LEVEL CONTROL> <CH2 INPUT LEVEL>
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EXT
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|
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[Limiter Mode] [CH1&2 AGC Mode]
0-10 Off, —6dB Mono
—9dB, —12dB Stereo
—15dB, —17dB

°1

-
[Color Bar]

[1kHz Tone on Color Bar]

Estd activado uno o
ambos.
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Audio Input (CH3&4)

4
|
|
| |
| |
4 A T TN ¢ N | |
FF - =
o | I I | I I | [ ! ! N
t t L ()L 1 [ !
LTI 0\ A A [ A
INPUTA | o o [ N [ _ _ |
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| | | | I | | | I [ | “ |
- - - - o
[CH3 Input Select] ~ [CH3 Wind Filter] ~ [CH3 Level Control] [CH3 Input Level] ! | | ] | I
Internal L off On Auto 0-99 | | | |
MIC L 4 INPUT1 off Manual 1 [
R Internal MIC | o | I !
Shoe CH1 ) ! 1 | | |
j | | I
| [ | |
| | | |
_ _ _ | | 1 | | |
14 N 14 N | Pl | | |
| | | | | | | Pl | | |
'
t . 1 ® 1 _ — 1 S
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| | | | | | | | | )l | | |
| | | | | | | | | ;o | | |
| | | | | | | | | P! | | |
| | | | | | | | | |
- - - - [ .
[CH4 Input Select]  [CH4 Wind Filter] ~ [CH4 Level Control] [CH4 Input Level] [Limiter Mode] [CH3&4 AGC Mode] [Color Bar]
Off On Auto 0-99 Off, —6dB Mono [1kHz Tone on Color Bar]
INPUT1 off Manual —9dB, —12dB Stereo Esta activado uno o
INPUT2 —15dB, —17dB ambos.
Internal MIC
Shoe CH2
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CH1
CH2

!

:
A 4

CH3

CH4

Audio Output
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Especificaciones

General

Peso
Aprox. 2,3 kg (solo el cuerpo)
Aprox. 2,8 kg (con el parasol del objetivo (1),
ocular (1), bateria BP-U30 (1), tarjeta de
memoria (1))

Dimensiones (anchura/altura/profundidad)

190,0 mm x 202,0 mm X 419,7 mm.
Dimensiones médximas. La profundidad es la
longitud existente entre la parte delantera del
parasol del objetivo y el ocular grande.

Requisitos de alimentacién
12V deCC(de 11 Val65V)
Consumo de energia

Aprox. 24 W
cuando se graba con la pantalla LCD apagada,
el visor encendido y sin dispositivo externo
conectado

Aprox. 36 W
cuando se graba con la pantalla LCD
encendida, el visor encendido y se utiliza HD
SDI, HDMI y dispositivo externo

Aprox. 36 W
al realizar la copia en un soporte USB

Temperatura de funcionamiento
De 0 °C a40 °C
Temperatura de almacenamiento
De 20 °C a +60 °C
Tiempo de funcionamiento continuo
Con la bateria BP-U90:
aprox. 3 horas y 15 minutos.
Con la bateria BP-U60:
aprox. 2 horas y 10 minutos.
Con la bateria BP-U30:
aprox. 1 hora y Sminutos.
(Cuando se graba con la pantalla LCD apagada,
el visor encendido y no estd conectado el
dispositivo externo)

Formato de grabacion (video)

XAVC Long

Modo XAVC-L QFHD: VBR, 150 Mbps (méx.),
MPEG-4 H.264/AVC

Modo XAVC-L HD 50: VBR, 50 Mbps (méx.),
MPEG-4 H.264/AVC

Modo XAVC-L HD 35: VBR, 35 Mbps (méx.),
MPEG-4 H.264/AVC

Modo XAVC-L HD 25: VBR, 25 Mbps (méx.),
MPEG-4 H.264/AVC

DVCAM
CBR, 25 Mbps

Proxy

Perfil principal AVC/H.264, 4:2:0 Long GOP,
VBR

1920x1080/9 Mbps, 1280x720/9 Mbps,
1280x720/6 Mbps, 640x360/3 Mbps,
480x270/1 Mbps, 480x270/500 kbps

Formato de grabacion (audio)
XAVC Long
Modo XAVC-L: LPCM de 24 bits, 48 kHz,
4 canales

DVCAM
LPCM de 16 bits, 48 kHz, 4 canales

Proxy
AAC-LC, 128 kbps, 2 canales

Velocidad de fotogramas de grabacion

XAVC Long

Modo XAVC-L QFHD 150: 3840x2160/59.94P,
50P, 29.97P, 23.98P, 25P

Modo XAVC-LHD 50: 1920x1080/59.94P, 50P,
59.94i, 50, 29.97P, 23.98P, 25P
1280x720/59.94P, 50P

Modo XAVC-LHD 35: 1920x1080/59.94P, 50P,
59.94i, 501, 29.97P, 23.98P, 25P

Modo XAVC-L HD 25: 1920x1080/59.94i, 50i

DVCAM
720x480/59.94i, 29.97PsF
720x576/50i, 25PsF




Tiempo de grabacion/reproduccién

XAVC Long
Modo XAVC-L QFHD 150

Al utilizar una tarjeta de memoria de 128 GB:

aprox. 88 minutos
Modo XAVC-L HD 50

Al utilizar una tarjeta de memoria de 128 GB:

aprox. 240 minutos
Modo XAVC-L HD 35

Al utilizar una tarjeta de memoria de 128 GB:

aprox. 320 minutos
Modo XAVC-L 25

Al utilizar una tarjeta de memoria de 128 GB:

aprox. 445 minutos

DVCAM

Al utilizar una tarjeta de memoria de 128 GB:

aprox. 425 minutos

« El tiempo de grabacién/reproduccién puede
variar debido a las condiciones de uso y a las
caracteristicas de la memoria.

Objetivo

Montura del objetivo

Tipo fijo

Relacién de zoom
25%

Distancia focal

3,7 mm a 92,5 mm
(Equivalente a 35 mm de 28,8 mm a 720 mm)

Area de enfoque
Seleccionable AF/MF/Full MF
800 mm a oo (macro OFF)
10 mm a e (macro ON, gran angular)
800 mm a e (macro ON, teleobjetivo)

Iris
Seleccionable entre automética y manual
De Fl1.6 aFl1 y C (cerrado)

Estabilizacion de imagen
Seleccionable ON/OFF, cambio de objetivo

Diametro del filtro
MS82 mm, ancho de 0,75 mm

Macro
Seleccionable ON/OFF
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Camara

Dispositivo de imagen
Sensor de imagen ExmorR 3-CMOS de tipo
1/3 pulgada

Elementos de la imagen efectivos
3840 (H) x 2160 (V)

Sistema 6ptico

Sistema de prisma F1.6

Filtros integrados
Filtros ND
CLEAR: Clear
1: 1/4AND
2: 1/16ND
3: 1/64ND
ND variable lineal (aprox. de 1/4 ND a 1/128
ND)

Sensibilidad (2000 1x, 89,9% de reflexion)
F11 (normal, 1920x1080/59.94P, modo de alta
sensibilidad)
F12 (normal, 1920x1080/50P, modo de alta
sensibilidad)

Tluminacién minima
0,01 Ix (normal, 1920x1080/59.941) (F1.6,
+30 dB de modo de alta sensibilidad,
acumulacién de 64 fotogramas)

Relacién S/N
57 dB (Y) (normal)

Resolucion horizontal
2000 lineas de TV como minimo (modo
3840x2160P)
1000 lineas de TV como minimo (modo
1920x1080P)

Velocidad del obturador
De 1/24 a 1/8000 de segundo

Movimiento a camara lenta y rapida
XAVC Long
2160P: De 1 a 60 fps
1080P: De 1 a 60 fps
720P: De 1 a 60 fps

Balance de blancos

Modo Preset (3200K)
Modos Memory A, Memory By ATW

Gain
-3,0,3,6,9, 12, 15, 18 dB, 30 dB (Turbo Gain
On), AGC

Curva Gamma

Seleccionable




LAN inalambrico

Estandares compatibles
IEEE 802.11a/b/g/n/ac

Bandas de frecuencia

2,4 GHz
5,2/5,3/5,6 GHz (solo PXW-Z190V)

Seguridad

WEP/WPA-PSK/WPA2-PSK
Compatible con etiqueta NFC Forum Tipo 3

Entradas/salidas

Entrada de audio

Tipo XLR de 3 contactos (2), hembra,
conmutable entre LINE/MIC/MIC+48V
LINE: +4dBu/0dBu/-3dBu (/EBUL) / 10 kQ
MIC: de -80dBu a —30dBu / 3 kQ

(Nivel de entrada de referencia
0 dBu=0,775 Vrms)

Salida de audio
Multi/Micro USB

Salida SDI
Tipo BNC (1), seleccionable 3G/HD/SD

Entrada del cédigo de tiempo
Tipo BNC (1), conmutable con el conector TC
ouT
De 0,5V a 18 Vp-p, 3,3kQ

Salida de cédigo de tiempo
Tipo BNC (1), conmutable con el conector TC
IN
1,0 Vp-p, 75 Q

Conector USB

Multi/Micro USB (1)
Host: USB 3.0/2.0 de tipo A (1), USB 2.0 de
tipo A (1) (Compatible en una versién futura.)

Salida de auriculares

Minitoma estéreo (1)
—16 dBu, 16 Q

Salida del altavoz

Monoaural
Salida: 500 mW

Entrada de cc

Toma de cc

Salida de HDMI
Conector HDMI (tipo A)

Conector REMOTE

Subminitoma estéreo (¢2,5 mm)
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Conector LAN con cable
RJ-45 (1), I0O0OOBASE-T, 100BASE-T,
10BASE-T (compatible en futuras
actualizaciones)

Pantalla

Visor
Tamaiio de la pantalla: 1,0 cm (tipo de
0,39 pulgadas)
Pixeles efectivos: aprox. 2,36 millones de puntos

Pantalla LCD
Tamafio de la pantalla: 8,8 cm (tipo de
3,5 pulgadas)
Pixeles efectivos: aprox. 1,56 millones de puntos

Micréfono interno

Microfono interno

Micréfono de condensador de electreto estéreo
omnidireccional

Ranuras de soporte

Tipo
SD (2), SD/MS (1)

Accesorios suministrados

Bateria (1)

Adaptadores/cargadores de CA (1)

Cable USB (1)

Parasol del objetivo (1)

Ocular grande (1)

CD-ROM “Instrucciones de funcionamiento” (1)
Antes de utilizar esta unidad (1)

Manual de la garantia (1)

Descargas de software

Cuando utilice la unidad con una conexion de PC,
descargue todos los controladores del dispositivo,
los complementos y las aplicaciones de software
que necesite de los siguientes sitios web.

Sitio web de productos de Sony Professional:
Estados Unidos  http://pro.sony.com
Canadd http://www.sonybiz.ca
Latinoamérica http://sonypro-latin.com



Europa, Oriente Medio y Africa
http://www.pro.sony.eu

Japén http://www.sonybsc.com
Asia Pacifico http://pro.sony-asia.com
Corea http://bp.sony.co.kr
China http://pro.sony.com.cn

Aunque los datos concernientes a los materiales
grabados estdn almacenados en varios archivos y
carpetas, es posible manejar con facilidad los
clips sin tener en cuenta la estructura de los datos
y los directorios si se utiliza el software de
aplicacion especifico.

« Si realiza operaciones, como copiar clips de la tarjeta
de memoria usando Explorer (Windows) o Finder
(Macintosh), es posible que no se conserven los datos
relacionados incluidos en los clips.

El disefio y las especificaciones estin sujetos a
cambios sin previo aviso.

Notas

* Haga siempre un ensayo de grabacion y
verifique que se grabd bien.

SONY NO SE HACE RESPONSABLE POR
DANOS DE NINGUN TIPO,
INCLUYENDO PERO NO LIMITADO A
LA COMPENSACION O PAGO POR
FALLO EN HACER CUALQUIER TIPO DE
CONTENIDO DE GRABACION POR
MEDIO DE ESTA UNIDAD O SU
SOPORTE DE GRABACION, SISTEMAS
DE MEMORIA EXTERNA O CUALQUIER
OTRO SOPORTE O SISTEMAS DE
MEMORIA.

Verifique siempre que esta unidad funciona
correctamente antes de utilizarla. SONY NO
SE HACE RESPONSABLE POR DANOS
DE NINGUN TIPO, INCLUYENDO PERO
NO LIMITADO A LA COMPENSACION O
PAGO POR LA PERDIDA DE
GANANCIAS PRESENTES O FUTURAS
DEBIDO AL FALLO DE ESTA UNIDAD,
YA SEA DURANTE LA VIGENCIA DE LA
GARANTIA O DESPUES DEL
VENCIMIENTO DE LA GARANTIA NI
POR CUALQUIER OTRA RAZON.

SONY NO SE HACE RESPONSABLE POR
RECLAMACIONES DE NINGUN TIPO
REALIZADAS POR USUARIOS DE ESTA
UNIDAD O POR TERCEROS.
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« SONY NO SE HACE RESPONSABLE POR
LA PERDIDA, REPARACION O
REPRODUCCION DE CUALQUIER DATO
GRABADO EN EL SISTEMA DE
ALMACENAMIENTO INTERNO,
SOPORTES DE GRABACION, SISTEMAS
DE ALMACENAMIENTO EXTERNO O
CUALQUIER OTRO SISTEMA DE
ALMACENAMIENTO.

SONY NO SE HACE RESPONSABLE DE
LA FINALIZACION NI DE LA
INTERRUPCION, POR LA
CIRCUNSTANCIA QUE FUERA, DE
CUALQUIER SERVICIO RELACIONADO
CON ESTA UNIDAD.

Marcas comerciales

* XDCAM es una marca comercial de Sony
Corporation.
* XAVCy son marcas comerciales
registradas de Sony Corporation.
* Microsoft, Windows, Windows Vista y
Windows Media son marcas comerciales o
marcas comerciales registradas de U.S.
Microsoft Corporation en Estados Unidos y en
otros paises.
Mac y Mac OS son marcas comerciales
registradas de Apple Inc. en Estados Unidos y
en otros paises.
Los términos HDMI y HDMI High-Definition
Multimedia Interface y el logotipo de HDMI
son marcas comerciales o marcas comerciales
registradas de HDMI Licensing Administrator,
Inc. en los Estados Unidos y en otros paises.
Adobe, el logotipo de Adobe y Adobe Acrobat
son marcas comerciales registradas o marcas
comerciales de Adobe Systems Incorporated en
Estados Unidos y/o en otros paises.
“Memory Stick”, “Memory Stick Duo”,
“Memory Stick PRO Duo”, “Catalyst Browse”,
“Content Browser Mobile” y el logotipo de
“Content Browser Mobile” son marcas
comerciales registradas o marcas comerciales
de Sony Corporation.
* Ellogotipo de SDXC es una marca comercial de
SD-3C, LLC.
* i0S es una marca comercial o marca comercial
registrada de Cisco Systems, Inc. y/o sus
afiliados en Estados Unidos y en otros paises.

* Android y Google Play son marcas comerciales
de Google Inc.



* Wi-Fi, el logotipo Wi-Fiy Wi-Fi PROTECTED
SETUP son marcas comerciales o marcas
comerciales registradas de Wi-Fi Alliance.

¢ Marca N es una marca comercial o marca
comercial registrada de NFC Forum, Inc. en
Estados Unidos y en otros paises.

Todos los demds nombres de compaiiias y de

productos son marcas comerciales registradas o

marcas comerciales de sus respectivos

propietarios. En este documento, no se utilizan
los simbolos ™ o ® para indicar los elementos
con marca registrada.

Licencias

ESTE PRODUCTO SE AUTORIZA BAJO LA
LICENCIA DE CARTERA DE PATENTES
AVC QUE PERMITE AL CONSUMIDOR EL
USO PERSONAL, PERO NO COMERCIAL,
PARA:

(i) CODIFICAR VIDEO QUE CUMPLA CON
EL ESTANDAR AVC (“AVC VIDEO”) Y/O
(ii) DECODIFICAR VIDEO AVC QUE UN
CLIENTE CODIFICO DURANTE UNA
ACTIVIDAD PERSONAL U OBTENIDO A
TRAVES DE UN PROVEEDOR DE VIDEO
AUTORIZADO PARA SUMINISTRAR VIDEO
AVC.

NO SE OTORGA NINGUN TIPO DE
LICENCIA O NO EXISTE NINGUNA
LICENCIA IMPLICITA PARA NINGUN
OTRO USO. SI DESEA OBTENER
INFORMACION ADICIONAL ACERCA DE
MPEG LA, L.L.C., CONSULTE
HTTP://WWW.MPEGLA.COM

En base a los contratos de licencia entre Sony y
los propietarios del copyright del software, este
producto utiliza software libre. Para cumplir los
requisitos de los propietarios del copyright del
software, Sony se ve obligado a informarle acerca
del contenido de estas licencias.

Obtencidn del software con la licencia GPL/LGPL
Este producto utiliza un software al que se aplica
la licencia GPL/LGPL. Esto le informa de que
tiene derecho a acceder, modificar y redistribuir
el codigo fuente de estos programas de software
de acuerdo con las condiciones de la GPL/LGPL.
El c6digo fuente se proporciona en Internet.
Utilice la siguiente URL y siga las instrucciones
de descarga.
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http://www.sony.net/Products/Linux/common/
search.html

Le rogamos que no se ponga en contacto con
nosotros acerca de los contenidos del cédigo
fuente.

Las licencias (en inglés) estdn grabadas en la
memoria interna del producto.

Establezca una conexién de almacenamiento
masivo entre el producto y el ordenador para leer
las licencias que se hallan en la carpeta
“PMHOME” - “LICENSE”.
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Conector Multi/Micro USB 8, 61, 62
Conector SDI OUT 61, 106

Content Browser Mobile 47

Control automadtico de ganancia 28, 73
Control del audio 26

Control remoto web 53

Correa de bandolera 9

Correccién de gamma 78

Customize View 89

D

Datos sobre el tiempo 33
Delete Clip 89

Detail (HD mode) 79
Detail(QFHD) 79

Detail (SD mode) 80

Dial SEL/SET 67

Display Clip Properties 58, 89
Display On/Off 85

Dispositivo de audio externo 31
Down Converter 83

E

Edicién no lineal 62
Estabilizacion de la imagen 33
Extensor digital 12

F

Face Detection AF 11, 34

Fecha y hora 18

Filtro ND 72, 28

Flicker Reduce 74

Focus Magnifier 26

Format Media 90

Formateo (inicializacion)
ranura UTILITY SD/MS 42, 45
soportes de grabacién 20

Formato 27, 39

Formato de video 106

Frecuencia del sistema 12, 27



G Mensajes de precaucion y de
funcionamiento 112

Gamma 78 ’ )
Ganancia 28, 72 Mend Audio 81
GPS 44,96, 102 Menid Camera 72

Ment de configuracién 65, 67, 71
Meni File 91

Meni LCD/VF 83

Menu Media 90

Grabacién de proxy 46
Grabacién en relé 23
Gran angular 24

H Meni Network 92
HDD 63 Mena Paint 75
HDMI TC Out 87 Meni Recording 87
HDR 41 Ment System 94
HLG 41 Menid TC/UB 87
Hours Meter 96 Meni Thumbnail 89
Menu User 65, 69, 71
| Ment Video 83
Micréfono interno 7, 31, 81

Indicaciones de advertencia 111

Indicaciones de error 111 Modo AF 26
Interruptor FOCUS 25 Modo de estacién 13, 49
Interruptor GAIN 28 Modo de grabacién de proxy 89
Interruptor INPUT1 31 Modo de punto de acceso 13,47, 93
Interruptor INPUT2 31 Modo Full Auto 23
Interruptor IRIS 27 Modo Full MF 25
Interruptor WHT BAL 30 Modo Macro 26
Iris automdtico 27 Modo Memory A 29
Iris manual 27 Modo Memory B 29

Modo MF 25
K Modo predeterminado 28, 29
Knee 78 Modo Variable 28

Moédulo LAN inaldmbrico USB 47
L Monitor externo 61
Lampara indicadora/indicador de grabacién N

7,9, 111
LAN 47 NFC 6, 48
Language 96 Nivel de grabacién de audio 32
LCD Setting 83 Nombre del clip 24
Localizacién automadtica del balance de 0
blancos 29

Lock/Unlock Clip 89 Objetivo 101

Obturador automdtico 28, 74
M Output Display 83

Output Format 83
Output On/Off 83

Maintenance 81
Marcas de esencia 60

Marker 84 P

Matrix 80

Media Full 21 Palanca del zoom 24

Media Near Full 21 Palanca del zoom del asa 24

Pantalla de imdgenes en miniatura 55
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Pantalla LCD 11

Parasol del objetivo con cubierta del
objetivo 18

Peaking 84

R

Ranura para tarjetas de memoria 9, 20
Ranura UTILITY SD/MS 8,41, 45
Rec Format 94

Reloj 18

S

S&Q Motion 87
Sefial de salida 106
Shutter 73

Simul Rec 88

Skin Detail 80
Software 62, 119
Soporte USB 63, 90
SteadyShot 33

T

Tarjetas de memoria SD 42, 45
Tarjetas de memoria SDHC 42, 45
Tarjetas de memoria SDXC 20, 42, 45
Tarjetas SD 41, 45

Teleobjetivo 24

Thumbnail View 89

Tiempo de grabacion restante 14, 21, 105

Time Zone 18
Toma de corriente de pared 17

U

Update Media 90

Users Bit 87

UTC 18

Utilizacién de la videocdmara en el
extranjero 98

Vv
Version 97
VF Setting 83
Video Light Set 75
Visor 11
mando de ajuste didptrico 19

w
White 76

White Clip 78
White Switch 76
WPS 48,49

Y4

Zebra 85

Zoom 24

Zoom del asa 24, 74
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